Copyright Notice

Copyright © 1990 - 2020 by Business Forecast Systems, Inc. All Rights Reserved Worldwide. No part of this manual may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without express written permission of Business Forecast Systems, Inc., 68 Leonard Street, Belmont, MA 02478 USA.

Disclaimer

Business Forecast Systems, Inc. makes no representations or warranties with respect to the contents hereof and specifically disclaims any implied warranties of merchantability or fitness for any particular purpose. Further, Business Forecast Systems, Inc. reserves the right to revise this publication and to make changes from time to time in the contents hereof without obligation of Business Forecast Systems, Inc. to notify any person or organization of such revision or change.

Trademarks

Forecast Pro is a registered trademark of Business Forecast Systems, Inc.

Other product names mentioned in this manual are trademarks or registered trademarks of their respective companies and are hereby acknowledged.
Contents

Chapter 1: Introduction to Forecast Pro ......................................................... 1
Forecasts and Collaborators ........................................................................... 1
What You Need to Run Forecast Pro ............................................................... 1
Registering Your Forecast Pro Package .......................................................... 2
Future Development of Forecast Pro ............................................................... 2
Forecast Pro Resources ................................................................................... 2
Installing Forecast Pro .................................................................................... 2
Automatic Installation .................................................................................... 2
Manually Installing the 32-bit or 64-bit Version ............................................... 3

Chapter 2: A Quick Overview of Forecasting .................................................. 4
What is Statistical Forecasting? ....................................................................... 4
Forecasting Methodologies ............................................................................. 5
Some Forecasting Tips .................................................................................... 7

Chapter 3: Setting Up Your Historic Data ....................................................... 9
Overview ......................................................................................................... 9
Selecting a Data Format .................................................................................... 11
Excel (XLS, XLSX, CSV) Formats .................................................................... 12
Text (MLT) Format .......................................................................................... 16
Using ODBC .................................................................................................... 17
Using Attribute Fields to Define a Hierarchy .................................................. 19

Chapter 4: Setting Up Your Optional Data ..................................................... 21
Conversion Factors ......................................................................................... 22
External Data Files ......................................................................................... 23
Explanatory Variables ..................................................................................... 24
Global Explanatory Variables ......................................................................... 25
Item-specific Explanatory Variables ............................................................... 25
Custom Filter Fields ....................................................................................... 26
Definitions: Custom Allocations ................................................................. 27
Definitions: Integer Rounding Quantities ...................................................... 28
Override Files ............................................................................................... 29
Helper Files .................................................................................................... 31
Modifier Files ............................................................................................... 31

Chapter 5: The Forecast Pro Interface ........................................................... 33
Operations Overview ....................................................................................... 33
Forecast Pro Interface Overview ................................................................... 34
Quick Access Toolbar ..................................................................................... 35
### Ribbon Menu
The Navigator .......................................................................................... 35
The Hot List ................................................................................................. 35
View Window .............................................................................................. 36
The Status Bar ............................................................................................ 38
Forecast Pro Ribbon Tabs ........................................................................... 39
File Tab ........................................................................................................ 39
Home Tab .................................................................................................... 40
Forecasting Tab .......................................................................................... 41
Reports Tab .................................................................................................. 41
Import Tab .................................................................................................... 42
Export Tab ..................................................................................................... 44
Operations Tab ............................................................................................. 44
Help Tab ........................................................................................................ 47
The Navigator Context Menu ....................................................................... 48

### Chapter 6: Working with Layouts
Adding Layouts .......................................................................................... 49
Managing Layouts ....................................................................................... 49

### Chapter 7: Using the Data Manager
Row Types ................................................................................................... 52
Row Controls ................................................................................................ 53

### Chapter 8: Forecast Pro Options
The Basics Tab ............................................................................................ 55
The Formats Tab .......................................................................................... 56
The Outliers Tab ........................................................................................... 58
The Overrides Tab ......................................................................................... 60
The Command Line Tab .............................................................................. 61
The Pareto Tab .............................................................................................. 63
The Performance Tab .................................................................................... 64
The Advanced Tab ........................................................................................ 66

### Chapter 9: The Forecast Pro Views
The Forecast Report View ............................................................................ 68
The Graph Views ........................................................................................... 69
The Override Forecasts View ....................................................................... 73
Working with overrides ................................................................................ 73
Row types ....................................................................................................... 76
Defining calculated rows ............................................................................. 78
Formatting rows ............................................................................................ 82
Defining row properties ................................................................................ 83
Specifying the baseline forecast ................................................................... 84
The Diagnostics View .................................................................................... 85
The Tracking Report and Tracking Report Graph Views ............................. 86
The Exception Report Views .......................................................................... 89
Curve Fitting .................................................................................................................. 126
Weight (Weighting Transformations) ................................................................. 126
Discontinue ........................................................................................................ 127
Fixed Value .......................................................................................................... 127
Custom Modifiers ............................................................................................... 128
Group Level (Reconciliation Modifiers) ............................................................. 129
Top-down ............................................................................................................. 130
Custom Allocation ............................................................................................... 130
Indexes .................................................................................................................. 130
Tools ....................................................................................................................... 131
Diagnostics .......................................................................................................... 131
Create Helper ....................................................................................................... 131
Outliers .................................................................................................................. 132

Chapter 12: Working with Hierarchies .............................................................. 134
Defining the Hierarchy ......................................................................................... 134
Reconciling the Hierarchy .................................................................................... 134

Chapter 13: Collaboration .................................................................................... 138
Excel Collaboration ............................................................................................... 139
Creating Forecast Pro Collaboration Worksheets ........................................... 139
Updating Collaboration Sheets ........................................................................ 141
Importing Forecast Pro Collaboration Worksheets ......................................... 142
Editing Collaboration Sheets in Excel ............................................................... 143
In Place Collaboration Sheets ........................................................................... 143
By Selection Collaboration Sheets ................................................................... 145
Working with Super Projects ........................................................................... 146
Pros and cons ...................................................................................................... 146
Creating a super project ..................................................................................... 147
Updating a super project .................................................................................. 147

Chapter 14: Understanding How Forecast Overrides are Allocated ............. 149
Adjustments Made to a Single Level ................................................................. 149
Adjustments Made to More Than One Level .................................................. 150
Examples Where Overrides Cannot be Allocated ........................................... 152
Summation .......................................................................................................... 153

Appendices .......................................................................................................... 154
Speeding Up the Program ................................................................................ 154
Using a Time Fence ............................................................................................. 156
Command Line Operation ................................................................................ 157
End-User License Agreement ............................................................................ 158
Suggested Reading ............................................................................................... 161
Chapter 1: Introduction to Forecast Pro

Forecasters and Collaborators

Forecast Pro is available in two different types of licenses—Forecaster licenses and Collaborator licenses. The type of license you install will dictate the functionality you can access. A Forecaster has access to all the functionality described in this manual. A Collaborator can view and manipulate a forecast project created by a Forecaster (including viewing graphs and reports, adding overrides and comments, saving output, etc.) but cannot generate new statistical forecasts.

Operationally, the two installations are very similar. However, a Collaborator does not have access to any of the functionality relating to reading historical data and generating statistical forecasts. Thus, there are sections of this manual which will not be relevant to Collaborators.

What You Need to Run Forecast Pro

A computer running a Windows operating system.

A minimum of 512 MB of RAM (random access memory). Additional memory will greatly enhance program performance. We recommend 2 Gigs if you are running a 32-bit operating system and as much RAM as your budget can afford if you are running a 64-bit operating system.

A hard disk drive with 50 MB of free space.

Registering Your Forecast Pro Package

Please take a moment NOW to visit www.forecastpro.com and register your software online. Registering your software entitles you to the following benefits:

• Free maintenance and support service for one year. This service provides program updates and unlimited technical support for the first year you license the program. After the first year, this service is available on a subscription basis. Technical support is provided via the telephone (during regular business hours Eastern Standard Time), via email, mail and fax.

• Automatic notification of upgrades, revisions and new products.

• Special pricing on upgrades, revisions and new products.
Future Development of Forecast Pro

BFS has made many changes to Forecast Pro to accommodate special needs and circumstances in the corporate environment. BFS will continue to improve Forecast Pro in the years to come. If you encounter problems or have any suggestions for improvements, please contact the BFS product development.

Forecast Pro Resources

Business Forecast Systems, Inc. provides the following resources to help you get the most out of Forecast Pro:

The _Forecast Pro Tutorials Manual_ provides a great way to introduce yourself to the product and its capabilities. The tutorials use sample input files and Forecast Pro projects that are installed with Forecast Pro. This manual is accessible via the Start page, the File page and the Help Ribbon menu.

The _Quick Start_ video provides a quick video overview of how to use Forecast Pro. This video is accessible via the Start page and the File page.

The _Forecast Pro Reference Manual_ documents all functionality included in the software. This manual is accessible via the Start page, the File page and the Help Ribbon menu.

The _Forecast Pro Statistical Reference Manual_ describes the statistical techniques, statistics and strategies that are implemented in Forecast Pro. This manual is accessible via the Help Ribbon menu.

The _Resources Menu_ on forecastpro.com provides an array of Forecast Pro resources including free on-demand forecasting webinars, access to the Forecast Pro blog and a calendar of upcoming Forecast Pro events.

Our _Technical Support Team_ (support@forecastpro.com or call 1-617-484-5050) strives to provide timely responses to issues or questions you may encounter while using Forecast Pro.

BFS provides on-site and web-based training services. Please contact our support team if you are interested in training.

Installing Forecast Pro

Automatic Installation

Forecast Pro can be installed as a native 32-bit or native 64-bit application. The installation program, FPSetup.exe, will automatically detect the operating system you are running and install the appropriate version. Running FPSetup is the recommended way to install Forecast Pro.

If you would prefer to use an MSI to directly install the 64-bit version or if you are running a 64-bit operating system but would like to install the 32-bit version, you will find instructions for doing so in the next section.
To install Forecast Pro on your hard disk using FPSetup, perform the following steps.

Run the FPSetup program as an Administrator (right click on FPSetup and select “Run as administrator”). The program is located in the root directory of the CD (e.g., D:\) or unzipped downloaded folder.

Follow the directions that appear on the screen. The installation program will prompt you for your serial number and CD-Key. These numbers are printed on the CD label and sleeve. If you are installing from a download, the numbers should have been included with the email that provided the download link.

Setup will then create the program directory, data directories, copy the appropriate files, create a launch icon on the program menu and place a launch icon on the desktop. It will also install SQLite drivers. The driver installation launches a separate installation dialog which includes a separate click-through license agreement.

The Forecast Pro Excel Add-in will not be accessible in Excel until you start Forecast Pro. Please start Forecast Pro to automatically activate the add-in. If you start the program with Excel open, you will need to close and re-open Excel for the add-in to be activated. If you have any difficulty installing Forecast Pro, please do not hesitate to contact BFS technical support (phone: 617 484-5050, email: support@forecastpro.com).

If you wish to remove Forecast Pro from your computer, use the Add or Remove Programs utility in the Windows Control Panel.

**Manually Installing the 32-bit or 64-bit Version**

As mentioned in the previous section, the FPSetup program automatically detects whether you are running a 32-bit or 64-bit operating system and installs the matching version.

Alternatively, you can run either the 32-bit or 64-bit setup program directly.

The 64-bit installation uses an MSI file called ForecastProTRAC.msi which is located in the directory d:\x64\en-us\. You must run the MSI as an administrator.

The 32-bit installation uses an InstallShield installation program called Setup.exe which is located in the directory d:\Win32\. You must run the Setup program as an administrator.
Chapter 2: A Quick Overview of Forecasting

What is Statistical Forecasting?

Everybody forecasts, whether they know it or not. Businesses need to forecast future events in order to plan production, schedule their work force, or prepare even the simplest business plan.

Most business forecasting is still judgmental and intuitive. Sometimes this is appropriate. People must integrate information from a large variety of sources—qualitative and quantitative—and this is probably best done by using the extraordinary pattern recognition capabilities of the human brain. Unfortunately, many companies also use judgmental forecasting where they should not.

Not everyone understands the concept of forecasting. It tends to get mixed up with goal setting. If a company asks its salespeople to forecast sales for their territories, these “forecasts” often become the yardsticks by which they are judged.

The main advantage of statistical forecasting is that it separates the process of forecasting from that of goal setting and makes it systematic and objective. Statistical forecasting can help almost any business improve planning and performance. There is, in other words, value added for a business.

The future is uncertain, and this uncertainty can be represented quantitatively. Statistical forecasting represents uncertainty via a probability distribution. A probability distribution associates each possible outcome with a likelihood of it occurring. Two kinds of information are needed to describe the distribution: the point forecasts, which is essentially the “best guess” estimate, and the confidence limit, which captures how much uncertainty there is around the point forecast. The upper and lower confidence limits represent reasonable bounds for the forecast. You can be reasonably confident that the actual outcome will fall within the confidence limits.

Forecast Pro depicts this information graphically as well as numerically. In the graph below, the red line represents the point forecast, while the blue lines represent the upper and lower confidence limits.
The upper confidence limit is often calibrated to the ninety-fifth percentile. This means that the actual value should fall at or below the upper confidence limit about 95% of the time. You can set the percentiles of both the upper and lower confidence limits. Sometimes, the upper confidence limit will be more useful for planning than the point forecast.

Let’s illustrate this idea with an example. Suppose you were in charge of forecasting widget sales for your company. If you wanted to determine expected revenues for next month, you would be most interested in the point forecast, since it is the mean value of the distribution. The point forecast gives you the minimum expected forecast error.

On the other hand, suppose you wanted to know how many widgets to produce. If you overproduce, warehousing costs will be excessive. But if you underproduce, you will probably lose sales. Since the cost of lost sales is usually greater than the cost of overstocking, you will be most interested in the upper confidence limit. The 95% upper confidence limit tells you how many widgets to produce to limit the chance of “stocking out” to less than 5%.

**Forecasting Methodologies**

A wide variety of statistical forecasting techniques are available, ranging from very simple to very sophisticated. All of them try to capture the statistical distribution that we have just discussed.

Forecast Pro offers the forecasting methodologies that have been proven to be the most appropriate for business forecasting—simple moving averages, discrete data models (Poisson or negative binomial), curve fitting, Croston’s intermittent demand model, exponential smoothing, Box-Jenkins, Bass diffusion model, forecasting by analogy, dynamic regression, event models and multiple-level forecasting.
All of these methodologies forecast the future by fitting quantitative models to statistical patterns from the past. Therefore, you must have historic records of your variables, preferably for several years. Forecast accuracy depends upon the degree to which statistical data patterns exist and their stability over time. The more regular the series, the more accurate the forecasts are.

Five of the methodologies are univariate techniques. They forecast the future entirely from statistical patterns in the past.

The simple moving average is widely used in business, mostly because it is so easy to implement. However, it is really only appropriate for very short or very irregular data sets, where statistical features like trend and seasonality cannot be meaningfully determined.

Discrete data models are used for data consisting of small whole numbers. These models are characteristically used to model a slow-moving item for which most orders are for only one piece at a time. Forecasts are nontrended and nonseasonal.

Croston’s intermittent demand mode is not a widely known or used technique, but it can be extremely useful. It is usually used to model data in which a significant number of periods have zero demand but the non-zero orders may be substantial. This is characteristic of a slow-moving item which is ordered to restock a downstream inventory. Forecasts are nontrended and nonseasonal.

Exponential smoothing models are widely applicable. They are also widely used because of their simplicity, accuracy and ease of use. Their robustness makes them ideal even when the data are short and/or volatile. Exponential smoothing models estimate trend and seasonality and extrapolate them forward.

Box-Jenkins is a more elaborate statistical method than exponential smoothing. Box-Jenkins models estimate the historic correlations of the data and extrapolate them forward. It often outperforms exponential smoothing in cases when the data are fairly long and nonvolatile. However, it doesn't usually perform well when the data are unstable.

You can use Forecast Pro’s expert selection to automatically choose the appropriate univariate forecasting technique for each item forecasted. Expert selection will determine which of the five univariate models is most appropriate for the data and select the modeling method that best fits the data. Alternatively, you can dictate that a specific method be used and, if desired, customize your models. Forecast Pro provides extensive diagnostics and statistical tests to help you make informed decisions.

Forecast Pro includes five additional forecasting techniques that are not considered in expert selection—event models, custom component models, forecast by analogy and the Bass diffusion model.

Event Models are extensions of exponential smoothing models that allow you to capture responses to promotions, business interruptions and other aperiodic events. These models allow you to assign each period into logical categories and incorporate an adjustment for each category. For example if you establish a category for promoted periods then your model would include an adjustment for promoted periods. If you ran three different types of promotions you could establish three categories and have a different adjustment for each type of promotion.

Custom Component Models are also extensions of exponential smoothing models. The method generates statistical forecasts for the different components found in an exponential smoothing model (sales level, trend, seasonal pattern and events) and then allows you to customize any of the estimated components. The model is very useful in
circumstances where not all of the components can be accurately estimated from the demand history. Examples include short data sets where the seasonal pattern cannot be reliably estimated and you wish to use a seasonal pattern from a similar product, forecasting the impact of future events that have not occurred historically, tempering the trend for longer-term forecasts, etc.

*Forecast by Analogy* is a new product forecasting technique that allows you to create a forecast that “looks like” a different product’s demand pattern or a launch profile that you create.

*Bass Diffusion Model* is a new product forecasting technique designed to forecast the spread of a new product based on the adoption rates of two types of users—innovators who are driven by their desire to try new products and imitators who are primarily influenced by the behavior of their peers.

*Dynamic regression* produces a forecast based on the forecasted item’s history (like univariate methods) and that of the explanatory variables (e.g., product promotion, advertising, demographic variables, or macroeconomic indicators). You must provide historic values for the variable to be forecast and the explanatory variables.

Forecast Pro can provide automated selection for the dynamic terms (e.g., lagged dependent variables and Cochrane-Orcutt terms), but the user needs to specify which explanatory variables to include in the model. Forecast Pro provides several test batteries and diagnostics for variable selection and gives you specific advice on how to improve the model. Building a dynamic regression model thus consists of deciding which variables to consider, and following the program’s advice, step-by-step, to identify your final model.

Dynamic regression can outperform exponential smoothing and Box-Jenkins in cases where strong explanatory variables exist, and you have reasonably accurate forecasts for them. Unfortunately, this is not always the case, so the forecasts may not be as accurate as those from univariate methods. Nevertheless, the method has considerable appeal, because it forces you to create a causal model for your data, and thus to improve your understanding.

If you are new to forecasting and these techniques seem a little intimidating, don’t worry. We designed Forecast Pro to guide you completely through the forecasting process. Just follow the program’s advice, and you will soon be generating accurate forecasts and adding value to your business.

### Some Forecasting Tips

Forecast Pro uses your data history to forecast the future, so it is extremely important that your data be as accurate and complete as possible. Keep in mind the rule, “Garbage in, garbage out!”

You will also want to give some thought to what data you should forecast. If you want to forecast demand for your product, you should probably input and forecast incoming orders rather than shipments, which are subject to production delays, warehousing effects, labor scheduling, etc. Many corporations are making large investments to obtain data as close to true demand as possible.

The more data you can supply the program, the better. The program can work with as few as five data points, but the forecasts from very short series are simplistic and less accurate. Although collecting additional data may require some effort, it is usually worth it.
If your data are seasonal, it is particularly important that you have adequate data length. The automatic model selection algorithms in Forecast Pro will not consider seasonal models unless you have at least two years’ worth of data. This is because you need at least two samples for each month or quarter to distinguish seasonality from one-time irregular patterns. Ideally, you should use three or more years of data to build a seasonal model.
Chapter 3: Setting Up Your Historic Data

Forecast Pro requires historic data to be input in a specific format. For many users, the data format is an initial stumbling block on the way to success in forecasting their own data. This usually happens when a user misunderstands some of the details of the data format. This chapter explains the data formats supported by Forecast Pro, advises you how to select a format and describes how to create the files. If you read the material carefully and examine the sample data files that are shipped with Forecast Pro, you will be up and running quickly.

The first two sections describe data requirements and the different data file formats. After you have selected your file format, consult the appropriate section for instructions on how to create the files.

Overview

Forecast Pro works with historic time series, i.e., sequences of values of a variable at some time interval. Business series are usually expressed in terms of the calendar, and can be daily, weekly, monthly or quarterly. Forecast Pro can work with any type of time series but is oriented towards weekly, monthly and quarterly calendar data.

Collection and maintenance of reliable historic data is up to you and your IT department and can be implemented in many different ways, depending on information flow conditions in your organization.

Data length

Forecast Pro works by fitting a statistical model to your historic data and extrapolating it via the fitted model. Thus, your data must be long enough to provide reasonably stable estimates of the most important features of the data. Very short or very noisy historic records usually yield very simple models because the data are too short to support statistical estimates of important features like seasonality.

If the data are very short, say four points or fewer, Forecast Pro can pick up neither seasonality nor trend and reverts to the Simple Moving Average model.

For more than four points but less than two years' worth of data, Forecast Pro can fit and forecast trends but not seasonality. If your data are in fact nonseasonal, your forecasts are likely to be adequate. If your data are in fact seasonal, the forecasts are likely to be poor—Forecast Pro cannot extract or forecast the seasonality.

However, seasonal forecasts from short data sets are feasible using some of Forecast Pro’s customized approaches. For example, when the short data sets are nested within aggregate product groups with longer histories, top-down forecasting can be used. If there are other longer series which exhibit the same seasonal pattern then the pattern can be estimated from the longer data set and applied to the short data sets using the INDEXES modifier, a custom component model or the forecast by analogy model.
Seasonality can be estimated and forecasted from two to three years of data, but this amount of data is marginal, especially when your data are noisy or intermittent. Patterns in the noise may be mistaken for seasonality, yielding inappropriate “seasonal” forecasts.

Robust capture of seasonality requires three or more years of data. Four to seven years is even better, since there is more information from which the program can separate seasonality and trend from the noise.

There is little additional payoff in accuracy beyond about seven years of data, and the cost in computer time can be substantial.

**Missing values and zeros**

Each of the statistical forecasting methods requires an unbroken stream of historic values. Unfortunately, missing values are common in business data. You therefore need a well-formulated approach to missing data. There are two parts to the approach. You must first decide how to encode missing values in the input data file. Then you must decide how these missing values are to be treated by Forecast Pro.

The encoding of missing values depends upon the data format. However, one problem is common to all of the formats—the distinction between missing values and zeroes. Forecast Pro ordinarily considers zeroes to be actual data values and treats them as such. If they were really intended as missing values, then the forecasts can be badly biased.

Forecast Pro treats a sequence of leading zeroes as missing values if you check “Ignore leading zeroes” on the Formats tab of the Options dialog box, and it treats trailing zeroes as missing if you check “Ignore trailing zeroes”. If you can avoid using this strategy, do so. Its dependence upon these flag settings makes it a little risky.

When historic data is read into Forecast Pro, the program establishes a global ending date for the history which corresponds to the most recent observation available for any item being read in. If a given item does not have a historic observation for the global ending date, the item is flagged as “dead.” Dead items are not forecasted but their demand history goes into the group totals. This can be an issue if your data source code’s zeroes as missing (e.g., blank cells in Excel, no transaction in a table or query, etc.). If you check “Set trailing blanks to zero” on the Formats tab of the Options dialog box, Forecast Pro will replace missing trailing observations with zeroes. If you can avoid using this strategy, do so. Its dependence upon these flag settings makes it a little risky.

Zeroes in the middle of your data are always treated as numerical values. Therefore, embedded missing values must be explicitly coded as missing. Since the way you do this depends upon the data format, it will be addressed as we discuss each specific data format.

Forecast Pro interprets your input data and missing values as the data are read. In order to change treatment of missing data, you must reread the data from scratch. The interpretation of zeros and missing values depends upon the “Ignore leading zeroes” and “Ignore trailing zeroes” flags and upon the “Missing values” setting on the Formats tab of the Options dialog box. There are three possible settings for missing values— *Truncate*, *Impute* or *Zero*.

*Truncate* directs Forecast Pro to use only the most recent unbroken stream of data. All data up to and including the last missing value are discarded.

*Impute* directs Forecast Pro to discard leading and trailing missing values but to impute embedded missing values via linear interpolation.
Zero directs Forecast Pro to reset missing values to zeroes and to treat them as numerical values. This setting is appropriate when the data file is written from a database in which only the non-zero records are stored. In other cases it might lead to badly biased forecasts.

Header information

Once you have collected your time series data, you will need to define the header information. The required header information includes the following.

**Variable name.** The name by which the program refers to an individual item (often an SKU). An item name is limited to 256 of the following characters:

0-9 A-Z a-z ! $ % & ? @ _ + - / * . ~ < >

However, you may also be limited by restrictions imposed by the software to which you export your data. SQL databases, for instance, sometimes require that the first character in a name is a letter and do not regard upper and lower cases as distinct.

If the variable name begins or ends with an underbar (_), Forecast Pro tags it as a potential helper variable and will not forecast it. Helper variables are used in conjunction with event models, forecast by analogy models and weighting transformations.

**Variable description.** A short description of the variable. Variable descriptions must not exceed 256 characters in length. Variable descriptions are displayed within Forecast Pro and can be included in Numeric Output Files and Formatted Forecast Report Files.

**Starting year.** The year and period corresponding to the first available data point. If the first available observation for a monthly series was April, 2016 then the starting year would be 2016 and the starting period would be 4. The starting year must be 100 or later. For data that are not calendar-oriented, enter 100 for the starting year and 1 for the starting period.

**Periods per year.** 12 for monthly data, 4 for quarterly data, etc. For data that is not calendar oriented, use 1. Note that most weekly corporate calendars involve occasional years of 53 weeks—these occurrences will cause the forecast date tags to be off by a week.

**Periods per cycle.** The number of periods per seasonal cycle, usually equal to the number of periods per year. An exception might be daily data, where periods per cycle could be set to 7 to capture weekly patterns and periods per year set to 365. Or, if weekend days are excluded, periods per cycle might be 5 and periods per year 260. For nonseasonal data, periods per cycle should be 1. This is a critical entry because Forecast Pro uses it for seasonal adjustments.

Selecting a Data Format

The program accepts three different data formats—Excel (XLS, XLSX & CSV), Text (MLT, CSV) and Open Database Connectivity (ODBC). Examples of each file type are shipped with the program.

Which data format you choose will depend on your application and database operations. Before making your choice, you should be aware of the following advantages and disadvantages of each file type.
Excel (XLS, XLSX & CSV) files

Excel or CSV (Comma Separated Values) files are frequently used for managing Forecast Pro Data input files. You can make and forecast multiple spreadsheet files in one project if you wish.

PROS. If you are comfortable using a spreadsheet, then the spreadsheet format allows you to create, update and manipulate your data in a familiar environment. Processing time for xls files is faster than for ODBC. Creating forecast reports from Excel is straightforward.

CONS. The layout of your spreadsheet must follow the Forecast Pro rules. You may have to change your current spreadsheet layout to one you find slightly less convenient. Processing time for xlsx files can be slow (xls is faster and csv is faster still).

Text (MLT, CSV) files

Text files can also be used to hold your data inputs. You can make and forecast multiple text files in a single project if you wish.

PROS. Processing time is faster than for ODBC and spreadsheets (excluding CSV which is text-based). Most databases can output text files.

CONS. Editing, viewing and updating large MLT files can be clumsy. Not all editors accept very long files.

ODBC

Open database connectivity (ODBC) allows Forecast Pro to read and write data directly to databases for which an ODBC driver exists. Most popular databases support ODBC, including Access, Oracle and SQL server.

PROS. ODBC can provide direct access to data stored in the corporate database obviating the need for intermediate files.

CONS. Reading and writing directly to the corporate database can raise security issues. Data transfer can be slow for some configurations.

The next three sections supply the details you need to set up your data in one of the Forecast Pro formats. If you have chosen a format, you need read only the pertinent section.

Excel (XLS, XLSX, CSV) Formats

Forecast Pro can read Excel (XLS, XLSX) files and CSV (Comma Separated Values) files saved from Excel.

You must create your spreadsheet file from within your spreadsheet program. Forecast Pro checks data types as it reads the spreadsheet. If it sees text where it expects a number, or a floating point number where it expects an integer, an error message will be displayed when the data is read in. By default, a blank cell is interpreted as a missing value. This default can be adjusted for leading and trailing blanks on the Formats tab of the Options dialog box. Do not use zeros to represent missing values—they will be interpreted as numbers and will probably distort your forecasts badly.
Entire spreadsheet vs. named range

You may either devote an entire worksheet to the data (recommended) or specify a portion of a worksheet by giving it the range name BFSDATA.

In a multi-worksheet workbook the data are assumed to reside in the first (topmost) worksheet unless an alternate sheet has been specified by naming it BFSDATA.

The cell references in the examples below assume that the entire worksheet has been devoted to the Forecast Pro database. If you opt to specify a named range, cell A1 in the samples will correspond to the cell in the uppermost left corner of your named range.

Row format

If your data are already stored by rows, you will want to consider the row format first. You can probably alter your spreadsheet to the Forecast Pro row layout in just a few minutes. In row format each time series occupies a single row on the spreadsheet.

The data are assumed to reside in the topmost (first) spreadsheet in the workbook unless an alternate sheet has been specified by naming it BFSDATA.

Row 1 of the spreadsheet is devoted to column headings. The keyword “description” must be used as the column heading for the description column. The other cells in row 1 are ignored by Forecast Pro. You can use them for titles, calendar information, etc.

Here is an example of a row format spreadsheet. The file is installed with the program and is named Sample Historic Data – Horizontal.xlsx.

The above example does not use attribute fields to define product groupings. This is often desirable and is discussed in the Using Attribute Fields to Define a Hierarchy section.

In our example, each data record consists of six header items in columns A through F, followed by the historic data in the remainder of the row, beginning in column G. Each item is placed in a separate cell.

Columns A through F contain the following six items required items.

A  Variable name. Up to 256 characters.
B  Variable description. Up to 256 characters.
C  Starting year. Must be an integer.
D  Starting period. Must be an integer.
E  Periods per year. Must be an integer.
F  Periods per seasonal cycle. Must be an integer.

See the Overview section at the beginning of this chapter for more details on these items.
The time series data begin in column G. The starting year (column C) and starting period (column D) refer to the year and period for column G, whether or not that cell actually contains data. Thus, in the example spreadsheet, the first value for PG1-204-2 is for January 2014 in column I, even though the column C defines the starting year as 2013, and column D defines the starting period as 11.

**Column format**

If your data are already stored by columns, you will want to consider the column format first. You can probably alter your spreadsheet to the Forecast Pro row layout in just a few minutes. In column format each time series occupies a single column on the spreadsheet.

The data are assumed to reside in the topmost (first) spreadsheet in the workbook unless an alternate sheet has been specified by naming it BFSDATA.

Column A of the spreadsheet is devoted to row headings. The keyword “description” must be used as the row heading for the description row. The other cells in column A are ignored by Forecast Pro. You can use them for titles, calendar information, etc.

Here is an example of a column format spreadsheet. The file is installed with the program and is named Sample Historic Data – Vertical.xlsx.

The above example does not use attribute fields to define product groupings. This is often desirable and is discussed in the Using Attribute Fields to Define a Hierarchy section.

In our example, each data record consists of six header items in rows 1 through 6, followed by the historic data in remainder of the rows, beginning in row 7. Each item is placed in a separate cell.

Rows 1 through 6 contain the following six required items.

1. Variable name. Up to 256 characters.
2. Variable description. Up to 256 characters.
3. Starting year. Must be an integer.
4. Starting period. Must be an integer.
5. Periods per year. Must be an integer.
6. Periods per seasonal cycle. Must be an integer.
See the Overview section at the beginning of this chapter for more details on these items.

The time series data begin in row 7. The starting year (row 3) and starting period (row 4) refer to the year and period for row 7, whether or not that cell actually contains data. Thus in the example spreadsheet, the first value for PG1-204-2 is for January 2014 in row 9, even though the header defines the starting period as 11 and the starting year as 2013.

Transaction format

When demand history is stored in a database, it often consists of individual records for each transaction (e.g., each order or shipment) that includes the quantity and the date. If your data are currently available in Excel in this format, you will want to consider the transaction format. The advantage is that it may require less manipulation than other formats to bring the data into Forecast Pro. The disadvantage is that it is harder for a person to view and manipulate the data in Excel.

The data are assumed to reside in the topmost (first) spreadsheet in the workbook unless an alternate sheet has been specified by naming it BFSDATA.

Row 1 of the spreadsheet is devoted to column headings. The keyword “description” must be used as the column heading for the description column. The other cells in row 1 are ignored by Forecast Pro. You can use them for titles, calendar information, etc.

Here is an example of a transaction format spreadsheet. The file is installed with the program and is named Sample Historic Data – Transactions.xlsx.

The above example does not use attribute fields to define product groupings. This is often desirable and is discussed in the Using Attribute Fields to Define a Hierarchy section.

In our example, each data record consists of six header items in columns A through F, followed by the historic data in column G. Each item is placed in a separate cell.

Columns A through F contain the following six items required items.

A  Variable name. Up to 256 characters.
B  Variable description. Up to 256 characters.
C  Year. Must be an integer.
D  Period. Must be an integer.
E  Periods per year. Must be an integer.
F Periods per seasonal cycle. Must be an integer.
See the Overview section at the beginning of this chapter for more details on these items.

Formatting rules
Keep the following points in mind when you are creating your spreadsheet.
If you are not using attribute fields each variable name must be unique.
If you are using attribute fields each variable name within a given group must be unique.
If you use zeroes to pad the data prior to an item's availability, make sure that Ignore leading zeros is selected on the Formats tab of the Settings Options dialog box.

Text (MLT) Format

A multivariate text file contains information for the data series you wish to forecast.
This file is stored as an editable text file with the extension MLT. You must create this file outside of Forecast Pro, making sure that you format it appropriately.
The MLT file format is straightforward. The file begins with record headings followed by a semicolon. The record headings are required for the Variable Name and Description fields and are optional for all other records. You can use them for titles, calendar information, etc. if you wish.

After the record headings comes header information for the first variable, followed by decimal numbers representing the historical data and then a semicolon. This is followed by the same format for subsequent time series. Two semicolons in a row mark the end of the MLT file.

Since Forecast Pro recognizes spaces, tabs and returns as equivalent terminators, you have a great deal of flexibility in formatting your data. The most common format is to organize series by rows, as in the following example.

The above example does not use attribute fields to define product groupings. This is often desirable and is discussed in the Using Attribute Fields to Define a Hierarchy section below.

The header consists of the first six items:
Variable name. Up to 256 characters enclosed in quotes.
Variable description. Up to 256 characters enclosed in quotes.
Starting year. Must be an integer.
Starting period. Must be an integer.
Periods per year. Must be an integer.
Periods per seasonal cycle. Must be an integer.

See the Overview section at the beginning of this chapter for more details on these items.

The remaining fields contain historic data. Each time series is terminated with a semicolon and the file is terminated with two semicolons.

Notice that we have elected to use the same starting period and starting year for each time series and then used the keyword “MISSING” in lieu of values for data points that are unavailable. Thus, in the example, the first value for PG1-204-2 is for January 2012, even though the header defines the starting period as 11 and the starting year as 2011. Aligning the data file this way makes it easier for somebody to view and modify the file. Alternatively, we could have omitted the “MISSING” keywords and altered the starting period and starting year to correspond to each individual time series’ starting date. Forecast Pro will have no problem reading a file formatted in this fashion—but you might.

The one-time-series-per-line format illustrated above is easy to read, however, keep in mind you can use any combination of rows and columns.

Formatting rules

Keep the following points in mind when you are creating your .MLT files.

The record headers, variable name field and variable description field must always appear in quotes.

If you are not using attribute fields, each variable name must be unique. If you are using attribute fields, each variable name within a given group must be unique.

If you plan to use commas to separate items, or as place holders for large numbers, you will need to set a few options on the format tab of the Settings Options dialog box to insure that they are interpreted correctly.

Be careful not to use dollar signs, page breaks or other symbols that may confuse Forecast Pro.

Use the word MISSING instead of a number to indicate a missing value.

If you use zeroes to pad the data prior to an item’s availability, make sure that Ignore leading zeros is selected on the Formats tab of the Settings Options dialog box.

Using ODBC

ODBC provides direct data communications between Forecast Pro and a wide variety of databases. This is accomplished through intermediary ODBC drivers that lie between Forecast Pro and your database. You must obtain the driver from the database manufacturer or a third party and install it according to the directions provided.

ODBC drivers are available for many database products including Access, Oracle and SQL Server.

Database structure

Forecast Pro reads data from structured tables or views defined in the database. Ordinarily, the tables created for the Forecast Pro interface are just a subset of the entire database.
Here is an example of a data table formatted for Forecast Pro. The file is installed with the program and is named Sample Historic Data – ODBC.mdb.

<table>
<thead>
<tr>
<th>ItemId0</th>
<th>Description</th>
<th>Hist_Year</th>
<th>Hist_Period</th>
<th>Ppy</th>
<th>PPC</th>
<th>PPC</th>
<th>Hist_Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>6</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>1944</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>7</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>3888</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>5832</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>9</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>8748</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>10</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>16524</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>11</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>16524</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2016</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>23328</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>1</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>17496</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>2</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>2116</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>3</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>6904</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>4</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>17496</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>5</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>1944</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>6</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>9720</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>7</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>3888</td>
</tr>
<tr>
<td>COR-12-11</td>
<td>CASE - 12 count Corn Muffins</td>
<td>2017</td>
<td>8</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td>5832</td>
</tr>
</tbody>
</table>

The above example does not use attribute fields to define product groupings. This is often desirable and is discussed in the Using Attribute Fields to Define a Hierarchy section.

In our example, each data record consists of six header items in columns 1 through 6, followed by the corresponding historic data point. It is important to note that each data record must contain the aggregated value for the given period.

The fields are defined as follows.

- **ItemId0**: This is a text field containing the variable name. It can be up to 256 characters.
- **Description**: This is a text field containing the variable description. It can be up to 256 characters.
- **Hist_Year**: This is a number field with field size double containing the year.
- **Hist_Period**: This is a number field with field size double containing the period.
- **Ppy**: This is a number field with field size double containing the periods per year.
- **PPC**: This is a number field with field size double containing the periods per cycle.
- **Hist_Value**: This is a number field with field size double containing the aggregated historic data value for the record’s “date” as defined by the Hist_Year and Hist_Period.

See the Overview section at the beginning of this chapter for more details on these items.

The Forecast Pro project needs to connect to an ODBC database before you can access the tables and queries therein. The first time you select Add ODBC in the Data Manager for a given project you will be prompted to establish the file data source (select an ODBC driver) and then to select a database.

Once the project is connected to the database, the tables and queries are displayed, including those that have nothing to do with Forecast Pro. A table from the database is treated just like a file when you are using the Data Manager. Thus, you should arrange data into the tables or views that make logical sense as entries in the Data Manager.
Using Attribute Fields to Define a Hierarchy

Formatting rules

ODBC drivers vary a great deal. If you experience any difficulties connecting to the database, the first thing to check is that you are using the latest ODBC driver available for your database.

With the exception of the last one (which only pertains to Oracle) all of the notes below have been verified using Microsoft Access. There is a chance that your ODBC driver might be more (or less) restrictive.

Missing values are indicated by whatever rules are used by the native database. Every database recognizes the distinction between zeroes and missing values. If you want, you can encode leading and trailing missing values as zeroes. In that case you must make sure that “Ignore leading zeros” and/or “Ignore trailing zeroes” is selected on the Format tab of the Settings Options dialog box.

Table names and variable names should begin with a letter and should not include blank spaces.

If you are not using attribute fields each variable name must be unique.

If you are using attribute fields each variable name within a given group must be unique.

Oracle Users: Some Oracle drivers will only work if the Hist_Value field is defined as FLOAT (not NUMBER). All other numeric fields can be NUMBER with the decimal places set to zero.

Using Attribute Fields to Define a Hierarchy

If you do not include any attribute fields, when you read the data into Forecast Pro, it will create a one-level hierarchy (i.e., there will be no group totals).

If your data file, table or query includes attribute fields prior to the Variable Name field, Forecast Pro will automatically build a multiple-level hierarchy. The first level of the hierarchy will correspond to the first attribute field, the second level of the forecasting hierarchy will correspond to the second attribute field, etc.

Let’s illustrate this with an example. The spreadsheet 123 Bakery – Historic Data.xlsx is a sample data file shipped with Forecast Pro. It is shown below.

In our example, our first attribute field is Total. Notice that the value for the field Total is “Total” for all items. Since all items have the same value for the first attribute field, when we read this spreadsheet into Forecast Pro the first level of our forecasting hierarchy will provide a grand total for all items in our spreadsheet. Notice that the next attribute field is Category, which contains both Cakes and Muffins. Thus, when we read this spreadsheet into Forecast Pro the second level of our forecasting hierarchy will breakdown total sales into
Cakes and Muffins. The next attribute field is Customer. Thus, the third level of our forecasting hierarchy will breakdown the Cakes and Muffins into Customers. The next field is the Variable Name (labeled “SKU”) so the final level of our hierarchy will breakdown the Category-by-Customer into SKUs.

By default, the *Automatically sort* option on the Formats tab of the Options dialog box is selected, and Forecast Pro sorts the data alphabetically prior to reading it in. If *Automatically sort* is not selected, the order of appearance on the spreadsheet dictates the structure of the hierarchy and you’ll want to take care when constructing your spreadsheet.

**ODBC attribute fields**

The file *123 Bakery – ODBC.mdb* is a sample data file shipped with Forecast Pro. It is shown below.

![Historic Data Table](image)

If you are using ODBC the first attribute field *must* be named ItemId0, the second attribute field must be named ItemId1, etc. All attribute fields must be text fields. Other than that, the operation is identical to the spreadsheet format described above.
Chapter 4: Setting Up Your Optional Data

In addition to the historic data (which is required) Forecast Pro’s Data Manager allows you to import other information to assist you in creating and working with the forecasts. Specifically, you can import:

*Conversions Factors.* Conversion factors allow you to display the history and forecasts in alternative units of measure (e.g., dollars, kilos, etc.).

*External Data.* Forecast Pro allows you to import external data rows (such as alternative forecasts, open orders, etc.) into the forecast override grid.

*Explanatory Variables.* Explanatory variables files contain variables that you wish to use in conjunction with dynamic regression models.

*Filter Fields.* Filter fields can be included in report views and filtered like any other fields. They can also be included in the numeric output file. Filters are also used to select items exported to Excel Collaboration worksheets.

*Definitions.* Definition files contain values to use in conjunction with custom forecast allocations and item-level integer rounding quantities.

*Overrides.* In addition to entering forecast overrides interactively using the Forecast Overrides view, Forecast Pro allows you to import them.

*Helper Variables.* Helper variables are used in conjunction with event models, forecast by analogy models and weighting transformations.
Modifiers. In addition to specifying forecast modifiers interactively on the Navigator, Forecast Pro allows you to import them.

The remainder of this chapter will detail each of these data types.

Conversion Factors

The unit of measure used in the historic data file is the default unit of measure. Forecast Pro allows you to define conversion factors (i.e., multipliers) which can be used to display the history and forecasts in alternative units (e.g., dollars, kilos, etc.).

Examine the file 123 Bakery - Conversions.xlsx.

Notice that the attribute fields are present. In our example, columns E through G contain the conversion factors.

By default, the conversion definition must include a record for every end item in the historic data, or you will receive an error message when you attempt to read it. If you want to allow conversion factors with a value of 0 or missing conversion factors, you may do so by activating the Allow zero valued conversion factors option on the Formats tab of the Options dialog box.

If the Allow zero valued conversion factors option is selected, Forecast Pro will allow blanks or zeros or missing rows in a conversions file specified in the Data Manager. Forecast Pro will give warnings about the missing data and changing project units using the Units drop-down on the dialog bar is not enabled. However, the converted rows are available in the Overrides Report and Graph views. Blanks will be considered to be zeros, and items with either zero or blank conversion factors will consequently not be included in the totals for those conversion factors.

If you will be using a table or query to hold the conversion factors, you’ll want to examine the Conversions table in the file 123 Bakery - ODBC.mdb.
Notice that the attribute fields are present. **Description** is a text field containing the conversion factor’s name. **NumValue** is a number field with field size double containing the conversion factor.

**Formatting rules**

In a spreadsheet, a header row that includes the names of the conversion fields is required.

The conversion factors are assigned at the end-item level and must include a record for every end item in the historic data, or you will receive an error message when you attempt to read it.

**External Data Files**

At times it is useful to have visibility to external information while working with the forecasts. Forecast Pro allows you to import external data rows (such as alternative forecasts, open orders, etc.) into the forecast override grid. The external data can be imported from other Forecast Pro projects, from Excel spreadsheets (both row and transaction-style) and from databases using ODBC.

Importing external data rows requires that you set up the data in a specific format. The sample file shown below is installed into the Forecast Pro input directory and is named **123 Bakery - External Data - SKU-Level Forecast.xlsx**.

The first columns (A through D in our example) define the attributes and name of the item (i.e., the hierarchy information). The next column (E in our example) is labeled Description and contains the name of the external row. The remaining columns are labeled with dates and contain the data values.
If you plan to import your external data using a transaction style spreadsheet, examine the sample file *123 Bakery – External Data – SKU-Level Forecasts – Transactions.xlsx* located in the Forecast Pro input directory. Note that the file layout is the same as the ODBC file layout shown below.

If you plan to import your external data using ODBC, examine the *Alternate_Forecasts* table in the sample Access database file *123-Bakery-ODBC.mdb* located in the Forecast Pro input directory.

![Alternate_Forecasts Table](image)

The format is very similar to the format for the historic demand. Notice that the attribute fields are present. *Hist_Year, Hist_Period* and *Hist_Value* are number fields identifying the year, period and values respectively.

**Formatting rules**

In a spreadsheet, a header row is required. The Description and date fields must also be present and labeled accordingly. The dates in the header row need to be either in an Excel format, or in a Year-Period format, e.g. 2019-July, or 2019-52.

The external data rows are imported at one level of the hierarchy only.

If an item has no entries for a given external data row, it does not need to be included in the spreadsheet, table or query.

**Explanatory Variables**

Explanatory variable files are used to import explanatory variables (i.e., independent variables) that you wish to include in a dynamic regression model.

Forecast Pro allows you to specify two types of explanatory variables—global and item-specific. A global explanatory variable consists of a single time series (set of values) which can be included in a dynamic regression model for any item on the Navigator. An item-specific explanatory variable consists of a set of time series each of which is associated to a specific item on the Navigator.

To illustrate the difference, consider a variable like holidays which will likely be the same for all items within a hierarchy and therefore should be defined as a global variable. Contrast holidays with a variable like price, which will likely take on different values for different items and therefore should be defined as an item-specific variable. In this context “items” is being used to include both end items and aggregate levels in the hierarchy.
Explanatory variables *must* include values for the historic period. Ideally, you would also include forecast values for your explanatory variable, but you are not required to do so. If an explanatory variable does not have values provided for the complete forecast period, you are able to use the “automatically extend” option, and Forecast Pro will use expert selection to forecast explanatory variables where necessary.

**Global Explanatory Variables**

Setting up global variables is straightforward. The first column is labeled Variable and contains the name of the explanatory variable. The remaining columns are labeled with dates and contain the date values. These date values should match what is used in Forecast Pro (e.g. the dates shown in the Numeric Output view).

The sample file shown below, “Electricity - Explanatory Variables.xlsx”, is provided with the software.

**Item-specific Explanatory Variables**

The item-specific explanatory variable setup is the same as the Global variable setup, except the file includes the attribute fields used in the historic data setup. The first few columns (columns A-D in the example below) list the attributes, the next column (column E below) is labeled Variable and contains the name of the explanatory variable and the remaining columns are labeled with dates and contain the date values (consistent with Forecast Pro, as described above).

The examples shown above use a row format spreadsheet. Explanatory variables may also be imported using all other formats supported for input files (e.g., transaction spreadsheet, ODBC, etc.). ODBC requires the same format as a transaction spreadsheet. An example of item-specific transaction explanatory variables, “Cereal- Item Level Explanatory Transactions.xlsx,” is provided with the software and shown below.
Notice that the attribute fields are in the first few columns. The attribute columns are followed by a column for the explanatory variable name. This column must be labeled `Variable`. The last 3 columns, `Hist_Year`, `Hist_Period` and `Hist_Value`, are number fields identifying the year, period and values respectively.

### Custom Filter Fields

You can define custom filter fields which can be included in the report views and filtered like any other fields. They can also be included in the numeric output file.

Examine the file `123 Bakery - Filters.xlsx`.

Notice that the attribute fields are present. In our example, columns E and F contain the filter fields.

If you will be using a table or query to hold the filter fields, you’ll want to examine the `Filters` table in the file `123 Bakery - ODBC.mdb`. 
Notice that the attribute fields are present. Description is a text field containing the filter name. TextValue is a text field containing the filter's value.

Formatting rules
In a spreadsheet, a header row that includes the names of the filter fields is required.
The filters can be assigned at any level.
If an item has no associated filters, it does not need to be included in the spreadsheet, table or query.

Definitions: Custom Allocations

A custom allocation approach allows you to dictate how a group-level forecast is allocated to its component series. This is appropriate when the breakdown between the two levels is known.

To use a custom allocation, you must define the allocation proportions in a file, table or query and read them into Forecast Pro using the Definitions row in the Data Manager.

Examine the file Running Shoes – Custom Allocation.xlsx.
Notice that the attribute fields are present. In our example, column G contains the allocation proportions.

If you will be using a table or query to hold the allocation proportions, you’ll want to examine the CustomAllocation table in the file Running Shoes.mdb.

Notice that the attribute fields are present. Description is a text field containing the keyword CALL to identify the entry as an allocation proportion. NumValue is a number field with field size double containing the allocation proportion.

Formatting rules

In a spreadsheet, a header row that uses the keyword CALL to identify the allocation proportions column is required.

The allocation proportions can be assigned at any level.

The allocations do not need to sum to 100 (i.e., they do not need to be percentages), they are simply relative proportions. For example, if a group had two component series, A and B, and you assigned A a weight of 2 and B a weight of 1, then series A would get a two thirds allocation and series B would get one third.

Definitions: Integer Rounding Quantities

Forecast Pro allows you to display integer forecast rows for the statistical and/or final forecasts on the override grid. These rows allow you to define an integer quantity to round to (e.g., 1, 50, 1000, etc.) and then round the forecasts using an algorithm that that keeps track of the “remainder” (rounded amount) and applies it to the next period’s forecast value. This is particularly useful for low-volume forecasts or when there are large minimum order quantities, where traditional rounding can result in biased forecasts.

When using integer forecasts, the user defines the default rounding quantity in the Advanced Controls tab of the Options dialog box. If you wish to assign item-specific rounding quantities you can do so by defining them in a file, table or query and reading them into Forecast Pro using the Definitions row in the Data Manager.

Examine the file 123 Bakery – Definitions – Integer Rounding Quantities.xlsx.
Notice that the attribute fields are present. In our example, column E contains the rounding quantities.

If you will be using a table or query to hold the rounding quantities, you'll want to examine the IRQ table in the file 123 Bakery - ODBC.mdb

Notice that the attribute fields are present. Description is a text field containing the keyword IRQ (Integer Rounding Quantity) to identify the entry as a rounding quantity. NumValue is a number field with field size double containing the rounding quantity.

**Formatting rules**

In a spreadsheet, a header row that uses the keyword IRQ to identify the rounding quantity column is required.

The rounding quantities can only be assigned at the end-item level.

If you wish to use the default rounding quantity defined in Forecast Pro for a given item, it does not need to be included in the spreadsheet, table or query.

**Override Files**

In addition to entering forecast overrides interactively using the Forecast Overrides view, Forecast Pro allows you to import overrides from other Forecast Pro projects, from Excel spreadsheets (both row and transaction-style) and from databases using ODBC.

The sample file shown below is installed into the Forecast Pro input directory and is named 123 Bakery – Overrides - Rows.xlsx
Override Files

The first columns (A through D in our example) define the attributes and name of the item (i.e., the hierarchy information). The next column defines the override row to which the changes should be applied, followed by a column for comments (which, naturally, populates the comment field). Finally, the overrides themselves appear from left to right, starting with the first forecast period. If a specific cell is blank, no override will be imported for that period. Please note that you may use formula overrides (formulas must begin with an equal sign) as well as number overrides.

If you plan to import your overrides using a transaction style spreadsheet, examine the sample file 123 Bakery – Overrides - Transactions.xlsx located in the Forecast Pro input directory.

If you plan to import your overrides using ODBC, examine the Overrides table in the sample Access database file 123-Bakery-ODBC.mdb located in the Forecast Pro input directory.

Notice that the attribute fields are present.  
**FC_Period** and **FC_Year** are number fields identifying the forecast date for the override.  
**Override_Row** can either be a number field identifying the row number or a text field identifying the row name.  
**Override_Formula** is a text field containing either a numeric value for the override or a formula (formulas must begin with an = sign).  
**Override_Created** is a date/time field identifying when the override was created. If the entry is blank the override report will list the date/time that the override was loaded into the project.  
**Override_Comment** is a text field containing the comment you wish to associate with the override. If the entry is blank, no comment will be associated with the override.

**Formatting rules**

In a spreadsheet, a header row is required. The Row and Comment fields must be present and labeled accordingly.
In a spreadsheet, the dates in the header row need to be either in an Excel format, or in a Year-Period format, e.g. 2019-July, or 2019-52.

Overrides can be assigned at any level.

The override row can be specified by either the row number or the row name.

Overrides can be entered as values or formulas.

If an item has no overrides, it does not need to be included in the spreadsheet, table or query.

**Helper Files**

Helper variables are used in conjunction with event modeling, forecast by analogy and the weighting transformation.

Usually event schedules are created interactively using the Event Manager. However, if you wish, you can create helper variables containing the event schedules in Excel or in a database and import them into your project using the Data Manager.

Forecast by analogy requires a helper variable containing the analogy series. Using a weighting transformation requires a helper variable containing the weights. Depending on your needs, you can either create these helper variables using the Create Helper Variable dialog box (accessed via Helper variable>Create on the Navigator’s context menu) or you can create them in Excel or in a database and import them into your project using the Data Manager.

Helper variables are created in an identical fashion to your input data. Please note the following:

1. Attribute fields are not used since helper variables are associated with items on the Navigator using modifiers.
2. Description, Starting Year, Starting Period, Periods per Year and Periods per Seasonal Cycle are all required fields.
3. Their span should cover both the historic and forecast period.

Several sample helper files are shipped with Forecast Pro including, “Beer - Helpers.xls.” and the table “Helpers” in the sample Access database file Beer.mdb.

**Modifier Files**

In addition to entering forecast modifiers interactively on the Navigator, Forecast Pro allows you to import modifiers from other Forecast Pro projects and from Excel spreadsheets.

Importing modifiers from Excel requires that you set up the spreadsheet in a specific format. The sample file shown below is installed into the Forecast Pro input directory and is named 123 Bakery - Modifiers.xlsx.
The first columns (A through D in our example) define the attributes and name of the item (i.e., the hierarchy information). The next column defines the modifier(s) to import.

If you will be using a table or query to hold the modifier fields you’ll want to examine the Modifiers table in the file 123 Bakery - ODBC.mdb.

Notice that the attribute fields are present. Modifier is a text field containing the modifier(s) you wish to apply.

**Formatting rules**

In a spreadsheet, a header row is required. The Modifier field must be present and labeled accordingly.

The modifiers can be assigned at any level.

Multiple modifiers can be assigned in a single cell or data field.

If an item has no modifiers, it does not need to be included in the spreadsheet, table or query.
Chapter 5: The Forecast Pro Interface

This chapter presents a command overview and a description of the user interface. Details for the functionality of the views and dialog boxes available from the Ribbon menu are provided in subsequent chapters, as specified.

Operations Overview

Generating forecasts in Forecast Pro consists of executing the following steps:

1. Prepare the database. This is performed outside of the program and entails selecting the type of data format to use and preparing the files. Creating your data files is discussed in Setting Up Your Historic Data and Setting Up Your Optional Data.

2. Specify the default options. This is accomplished using the Options dialog box, which may be opened with the Options icon on the Home tab. Options set by the user will apply to the current forecast document and can also be saved to the ForecastProTRAC.ini file and used as defaults for all future forecast documents using the “Set as Default” button. Thus, you need only set the options when you use Forecast Pro for the first time, or when you wish to change the current settings. An overview of all option tabs and settings is in the Forecast Pro Options section of The Forecast Pro Interface chapter.

3. Define the historic data and other inputs. This is accomplished by specifying the appropriate entries in the Data Manager. Consult Using the Data Manager for details.

4. Read in the data and prepare the forecasts. This is accomplished by clicking the Read & Forecast button in the Data Manager. By default, Forecast Pro will automatically create forecasts using its Artificial Intelligence (AI) driven expert selection algorithm and reconcile the forecasts using a bottom-up approach.

5. Save the results. This can vary depending upon your needs, but usually entails saving a numeric output file containing the forecasts and saving a forecasting project so that you can update it the next forecast period rather than creating a new one from scratch. Consult Saving Your Work.

In addition to the above required steps, there are many optional operations that you can perform. Including:

1. View the forecasts and other information graphically

2. View on screen reports.

3. View forecasts and other information numerically in the override grid and enter any desired changes and comments.
4. Customize how the forecasts are generated by specifying that specific forecasting models and reconciliation techniques be used. These optional steps are accomplished using the ribbon interface, as described below.

**Forecast Pro Interface Overview**

To start Forecast Pro double-click the Forecast Pro icon on your desktop or click the Start button, select All Programs and click the Forecast Pro icon. After the program is loaded, you will see a startup page like the one below.

![Forecast Pro Interface](image)

You may open an existing project, start a new project, view a Getting Started video, open Tutorials or view the Program Reference.

Starting a new project will take you to the following screen
The Forecast Pro interface consists of a Quick Access Toolbar (A), a ribbon menu (B), a Navigator (C, currently unavailable), a Hot List area (D), a view window (E) and a status bar (F).

**Quick Access Toolbar**

Located in the upper left-hand corner of the display, the Quick Access Toolbar contains frequently used icons. The Quick Access Toolbar initially contains the Save and Auto Arrange icons as well as a Layout selection drop-down. You can add or delete icons from this toolbar by clicking on the small downward arrow at the right end of the toolbar and selecting which of the available icons you want to include.

**Ribbon Menu**

The ribbon menu provides access to almost all Forecast Pro functionality. The functionality is organized into seven ribbon tabs: File, Home, Forecasting, Reports, Import, Export, Operations and Help. Clicking on one of these tabs will display the ribbon for the selected tab. Each ribbon is a collection of icons and drop-downs, often organized into groups. The most commonly used procedures are available on the Home tab (selected above). The Home tab shows one group, Layouts. The seven tabs are described in [Forecast Pro Ribbon Tabs](#).

**The Navigator**

The Navigator is the primary way to select an item to view in the Forecast Report, Graph, Override and Tracking Report windows. It is also how you select the item you want to customize using the Forecasting tab. After the data have been read, the Navigator displays
the available time series in a tree structure. The tree structure is defined by the hierarchy in your historic data files. Selecting an item on the Navigator will automatically display all relevant information in the open views.

The Navigator also features color-coded icons to allow you to spot items that contain overrides and/or comments. A red icon indicates that the item contains an override and/or comment. A green icon indicates that the item does not contain an override or comment. A yellow icon on a group indicates that at least one item further down that branch of the tree contains an override and/or comment. A light blue icon (applicable only if Manual forecast mode is selected on the Performance tab of the Options dialog box) indicates that an item’s forecast needs to be updated with the Recalculate icon on the Home tab. A dark blue icon (applicable only if Manual override mode is selected on the Performance tab of the Options dialog box) indicates that an item’s override calculations need to be updated with the Recalculate icon on the Home tab.

The Navigator context menu provides extensive functionality for working with your data and the Hot List. Please see The Navigator Context Menu for details.

The Hot List

Placing items on the Hot List allows you to efficiently navigate, work with and report on a subset of the items listed on the Navigator. Items can be added to the current Hot List by dragging from the Navigator or by using the Add to Hot List option on the Navigator’s context menu.

When you select an item on the Hot List, Forecast Pro will immediately select the item on the Navigator and update the affected views.

The Hot List’s context menu allows you to change how items are displayed, save numeric output files and formatted forecast report files for the current Hot List items and remove items from the current Hot List. The Open Hot List option allows you to open a Hot List which had been saved to Excel or import a Hot List from another project. The Save Hot List option allows you to export the current Hot List to Excel. The ability to import and export Hot Lists to Excel allows you to create multiple Hot Lists for a project and switch amongst them.

Please consult the Advanced Navigation lesson in the for more details.

View Window

Forecast Pro allows you to open multiple views in the View Window. These views may be resized, maximized or minimized and arranged as you wish using standard Windows functionality. Left click on the border of an open window and drag the mouse to resize and left click on a window’s title bar and drag the mouse to move the window.

You may also tile the open views using Auto Arrange icon on the Home tab and Quick Access Toolbar. This can be helpful when you open a new view. The drop-down on the Auto-Arrange icon allows you to tile windows vertically instead.

Each Forecast Pro view has a hamburger menu in the upper left-hand corner. This menu can be used to access key functionality, such as opening the settings dialog for the view or adding filters to the report.
When you add filters to a report, Forecast Pro includes a filter drop-down on each column, similar to Microsoft Excel. If you click on the filter drop-down, you will bring up a dialog box that allows you to sort and filter values.

From this dialog box you may sort the report by the values in the column. Check Absolute Value to sort by absolute value.

On the drop-down currently selected Numeric, you may select Numeric, Top 10, Above Average or Below Average. The Above Average and Below Average selections are self-explanatory. Selecting Numeric brings up a dialog box that allows you to enter logic for how the report should be filtered.

Selecting Top 10 brings up a dialog box that allows you to show the top or bottom items, based on number of items, percent or volume. While the default is to show the top 10 items, you can change the 10 to whatever value you wish to see.
Finally, you may add heat maps to numeric columns by selecting from the Color drop-down. The heat map colors a cell based on where the cell value falls in the range of values for the column. The default selection, None, is to not use a heat map. The drop-down provides a number of different color schemes to select from. If you choose a color scheme, a heat map with the selected color scheme will be applied.

Each Forecast Pro view also has a context menu. Right click anywhere on an open view to bring up the context menu.

There are fifteen view windows available in Forecast Pro. The following are context specific:

- **Forecast Reports**
- **The Graph Views**
- **The Override Forecasts View**
- **The Diagnostics View**
- **The Tracking Report and Tracking Report Graph Views**

Forecast Report, Graph, Override Forecasts, Diagnostics, Tracking Report and Tracking Graph

Context specific views display information for the current Navigator selection and update automatically as you move about the Navigator.

The remaining nine views are global and include:

(Item Report, 5 Exception Reports, Override Report, Outlier Report and Numeric Output) are global (i.e., their contents pertain to all items forecasted and are independent of the current Navigator selection).

### The Status Bar

The Status Bar, on the bottom of the Forecast Pro window, displays key information about the status of the open project.

On the right-hand side you will see the current hierarchy and current unit definition for your project. As described in **The Navigator Context Menu**, Forecast Pro allows you to group your data in different ways by "shuffling" the hierarchy. The current hierarchy ordering is shown next to Hierarchy icon on the status bar. Forecast Pro also allows you to convert your default units (how the historic data is defined) into alternative measurements, such as dollars, using a Conversions data file (see **Conversion factors** in **Setting Up You Optional Data**). You may change your unit measurement to one of the read-in conversion
factors on the Operations tab. The status bar displays the unit measurement that is selected in the Units drop-down on the Operations tab.

Changing the display units and/or altering the hierarchy will “lock” the statistical forecasts. When the statistical forecasts are locked, you are no longer able to change the statistical forecasting methods used to generate the statistical forecasts and the sections of the Forecast Report that pertain to the statistical modeling (i.e., Expert Analysis, Model Details, Within-Sample Statistics, Out-of-Sample Tests and Outliers) are omitted. If you subsequently return to the default state (i.e., default units and default hierarchy) the statistical forecasts will be “unlocked.” If you are in a locked state, Forecast Pro displays a lock icon with the text “Stat Forecast Locked” on the far right of the status bar.

The left-hand side of the status bar displays dynamic information about the current project status. When using the override grid, it will display totals and average for selected grid rows.

**Forecast Pro Ribbon Tabs**

**File Tab**

Selecting the File tab will take you to the following screen.

The File tab is also sometimes referred to as "backstage". When you are on the File tab, you do not have a view of your project and the rest of the Forecast Pro Interface.

On the top left, common file operations, including New, Open, Save, Save As, Close and Exit, are listed.

In the middle section there are 3 large icons: New Project (opens a new project), Quick Tour (links to a short video) and User Guide (opens the User’s Guide). Beneath these icons you
will see a pane that displays recent projects and a list of all projects in your default project directory (set in the Option settings).

On the right side, there is an Information pane displaying key details about the open project.

**Home Tab**

The most commonly used procedures are available on the Home tab.

**Layouts:** On the left-hand side of the ribbon is the Layouts group. The Layouts drop-down is used to select a saved layout to display. Above the drop-down are four small icons for adding, managing, updating, and removing layouts. Please see details in the “Working with Layouts” section of the Advanced Navigation lesson in *Forecast Pro TRAC Tutorials* or the Working with Layouts chapter in this reference.

**Data Manager:** To the right of the Layouts group is the Data Manager icon. The Data Manager is used to read data into the project. Once data is read in, the Navigator displays all items to be forecast, and the Hot List becomes available for use. Graphs will also become available after data has been read in. Consult Using the Data Manager for details.

**Graphs:** Click on the Graphs icon (with drop-down) to open a graph in the view window for the item selected in the Navigator. Up to four additional graphs may be added to the view window by selecting Add Graph on the Graph drop-down. Finally, you may select Diagnostics on the Graph drop-down to open the Diagnostics view. Details for how to work with the Graph and Diagnostic views are in The Graph Views and The Diagnostics View.

** Overrides:** The Override icon opens the Override view which allows you to adjust forecasts for the selected item. Consult The Override Forecasts View for details.


**Forecast Tracking:** Clicking on the Forecast Tracking icon (with drop-down) opens the Tracking Report view. Note that Forecasts Tracking is only available if there are archived forecasts (forecasts generated in prior periods). The drop-down on the Forecasts Tracking icon allows you to open the Tracking Graph and access the Tracking Report settings. Consult The Tracking Report and Tracking Report Graph Views.

**Numeric Output:** The Numeric Output icon (with drop-down) provides a quick way to save your Numeric Output. Numeric Output Files can contain time series output such as history, forecasts, fitted values and confidence limits as well as statistical output such as the forecasting model specification and summary statistics. These files can be saved in text, spreadsheet, ODBC or XML formats. You can include output for either all items forecasted or just for the Hot List. If you will be importing the forecasts into another application these are the files you will likely want to use.

The drop-down on the Numeric Output icon allows you to open the Numeric Output view (select Show) and the settings associated with the Numeric Output file. The Numeric
Output View displays the contents and format of the currently specified Numeric Output file. You can use the settings to specify the contents of the Numeric Output file. Consult The Numeric Output View and Numeric Output Files for more details.

Excel Collaboration: The Excel Collaboration icon opens the Excel Collaboration dialog box. From this dialog box, you can create and import Excel-based Forecast Pro collaboration sheets. Once created, the collaboration sheets may be distributed to users with a valid Forecaster or Collaborator license. Using the Forecast Pro Excel Add-in, users may review the forecasts and make overrides in Excel. The edited files can then be imported back into the Forecast Pro project, which will then contain the consolidated overrides from all imported users. Excel Collaboration is a fast and easy way to collaborate with multiple colleagues in parallel. Please consult the Collaborating with Colleagues lesson in Forecast Pro TRAC Tutorials or Excel Collaboration in this reference.

Options: The Options icon opens the Options dialog box. This dialog box controls project-level settings, and typically you will want to set your options when you are starting a project. Please consult Forecast Pro Options for details.

Auto Arrange: Forecast Pro allows you to open multiple views in the View Window. These views may be resized and arranged as you wish. The Auto Arrange icon (with drop-down) tiles the open views horizontally. This can be helpful when you open a new view. The drop-down on the Auto-Arrange icon allows you to tile windows vertically instead. Given that opening a new view is often followed by auto arrange, the Auto Arrange icon is also available on the Quick Access Toolbar by default.

Recalculate: This option is only available when Manual override mode or Manual forecast mode is selected on the Performance tab of the Options dialog box (see The Performance Tab). Selecting recalculate will reconcile all forecasts and overrides.

Forecasting Tab

By default, Forecast Pro will use expert selection, an Artificial Intelligence (AI) driven engine, to automatically select a forecasting model for each item on the Navigator. Alternatively, you may select alternative models and/or forecasting options on the Forecasting tab.

Available models, modeling options and Forecasting tab functionality are documented in detail in Custom Forecasts: The Forecasting Tab.

Reports Tab

The Reports tab provide access to all Forecast Pro Views. Details for each of these views are in the Forecast Pro Views chapter.

Graphs: Click on the Graphs icon (with drop-down) to open and close a Graph view for the item selected in the Navigator. Up to four additional graphs may be added to the view
window by selecting Add Graph on the Graph drop-down. Finally, you may select Diagnostics on the Graph drop-down to open the Diagnostics view.

Overrides: The Override icon opens and closes the Override view which allows you to adjust forecasts for the item selected in the Navigator.


Forecast Tracking: Clicking on the Forecast Tracking icon (with drop-down) opens the Tracking Report view for the selected item. Note that Forecasts Tracking is only available if there are archived forecasts (forecasts generated in prior periods). The drop-down on the Forecasts Tracking icon allows you to open the Tracking Graph and access the Tracking Report settings.

Reports Group: The Reports group includes the following:

Exception Reports: There is an icon for opening each of the five Exception Report Views (Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, Waterfall and Custom). The Exception Reports enable you to quickly find cases where your forecast error or some other performance metric has fallen outside of an acceptable range. Exception reporting reduces the need for manual review of your forecasts and allows you to focus on the items where human attention is most needed. A Settings drop-down icon gives access to the settings for each of the Exception Reports.

Item Report: The Item Report icon (with drop-down) opens and closes the Item Report. Item Reports can contain time series output such as history, forecasts, fitted values and confidence limits as well as statistical output such as the forecasting model specification and summary statistics. The drop-down on the Item Report icon allows you to open the Settings dialog box associated with the Item Report. The functionality of the Item Report is essentially the same as the Numeric Output view, but the Item Report allows you to change the view without impacting the structure of the Numeric Output File.

Outliers: The Outliers icon opens and closes the Outlier Report, a global report that list all outliers identified in the project.

Override Report: The Override Report icon opens and closes the Override Report view that shows all current overrides in the project.

Numeric Output: The Numeric Output icon (with drop-down) opens your Numeric Output view. Numeric Output Reports can contain time series output such as history, forecasts, fitted values and confidence limits as well as statistical output such as the forecasting model specification and summary statistics. The drop-down on the Numeric Output icon allows you to open the Settings dialog box associated with the Numeric Output. Note that these setting are typically configured for exporting a file with a defined structure, so changing these settings may disrupt your forecasting process. Consult the Numeric Output View and Numeric Output Files for more details.

Import Tab
The Import Tab includes the functionality for reading in project data as well as several other types of information, possibly from other saved Forecast Pro projects, into your current project.

Data Manager: Clicking the Data Manager icon opens the Data Manager dialog. The Data Manager is used to read data into the project. Once data is read in, the Navigator displays all items to be forecast, and the Hot List becomes available for use. Graphs will also become available after data has been read in. Consult Using the Data Manager for details. Note that the Data Manager icon is also available on the Home tab.

Project Settings: The Project Settings icon is used to import project settings from a saved project into the current project. The settings include all selections on the Options dialog box as well as formatting for reports and output files. Because the settings control how data is read into Forecast Pro, you may only import project settings prior to reading in the data.

Hot List: The Hot List icon is used to import a Hot List from a saved project or from an Excel file into the current project. Excel Hot List files are created using the Hot List icon on the Export tab or using the Export to option on the Hot List’s context menu. If a Hot List currently exists, you will have the option of deleting it prior to importing the new Hot List.

Layouts: The Layouts icon is used to import layouts from a saved project into the current project. Please see details in the Working with Layouts chapter of this reference.

Calculated Rows: The Calculated Rows icon is used to import calculated rows from a saved project into the current project.

Archived Forecasts: The Archived Forecasts icon is used to import archived forecasts from a saved project into the current project. When you select this option a dialog box appears allowing you to specify the origin date for the archived forecast sets that you wish to import.

Archived Overrides: The Archived Overrides icon opens the Import Archived Overrides dialog box which is used to load override sets from the current Forecast Pro database.

You can load an individual override set by highlighting the set and clicking the Apply button. Alternatively, you can load all displayed sets using the “Apply all sets” button. The “Filter by” options allow you to control which override sets to display. Selecting “Compatible series” will eliminate all override sets that do not match the current state (i.e.,
it will eliminate all override sets where the units of measure and/or the hierarchy structure does not match the current project’s display).

The most common use for this facility is loading override sets made last period after updating the statistical forecasts. For an override from the selected override set to be loaded, the item name and ancestry must match an item in the current project.

**Export Tab**

Reports Group: The Reports Group includes functionality to export the Numeric Output or any of the Forecast Pro reports for all or a subset of the items in your project.

On the left-hand side of the group, you can select which items you want to export. You may select Current Display (includes the items shown if you opened the report view, including any active filters), All or Hot List (items currently displayed in the Hot List). Clicking any of the Group icons (Numeric Output, Forecast Report, Item Report, Outliers, Override Report, Forecasts Tracking, Forecast vs. History, Forecast vs. Archive, Forecast Accuracy Waterfall and Custom) will prompt you to save the report for the specified items.

Note that the Forecast Report icon will save a Formatted Forecast Report, including a tab for each exported item, in the saved Excel file.

Other Group: The icons in the Other Group prompt you to save the Hot List, Helpers, Calculated Rows or Modifiers in the saved current project. These files may then be read into another Forecast Pro project with the Import tab.

**Operations Tab**

Date Range Group: The Date Range controls are used to set the span of data used when estimating forecast models, define a holdout sample and reset dates to the default of using all available data without a holdout sample. to manage

Year and Period: The Year and Period spinners are used to define the fit set. All time series methods begin by fitting the coefficients of a model to historic data. You can alter the beginning year and beginning period to specify the first point of the fitting sample and/or the ending year and ending period to specify the last point. By default, Forecast Pro selects the largest fit set for which data exists. Normally, you will want to accept the defaults. However, you may want to ignore earlier data if you distrust their relevance.

Holdout Periods: This spinner is used to specify the length of a holdout sample. When using a holdout sample, Forecast Pro withholds the specified number of periods at the end of the data from the model fitting. If you withhold 2 or more points, Forecast Pro
automatically generates out-of-sample evaluation statistics for any models that you build. These statistics are available in the Forecast Report. If you do not want to perform out-of-sample testing, set the holdout sample to zero.

Read Data: The Read Data icon reads in the Historic Data defined in the Data Manager from its primary source along with any other inputs where the on Read option is selected.

Forecast: Clicking the Forecast icon generates statistical forecasts. This option is only available when historic data has been defined in the Data Manager and the data has been read in. Changes to the date range used may require you to re-forecast the data.

Recalculate: This option is only available when Manual override mode or Manual forecast mode is selected on the Performance tab of the Options dialog box. Selecting the Recalculate icon will reconcile all forecasts and overrides.

Simulate Archive: The Simulate Archive icon is used to generate statistical forecasts for previous forecast origins (last period used to generate a forecast) and to insert them into the Forecast Pro database. Essentially this is a form of simulation that allows you to initialize the forecast archive with statistical forecasts. Clicking the Simulate Archive icon opens the following dialog box.

![Simulate Archive dialog box](image)

The Simulate Archive dialog box allows you to specify how many periods you wish to initialize or simulate. Forecasts will be generated for the specified period and all subsequent periods up to the current origin.

In the example above, the current origin (last period of historic data) is June 2020. The periods to initialize is set to 12, which corresponds with a forecast origin of June 2019 (12 periods prior to the current origin). Simulation would begin by generating forecasts using data up to and including June 2019 and inserting them into the database. It would then generate forecasts using data up to and including July 2019 and insert them into the database. It would continue this process until all 12 forecasts sets had been generated and inserted into the database.

Time Fence Group: Please consult Using a Time Fence for a detailed description of time fences.

Enable: The Enable icon turns on a time fence for the current project. Once you turn a project’s time fence on, it cannot be turned off!

Freeze Next Period: Clicking the Freeze Next Period icon will increase the length of all time fences in the current project by one period. If you subsequently, update your data with the next observation and create a new forecast (thus changing the forecast origin), the time fence length will revert back to their pre-Freeze-Next-Period settings. This option provides a way of insuring that after the forecasts are finalized someone doesn’t inadvertently alter the frozen periods’ forecasts prior to the data being updated, new forecasts being generated and the frozen periods’ forecast becoming an officially fenced value.
Control Panel: The Control Panel icon invokes the TRAC Control Panel dialog box which is used to view information about the current project’s database and to purge unwanted (e.g. obsolete) forecasts and overrides.

Important: To reduce the size of the Forecast Pro database file, you must use the Compact button after purging forecasts and overrides. Purging without compacting results in the records being deleted from the database but does not change the file size.

![TRAC Control Panel](image)

The grid displays the contents of the database.

The Purge Forecasts button will delete all forecasts prior to the specified date.

The Purge Overrides button will delete all overrides prior to the specified date.

The Compact button consolidates the Forecast Pro database file. Use this button to reduce the size of the database file after purging forecasts and/or overrides.

Set password: This icon is used to password protect your project. When you attempt to open a password-protected project, Forecast Pro will prompt you for the password and only open the project if the correct password is entered.

Super Project: The Super Project icon invokes the Super Project Manager. The Super Project Manager is used to consolidate multiple projects into a “super project” or to update a super project.

Setting up and maintaining a super project is reasonably complex. If you are planning on using super projects you should (1) refer to the Collaborating With Colleagues lesson in Forecast Pro TRAC Tutorials for a discussion of the pros and cons of super projects and an illustration of using the Super Project Manager to create a super project and (2) read the Working With Super Projects in this reference carefully. Business Forecast Systems and Forecast Pro distributors also offer consulting services to help you establish your forecasting process.
When creating a new super project, you first use the Add button to select the component projects to consolidate. The Import options allow you to specify what you wish to import from the component projects. When first creating a super project, you will generally import everything. When updating a super project, you may want to pick and choose what to import.

The “Erase first” options are only relevant if you are updating a super project. If selected, they will erase any data corresponding to the specified component prior to loading in the new data.

After you have selected the component projects and the import selections, the Apply button is used to create or update the super project.

Units: The Units drop-down box is used to change the display units. This box will only be available if you have defined conversion factors for your current data set in the Data Manager. The Units icon on the status bar will display the Units drop-down selection. Consult Conversion Factors in Setting Up Your Optional Data for details.

Help Tab

Forecast Pro includes extensive on-line help.

Tutorials: The Tutorials icon opens a pdf version of Forecast Pro TRAC Tutorials. These tutorials are designed to give you an overview of Forecast Pro’s functionality. The tutorials are organized into two section: General Operations and Forecasting Operations. The General Operations tutorial is designed to teach you how to use the Forecast Pro interface, while the Forecasting Operations tutorial focuses on customizing your models and forecasts.

Program Reference: The Program Reference icon opens a pdf version of the Forecast Pro TRAC Reference.

Check for Updates: This icon will check online to see if you are running the latest release of the program. If a product update is available, you'll receive a message alerting you to this fact with instructions describing how to receive the update. If your support and maintenance contract is up to date, product updates are free.

About Forecast Pro: This icon displays the Forecast Pro version number and copyright notice.

**The Navigator Context Menu**

The Navigator’s context menu provides a convenient way to build a Hot List, apply forecast modifiers, control the display of the Navigator tree and rearrange the hierarchy. Most of the options are self-explanatory, however a few warrant some explanation.

The options under Add to Hot List are used to copy items onto the current Hot List (the Hot List is described in the next section). *Children*, *Parents* and *Siblings* refer to one level down on the current Navigator branch, one level up on the current branch and the same level on the current branch respectively. On the Analysis submenu, *Overrides* refer to items with direct overrides and *Affected* refers to items with indirect overrides (i.e., items where a direct override elsewhere in the hierarchy changed the item’s forecast).

The Model, Events, Component Model, Dynamic Regression, Weights, Outliers, Top-down, Custom Allocation and Indexes options are all used to specify forecast modifiers. The most commonly used modifiers can be applied directly using the menu options. The less commonly used modifiers can be entered from the keyboard using the Custom Modifier option. All forecasting-related functionality on the Navigator’s context menu is also available on the Forecasting tab. Please consult *Custom Forecasts: The Forecasting Tab* for details on available forecasting options and supported forecast modifiers.

The Hierarchy option is used to “shuffle” (rearrange) the hierarchy displayed on the Navigator. Reading data into Forecast Pro establishes the default hierarchy. If the default hierarchy contains 4 levels, the notation 1-2-3-4 is used to represent the default state. Hierarchy>Promote and Hierarchy>Demote redefine the hierarchy by moving the currently selected level “up” or “down” one level. For example, moving level 3 of a 4-level default hierarchy, would change the displayed hierarchy from 1-2-3-4 to 1-2-4-3. Hierarchy>Move to Top promotes the currently selected level to the highest level, Hierarchy>Move to Bottom demotes the currently selected level to the lowest level and Hierarchy>Restore Default converts the currently displayed hierarchy back to the default hierarchy.

The Helper Variable>Create option is used to access the Create Helper Variable dialog box. This utility allows you to create helper variables based on your current Navigator selection. You may also access the Create Helper Variable dialog box from the Forecasting tab. Please consult *Helper Variables* in *Custom Forecasts: The Forecasting Tab* for details on creating helper variables.

If you select a helper variable on the Navigator, you can use the Helper Variable>Delete option to delete it from your project.
Chapter 6: Working with Layouts

Layouts (previously known as Bookmarks) are an excellent way to standardize your forecasting process. Layouts allow you to save and return to setting and window view configurations. If you set up your forecasting process with layouts, you can easily access the key information you need each time you update your project. Please consult the Working with Layouts lesson and the Touring the Five Reports section of the Exception Reporting lesson in Forecast Pro TRAC Tutorials for more details on using layouts.

To make a layout, you first create a project view that you find useful. For example, you may want to have a graph view and an item report filtered to products with less than 12 periods of history. If you are using monthly data, this view will show you all items with less than a year of history. You can view each item in the graph by clicking on each item in the item report list. Next, you will want to save that view as a layout.

Layouts are managed from the Home tab.

Adding Layouts

The + icon opens the Add Layout dialog.

To add a layout, simply enter a layout name, a description (if desired) and click OK. If you click on the Layouts drop-down list, you will now see your saved layout included. If you select your layout from the drop-down menu, Forecast Pro will display the view and setting configurations as saved in the selected layout.

Managing Layouts

The Layout settings can be configured by clicking the Manage Layout icon ( landlords ) to open the Layout Manager dialog box.
Name: This drop-down shows four Layout commands, New, Rename, Save As and Delete, as well as the layouts that have been saved to the current project. The drop-down displays the currently selected layout.

New: Selecting new will open the Add Layout dialog box described above.

Rename: Opens the Rename Layout dialog box where you can enter a new name.

Save As: Opens a Save As dialog box that will take the settings for the selected layout, along with any changes you have made in the Layout Manager dialog and create a new layout with the specified name.

Delete: Removes the selected layout from the current project.

Refresh: The Refresh button updates the currently selected layout with specified changes.

Delete: The Delete button removes the selected layout from the current project.

View Display: The View display allows you to specify, for each Forecast Pro view, if you want the selected layout to save Display and/or settings configurations for the selected view. The Display includes View window status (open, closed etc.) and view location, while the Settings include anything that is specified in the view’s Setting dialog box. Display is checked for all views that should be shown in the layout. If a view has Settings checked but not Display, Forecast Pro will load the settings as specified in the layout by not open the view window. This may be useful if you want to export reports with saved settings, but you do not want to view the Report in Forecast Pro.

Include hot list: Check this if you want the layout to save hot list items, so that when the layout is selected the hot list displays those saved items.

Include selected item: Check this if you want the layout to associate the item selected on the Navigator with the layout.

Include navigator layout: Check this if you want the layout to save the Navigator layout (e.g. which nodes are open) and update the Navigator when you select the layout.
Layouts may be removed and refreshed directly from the Home tab using the remove layout icon ( □ ). Clicking on the remove layout icon opens the Remove Layout dialog box. Simply select the layout you want to remove and click OK to remove a layout from the Layouts drop-down and the current project.

Layouts may also be refreshed directly from the Home tab with the refresh layout icon ( ⌈ ). Click the refresh icon to launch the Refresh Layout dialog box. Selecting a layout in the dialog box and clicking OK will replace the selected layout with the current Forecast Pro view and settings.
Chapter 7: Using the Data Manager

The Data Manager provides a centralized place to define all of the input data for Forecast Pro and keep it up to date.

Row Types

You invoke the Data Manager by clicking the Data Manager icon on the Home tab.

The Data Manager consists of eight rows each of which allows you to read in a different type of data.

In addition to the *Historic Data* (which is required), Forecast Pro’s Data Manager allows you to import other information to assist you in creating and working with the forecasts. Specifically, you can import:

- **Conversions Factors.** Conversion factors allow you to display the history and forecasts in alternative units of measure (e.g., dollars, kilos, etc.).
- **Explanatory Variables.** Variables that you may wish to include in a dynamic regression model may be read in with an explanatory variable file.
- **External Data.** Forecast Pro allows you to import external data rows (such as alternative forecasts, open orders, etc.) into the forecast override grid.
- **Filter Fields.** Filter fields can be included in report views and filtered like any other fields. They can also be included in the numeric output file.
- **Definitions.** Definition files contain values to use in conjunction with custom forecast allocations and item-level integer rounding quantities.
- **Overrides.** In addition to entering forecast overrides interactively using the Forecast Overrides view, Forecast Pro allows you to import them.
**Helper Variables.** Helper variables are used in conjunction with event models, forecast by analogy models and weighting transformations.

**Modifiers.** In addition to specifying forecast modifiers interactively on the Navigator, Forecast Pro allows you to import them.

**Row Controls**

Each row has a number of controls associated with it allowing you to specify data sources, remove data sources and read the data.

**Add drop-down.** The Add drop-down is used to select data sources. You first specify the type of data source you will be adding (Excel, MLT or ODBC) and then the program will prompt you to specify the file, table or query. The Overrides, Helpers and Modifiers rows also allow you to specify a Forecast Pro project as the data source. If you wish to specify multiple data sources for a given row, you may. The first time you add an ODBC data source you will be prompted to choose an ODBC driver and connect to the database.

![Data Manager](image)

**Selected data sources drop-down.** After you add one or more data sources to a given row, the filenames, table names, query names, or project names will appear on the selected data sources drop-down display. If you open this drop-down, you will see a list of the selected data sources along with a checkbox to the left of each one. This check box is used to mark the source as active or inactive. When you read the data, only the active data sources will be read.

**Remove drop-down.** The remove drop-down is used to remove data sources from the row. You have the option of either removing all specified data sources or only the inactive (unchecked) ones. After you use the Remove drop-down you will need to refresh the row to delete the data from the current project.

**Status box.** The status box displays the current status for the data sources specified on the row. “Refresh pending” means that the current row specifications do not match the project’s current state and you need to refresh the row to sync them with the project.
Read & Forecast button. The Historic Data row includes a button labeled “Read & Forecast”. Clicking the button will read in the historic data and generate the forecasts. It will also refresh (i.e., read or re-read) any data rows where the “on read” option is selected.

Refresh button. The refresh button is used to read (or re-read) the data for the specified row.

On Read checkbox. Four of the rows include an “on Read” checkbox. If this option is selected Forecast Pro will automatically refresh the row whenever you read in the historic data. The on Read option is useful when the associated data will be changing each forecast period.

Notice that the Overrides, Helpers and Modifiers rows do not have on Read options and therefore can only be refreshed by clicking their Refresh buttons. This is due to the fact that overrides, modifiers and helper variables can all be modified interactively using Forecast Pro, and therefore refreshing them automatically from the data source may have unintended consequences (e.g., overriding your manual changes, etc.)

Refresh All button. The Refresh All button will refresh all data rows with the exception of the Historic Data. Note that it will refresh all rows that have defined data sources even if their status is up to date.
Chapter 8: Forecast Pro Options

The Options icon on the Home tab the Options dialog box which is used to change various Forecast Pro settings.

The Options dialog box contains both a Set as Default button and an OK button. Clicking the OK button will save your current settings for use with the current project. Clicking the Set as Default button will save your current settings for use with the current project and save them as the default settings for all new projects.

The Options dialog box contains eight pages or tabs. We will discuss each in turn.

The Basics Tab

The Basic tab contains frequently accessed settings that every user should understand.

File Settings:

Input Data. the complete path name of the directory where the program should read data.

Projects. Specify the complete path name of the directory where the program should write the project files.

Output. Specify the complete path name of the directory where the program should write all output files (e.g., Numeric Output files, Forecast Reports, etc.).

Forecast Options:

Allow negative forecasts. Most business data are inherently positive, although there are exceptions like telephone connection gain or sales data that include returns as negatives. Users with positive data are understandably disturbed when their forecasts turn negative. This can occur when Forecast Pro captures a downward trend at the end of your historic
data. If **Allow negative forecasts** is turned off, Forecast Pro will clip forecasts to zero that would otherwise be negative. If **Allow negative forecasts** is turned on, then Forecast Pro takes no special actions to avoid negative forecasts.

**Forecast horizon.** Specify how many periods ahead you want Forecast Pro to forecast.

**Upper confidence limit.** Specify the percentile for the upper confidence limits. The upper confidence limit for a specific item can also be specified using the `Upper=` modifier.

**Lower confidence limit.** Specify the percentile for lower confidence limits. The lower confidence limit for a specific item can also be specified using the `Lower=` modifier.

**Safety stock lead time.** Specify the lead time for the safety stocks. The specified lead time appears highlighted in the Safety Stock section of the Forecast Report and determines the values written to the Numeric Output file. Fractional entries (e.g., 1.5) are permitted.

## The Formats Tab

The Formats tab controls the formatting of the input and output.

**Input Data:**

**Decimal separator.** Specify whether a period or a comma is used for the decimal point. The program’s default is the convention appropriate for the United States, which is the period.

**Column delimiter.** Specify whether items in an MLT file are separated by spaces, commas or tabs (i.e., are the files space delimited, comma delimited or tab delimited).

**Thousands separator.** Specify the thousands separator used for input MLT files. The choices are none, comma and period. Forecast Pro does not use thousand separators in output.

**Automatically sort.** By default, the Automatically sort option is selected and Forecast Pro will merge and sort all historic data sources prior to reading them in. This can be useful when the order of the items in your data sources do not match the desired hierarchy. If the
Automatically sort option is not selected, Forecast Pro reads in your historic data sources sequentially and bases the structure of the Navigator’s hierarchy on the order of appearance of the items in the data sources.

Include group totals for data files. If this switch is on, Forecast Pro will automatically include a group total for each data file, table or query listed on the Historic Data row of the Data Manager. Including or not including a group total for the data files will yield different hierarchies on the Navigator.

Allow zero valued conversion factors. If this switch is on, Forecast Pro will allow blanks or zeros or missing rows in a conversions file specified in the Data Manager. Forecast Pro will give warnings about the missing data, and changing project units using the Units drop-down on the dialog bar is not enabled. However, the converted rows are available in the Overrides Report and Graph views. Blanks will be considered to be zeros, and items with either zero or blank conversion factors will consequently not be included in the totals for those conversion factors. If this switch is not on, Forecast Pro will give an error and not read in a conversions file with blanks, zeros or missing rows.

Zero demand threshold. If you set the zero demand threshold to "N" and the Discontinue option is not selected, Forecast Pro’s expert selection mode will generate a forecast of zero for any item where the last N historic observations are equal to zero. If you set the zero demand threshold to "N" and the Discontinue option is selected, Forecast Pro’s expert selection mode will discontinue and therefore not forecast any item where the last N historic observations are equal to zero.

Ignore leading zeros. If this option is selected, leading zeros prior to the first nonzero data point will be ignored (i.e., the data has not started yet and the zeros are interpreted as placeholders). For a more complete discussion on the handling of missing data and the distinction between a zero value and a missing value, please refer to the Missing Values and Zeros section in the Setting Up Your Historic Data chapter.

Ignore trailing zeros. If this option is selected, trailing zeros after the last nonzero data point will be ignored (i.e., the data has ended and the zeros are interpreted as placeholders). This means that the time series would be considered “dead” in multiple-level scripts and not forecasted. In nonmultiple-level scripts the forecasts for the time series would begin after the last nonzero point. For a more complete discussion on the handling of missing data and the distinction between a zero value and a missing value, please refer to the Missing Values and Zeros section in the Setting Up Your Historic Data chapter.

Missing Values. Specify how you wish the program to treat missing values. The options are: truncate the data set (i.e. discard all data that precedes the missing value), impute the missing data via a linear interpolation or set missing data points to zero. Regardless of how this option is set, missing values that appear prior to the first data point are ignored. For a more complete discussion on the handling of missing data and the distinction between a zero value and a missing value, please refer to the Missing Values and Zeros section in the chapter entitled Setting Up Your Historic Data.

Allow no history. If this switch is on, Forecast Pro will create a forecast of zero per period for items that have no historic data. If the switch is off, items with no historic demand will be omitted and not appear on the Navigator.

Set trailing blanks to zero. When historic data is read into Forecast Pro, the program establishes a global ending date for the history which corresponds to the most recent observation available for any item being read in. If a given item does not have a historic observation for the global ending date, the item is flagged as “dead.” Dead items are not
forecasted but their demand history goes into the group totals. This can be an issue if your data source codes zeroes as missing (e.g., blank cells in Excel, no transaction in a table or query, etc.). The *Set trailing blanks to zero* option will replace missing trailing observations with zeroes. For a more complete discussion on the handling of missing data and the distinction between a zero value and a missing value, please refer to the Missing Values and Zeros section in the *Setting Up Your Historic Data* chapter.

**Text Files:**

*Text file encoding.* Specify the format to use when writing two-byte characters to text files. This option is only of relevance if your data or scripts utilize non-ASCII characters. (Non-Latin based languages such as Japanese, Chinese, Russian, Arabic, etc. use non-ASCII characters.)

*Code page.* Specify the Windows code page to use when text file encoding is set to multi-byte. The code page specifies the character set to use when writing a multi-byte text file. (Most code pages are designed to support a specific language.)

**Display Precision:**

*Numeric.* Specify the precision (i.e., number of decimal places) to use when displaying time series data in the view windows.

*Percentage.* Specify the precision (i.e., number of decimal places) to use when displaying percentages in the view windows.

**The Outliers Tab**

![The Outliers Tab](image)

The Outliers tab is used to specify whether or not to detect and/or correct outliers. It also allows you to set the sensitivity settings for outlier detection and to dictate the amount of detail in the outlier report.

*Detection and Correction Logic:*

- **None**
- **Detection only**
- **Detection and correction**

*Rules:*

- Disable correction for initial 0 and/or final 0 data points
- Set history to zero if number of non-zero data points ≤ 4 and total number of data points ≥ 24

*Layout:*

- Include iteration statistics in reports
- Include Pareto statistics in reports

*Set as Default*

*OK* *Cancel* *Help*
None turns outlier detection off. The forecasts will be generated using the uncorrected history.

Detection only will detect outliers and display the suggested corrected values, but the forecasts will be generated using the uncorrected history.

Detection and correction will detect outliers and will automatically use the corrected values when generating forecasts.

Sensitivity (std. deviations) allows you to set the sensitivity of the outlier detection algorithm. If a given fitted error exceeds this threshold and it is the largest error detected during the current iteration it will be flagged as an outlier. Consult the Forecast Pro Statistical Reference Manual for details on how outlier detection and correction works.

Maximum iterations allows you to set the maximum number of iterations permitted during outlier detection for a given item. This setting thereby also defines the maximum number of outliers that can be detected for a given item. Consult the Forecast Pro Statistical Reference Manual for details on how outlier detection and correction works.

Rules:

Disable correction for initial X and/or final Y data points allows you to disable correction for data points at the beginning or end of an item. The outlier detection algorithm is sometimes less robust for the beginning and ending historic periods. Disabling correction for the initial and ending periods can avoid possible misidentification of outliers in these cases. Consult the Forecast Pro Statistical Reference Manual for details.

Set history to zero if number of non-zero data point is <= X and total number of data points >= Y allows you to set the entire history to zero for an item if the number of zeros meets a specified threshold and the total number of historic data periods exceeds a specified threshold.

Layout:

Include iteration statistics in reports allows you to include detailed statistics describing the outlier detection process in the outlier report. Consult the Forecast Pro Statistical Reference Manual for details.

The other options in the Layout section allow you to include columns for the Pareto output and to include columns for custom filters (if there are any defined).
The Overrides Tab

The Overrides tab controls operation and display of the Override view.

Adjustment mode. If this selection is set to “Override” any overrides entered will replace the corresponding baseline forecasts (or overrides entered on a preceding row). If this switch is set to “Incremental” overrides you enter will be added as incremental adjustments to the baseline forecast rather than replacing it. Thus the final forecast will equal the sum of the statistical forecast and all overrides entered. If you attempt to change this setting when overrides exist for the current project, you will receive a warning and all overrides will be erased.

Number of adjustment rows. This setting controls the default number of adjustment rows displayed in the Override view.

Allow disaggregation. If this switch is on, the Override window will include a “Disaggregate to” drop-down box, allowing you to disaggregate (i.e., push down) any overrides made at a group level to a lower-level of the hierarchy. The disaggregation is based on a proportional allocation.

Number of live history periods. This setting controls the number of historic periods shown on the override grid when the history display option is set to Time Series. When working with large projects this setting can have an impact on performance (i.e., speed).

Time Fence: Number of periods. This option allows you to set the default length for the time fence. This setting can be overridden on an item-by-item basis using the \TIMEFENCE= modifier.
Forecast Pro supports command-line operation allowing you to create forecasts in a “hands-off” mode. For a complete description of how to run the product from the command line, consult Command Line Operation.

The Command Line tab allows you to dictate the options to apply if the current project is run via the command line.

Project Components to Apply:

Modifiers. This drop-down is used to control which modifiers to use when running from the command line. There are four options available: None, Project (default), Data Source and Project and Data Source. If None is selected, expert selection will be used for all items. If Project is selected, Forecast Pro will apply modifiers as specified in the Project's Navigator. If Data Source is selected, Forecast Pro will consider only modifiers specified in the Data Manager. If Project and Data Source is specified, Forecast Pro will apply modifiers specified in the Navigator for items that do not have a modifier in the Data Source and apply Data Source modifiers to items that have them.

Overrides. This drop-down is used to control which overrides to apply when running from the command line. There are four options available: None, Project (default), Data Source and Project and Data Source. If None is selected, all overrides in the project and Data Manager override files will be ignored. If Project is selected, Forecast Pro will apply any matching overrides/comments in the project to the statistical forecasts. If Data Source is selected, Forecast Pro will apply only overrides specified in the Data Manager. If Project and Data Source is specified, Forecast Pro will first load overrides from the Project and then from the Data Source. Thus, the Data source will take precedence over the Project for all override cell values.

Settings. If this option is selected, the command-line run will use all of the settings associated with the project (e.g., all settings in the Settings dialog box, numeric output
formatting, etc.). If this option is not selected, the default settings (i.e., the settings that have been saved as the defaults for use with new projects) will be used when running from the command line. Project settings are saved in the project file (*.FPProj). Default settings are stored in the ForecastProTRAC.ini file.

Output Files:

Numeric output. If this option is selected, the command-line run will save the numeric output. You have the option of saving this file for all items forecasted or (if you select Hot List only) just for the items listed on the Hot List.

Forecast Report. If this option is selected, the command-line run will save a formatted forecast report file to Excel. You have the option of saving this file for all items forecasted or (if you select Hot List only) just for the items listed on the Hot List. Keep in mind that these files can potentially be very large.

Tracking Report. If this option is selected, the command-line run will save a forecast tracking report file to Excel. You have the option of saving this file for all items forecasted or (if you select Hot List only) just for the items listed on the Hot List. Keep in mind that these files can potentially be very large.

Item report, Outlier report, Override report and Exception report. If any of these options are selected, the command-line run will save the specified report(s). The format and contents (including all items vs. Hot List only) will match the current settings in the project (or the defaults if you’ve specified to use them).

Project. If this option is selected, the command-line run will update and save a new project file.

Archive forecasts. If this option is selected, the command-line run will update and save the TRAC database file. You should select this option if you are archiving forecasts for tracking purposes.
The Pareto tab allows you to specify how the ABC codes should be assigned.

**Weighting Basis:**

*History* and *Forecasts*. These settings allow you to indicate whether the ranking should be performed using the historic demand or the current forecasts. The *Period* spinner(s) allows you to set the span for your selection.

*Hierarchy level*. The ABC codes are assigned to a single level of the hierarchy. The Hierarchy level drop-down allows you to pick the level to use.

*Units*. If you have defined conversion factors, this option allows you to select the unit of measure on which to base the ABC code assignments. *Default* refers to the unit of measure used for the historic demand data you read into Forecast Pro.

**Ranking Basis:**

*Volume (%)*. This option allows you to set the codes based upon the cumulative volume of each group. For example, if A is set to 80%, B is set to 15% and C is set to 5%, Forecast Pro will first rank all of the items from highest volume to lowest volume and then sequentially place the top ranked items into the A group until their cumulative volume equals or exceeds 80% of the total volume. It will then sequentially place items into the B group until the cumulative volume of the A and B items equals or exceeds 95% (80% + 15%). The remaining items (5% or less of the cumulative volume) are assigned type C.

*Series Count (#)*. This option allows you to assign specific numbers of items to each group. For example, if you had 1,000 items and you set the A group to 100, the B group to 200 and the C group to 700—the 100 highest volume items would be assigned to group A, the next highest 200 items would be assigned to group B and the remaining 700 would be assigned to group C.
Series Count (%). This option allows you to assign a specified percentage of the total number of items you have to each group. For example if A is set to 20%, B is set to 50% and C is set to 30%, Forecast Pro will first rank all of the items from highest volume to lowest volume and then sequentially place the top ranked items into the A group until the number of A group items equals 20% of the total number of items. It will then sequentially place items into the B group until the number of B group items equals 50% of the total number of items. The remaining items (30% of the total number of series) are assigned type C.

Group zero volume. Weighting Basis: If this option is on, any items having zero volume are placed into group D.

Total series. This displays the total number of series in the selected hierarchy level.

The Performance Tab

![The Performance Tab](image)

The Performance tab allows you to set expert selection options, select manual recalculation modes and set project operations. Adjusting these settings can improve processing speed and decrease time waiting for project operations and calculations.

Expert Selection:

Exclude ARIMA. If this switch is on Forecast Pro’s expert selection mode will not consider Box-Jenkins models. This will speed the forecast generation process considerably.

Exclude seasonal simplification. If this switch is on Forecast Pro’s expert selection mode will not consider seasonally simplified forms of exponential smoothing models. If you are forecasting data where the number of periods per cycle is greater than 13 (e.g., weekly data) this will speed the forecast generation process considerably.

Exclude NA-constant level. If this switch is on Forecast Pro’s expert selection mode and automatic exponential smoothing mode will not consider the NA-constant level model. This will speed the forecast generation process considerably.
Recalculations:

Manual override mode. If this switch is on, the override window will include a Retain button as well as a Commit button. The Retain button is used to apply and save overrides without reconciling the hierarchy. This is useful when working with large complex hierarchies where the reconciliation process takes some time. In manual reconciliation mode you would typically enter and retain all of the overrides you wish to make (i.e., for multiple items) and then click the Commit button or the red Recalculate icon to perform the reconciliation once, rather than having to wait for the program to reconcile after each item that you override.

Manual forecast mode. If this option is not selected, Forecast Pro will automatically recalculate the forecast and re-reconcile the hierarchy every time you apply a forecast modifier. For large hierarchies this can be time consuming. If you turn this option on, when you specify a forecast modifier the forecasts will not be updated until you click the red Forecast icon (’) or the red Recalculate icon (’). This allows you to specify multiple forecast modifiers without having to wait for the program to recalculate the forecasts in between each specification.

Operations:

Load archives with project. If this option is selected, Forecast Pro will cache the forecast archive information in memory when you open a project. For very large projects this can take some time. If this option is deselected, the forecast archive information will not be cached until the first time you execute an action that requires access to the forecast archive (e.g., opening the forecast tracking report or opening an exception report which uses the archive). Deselecting this option will speed up opening projects and decrease memory usage for individuals who do not need access to the information in the forecast archive.

Periods to retain in archive. This option allows you to limit the number of previous-origin forecasts (i.e., forecasts you generated in prior forecasting periods) to save in the forecast archive. Reducing the number of archived forecasts will reduce the size of the project’s database and speed up program operations.
The Advanced tab allows you to set Integer Forecast settings, Date Control features and adjust how frequently Forecast Pro checks for program updates.

Integer Forecasts use a special form of rounding that keeps track of the “remainder” (rounded amount) and applies it to the next period’s forecast value. This is particularly useful for low-volume forecasts or when there are large minimum order quantities, where traditional rounding can result in biased forecasts.

Consider a flat forecast of 0.4 units per month for the next 12 months. If you were to use the ROUND() function to round the forecast to the nearest integer the forecast would become, “0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0”. An integer forecast row for the same forecast would be, “0, 1, 0, 1, 0, 0, 1, 0, 1, 0, 0, 1”.

**Integer Forecasts:**

*Default rounding quantity.* Specifies the integer rounding quantity (the basis to round to the nearest multiple of) for Integer forecasts.

*Rounding method.* This drop-down allows you to choose round, round up or round down to the nearest multiple of the default rounding quantity.

*Accumulate during history.* Selecting this option instructs Forecast Pro to start tracking the remainder during the history rather than starting with the first forecast—this is generally desirable.

*Archive.* Saves Integer Forecasts to the project’s database. Archived Integer forecasts can be accessed through database queries.

**Date Controls:**

*Display dates generically.* If this option is selected, then monthly labels will be displayed using period numbers rather than the names of the months. For example, “2019-01” will be
used rather than “2019-Jan”. This option is often used when working with a fiscal calendar where displaying the names of the months could be confusing.

*Import date labels.* If enabled, Forecast Pro will import date labels from either the helper or historic data source (in the header row or column). If using a helper file, create a helper variable called `_Date` for the date labels. Date labels may be either text or numeric. If the labels are numeric and regularly spaced (time between adjacent periods is always the same), the labels will be extrapolated into future forecast periods. Numeric labels will also be formatted according to the User’s locale settings, as specified in Microsoft Windows settings. For ODBC data inputs, date labels must be provided in a helper file. Forecast Pro will prioritize labels in a helper file over those provided in the historic data source. These imported labels will be used in all views instead of the Forecast Pro’s standard dates. If *Import data labels* is not checked and a helper file includes a helper variable called `_Date`, Forecast Pro will treat `_Date` like any other variable and not use it for date labels.

*Check for product updates automatically.* If this option is selected, Forecast Pro will periodically check online for product updates and alert you if they are available. If your support and maintenance contract is up to date, product updates are free.

*Dynamic Regression:*

*Auto extend.* If this option is selected, Forecast Pro will generate forecasts for explanatory variables that do not have input values for the forecast horizon. Forecast Pro will use any provided values and only generate forecasts where they are missing. If this option is not selected, a dynamic regression model is selected for a given item and explanatory variable values are not provided for the entire forecast horizon, Forecast Pro will use expert selection instead of the specified regression model for that item.
Chapter 9: The Forecast Pro Views

The Forecast Report View

The Forecast Report view is a scrollable text display containing information about the forecasts and how they were generated. In addition to providing a convenient way to view information while using Forecast Pro, the Forecast Report view is also used to design the text section of the formatted forecast reports that are output to Excel.

The Forecast Report is opened and closed with the Forecast Report icon on the Home tab or the Reports tab.

The Forecast Report Settings dialog box allows you to customize the Forecast Report view. This dialog box is invoked by selecting Settings on the Forecast Report icon drop-down on the Reports tab, by selecting Settings from the Forecast Report view’s context menu, or by selecting Settings on the hamburger menu in the upper left corner of the view window.

You can either select one of the four standardized report styles or define a custom report. Include graph in output can be used in conjunction with any style report and specifies whether to include or omit a graph when saving a Formatted Forecast Report to Excel. The settings for the saved graph may be specified in the Graph view, as described below. A description of each report style appears below. A description of each report style appears below.

*Forecast Only* is a minimal display consisting solely of the forecasts.

*Basic* displays a listing of the forecasting model used, a set of the most commonly used within-sample statistics and a forecast display including confidence limits and summary statistics.

*Standard* is the default display. It includes the expert selection logic (if applicable), the model details including model coefficients, a full set of within-sample statistics, a safety
stock display, a listing of detected/corrected outliers (if outlier detection is active), a listing of any overrides and the same forecast display found in the Basic style.

Complete displays everything found in the Standard display as well as a numeric listing of the historic values, fitted values, converted forecasts and an expanded forecast display.

Custom allows you complete control over what is included in the display. The Historic Data, Forecast Data and Regression tabs on the Forecast Report Settings may be used to specify details about the components to include when Custom is selected. Your selections under the Custom option are automatically retained for the project allowing you to switch between the Custom style and one or more of the standard styles without having to reset your custom settings.

Important note: The Within-sample and Out-of-sample Stats tabs allow you to set the numeric precision for the within-sample and out-of-sample statistics. You also have the ability to set precision for regression model details on the Regression tab. These precision settings are used for both Custom and standard report styles.

The Graph Views

The graph views are used to display variables and forecasts graphically. You can include up to five graph views. In addition to providing a convenient way to view the forecasts while using Forecast Pro, a graph can also be included in the formatted forecast reports that you save to Excel. The format and content of the formatted forecast report’s graph will match the current settings for the Graph 1 view.

The Graph Settings dialog box allows you to customize the Graph view. This dialog box is invoked by selecting Settings on the view window’s hamburger menu or by selecting Settings from the Graph view’s context menu.

The Settings dialog box contains three pages or tabs. We will discuss each in turn.
The Layout tab allows you to select which components to display and format those components as you choose. The History, Fitted Values, Forecast and Confidence Limits components are always available in the Layout tab. When you first start a project, the default graph displays the History and Forecast components.

Other graph components may be added to or removed from the Layout tab using the Add or Remove button. Clicking the Add or Remove button brings up the Add or Remove dialog box shown below. The checkboxes are used to select which components should be included in the Layout tab. The Filter drop-down is useful for selecting components by variable type.

Clicking OK exits the Add or Remove dialog box and updates the list of components in the Layout tab.
You can set specific formatting options for each component.

Most of these options are self-explanatory. The Style drop-down provides four options: Scatter, Line, Bar or Area. Relative Scaling is only available for Converted Forecasts, Calculated Rows and External Data. Selecting Relative Scaling will display that component on its own scale. This is useful when graphing multiple components with dramatically different values. The Shared option allows you to coordinate color and numeric displays with the Override view. Checking Shared applies your Graph Setting selections to the Override grid, providing synchronized views.

The Components tab includes three sections.
The *Display* section allows you to select the graph type.

*Time series* displays a graph where the y-axis covers both the historic and forecast period. The *All* option will display the entire data set in a nonscrollable display. If the *All* option is not selected, the *Periods* option allows you to set how many periods should be included in a scrollable display.

*Year over year* displays a graph where the y-axis is one year long and the data for each year are “stacked” on the display. The *Years* option allows you to specify the number of years to include in the display.

The *Grid Lines* option displays grid lines on the graph. The *Ancestry* option displays the complete ancestry in the variable name (the variable name will appear preceded by any applicable parent group names). The *Events* option marks all historic or forecast points where an event code is being applied. The *Outliers* option marks all historic points where an outlier was detected and/or corrected.

Most of the Display options can also be controlled by bringing up the Display sub-menu on the Graph context menu. Selecting *Zoom* on the Graph context menu will activate the scrollable display.

The *Labels* section allows you to define labels for the X and Y axis and add titles to the graph. *Include variable name* will use the variable name followed by the description as the graph’s subtitle. The Clear button erases the current labels.

The *Y-Axis Scale* section controls the scaling for the selected item. Please note that these are item-level settings.

*Automatic* allows Forecast Pro to select the Y-axis scale.

*Custom* lets you set the minimum and maximum for the Y-axis scale.

*Include zero* begins the y-axis at zero or at the minimum negative value. If you select *Apply to all items*, the Include zero option will be applied globally. This is the only option in the section that may be applied globally.

The Labels and Y-axis Scale settings are shared by the Year over Year and Time Series graphs. If you prefer to use different settings for the different graph types, using multiple graph views or layouts are a good way to do so.
The Items tab allows you to graph multiple items and/or helper variables on a single graph. Simply select the items you want to display and then click the OK or Apply button.

*Include history* and *Include forecasts* indicate if the graph should include both the historic values and forecasts.

*Relative scaling* indicates if each graphed item should be displayed on its own scale.

The *Stacked bars* and *Stacked area* options are useful if you want to understand the contribution of the graphed items to a total. If you use a stacked option, the height of the graph for a given period is sum of the graphed items.

You may enter a title for the graph in the *Title* text field.

The *Filter* options can be used to limit which items are displayed for selection.

The *Exit Multi-item* button returns the graph view back to the default, single item settings.

### The Override Forecasts View

The override view is used for several different purposes. It can be used (1) to enter overrides to the statistically generated forecasts (or specified baseline forecasts), (2) to display imported data and calculated rows and (3) to specify the baseline forecasts. We will examine each of these operations in turn.

#### Working with overrides

The override view is used to enter overrides to the statistically generated forecasts. Changes made at any level of the forecasting hierarchy will automatically reconcile all levels. Refer to the *Understanding How Forecast Overrides are Allocated* chapter for a discussion on how the reconciliation is accomplished.
To open the override view, click the Override icon on the Home tab or the Reports tab on the ribbon menu.

Up to ten override rows can be used and you can adjust the forecasts using percentages, increments, formulas or by typing in new values. You can also enter comments for any cell on the display.

If you use Excel Collaboration, the Excel Collaboration row also becomes available and can be commented and adjusted like the other override rows.

There is an Overrides tab on the Options dialog box that allows you to control the document-level options, including how overrides should be applied (replacement values vs. incremental adjustments) and the precision of the display. This tab is fully documented in The Overrides Tab.

There are six rows in the example shown above.

The top row (currently labeled Statistical) shows the Baseline forecast. By default, the Baseline forecast is the Statistical forecast (the statistically based forecasts generated by Forecast Pro) and is labeled as such. If the baseline forecast is changed, the row label will reflect that.

The Inherited Overrides row is only present if your project has changed states (i.e., you have either switched units of measure or have rearranged the hierarchy). When you change states, it is often not possible to maintain the in-place overrides. This is due to factors such as the item or group that had an in-place override may no longer exist after you change the hierarchy or that changing the units would result in a different forecast allocation across the hierarchy.

To avoid these problems and to ensure that the final forecasts will remain consistent regardless of the hierarchy or units you are viewing, Forecast Pro will move the in-place overrides into the Inherited Overrides row prior to performing hierarchy changes and/or conversions.

Override 1, Override 2 and Override 3 contain any overrides that you have entered for the current forecasts. Proposed overrides are displayed in red, committed overrides are
displayed in black. The Commit button is used to convert proposed overrides to committed overrides. The Formula checkbox allows you to enter overrides as either formulas or “hard numbers” when using the increment and percent buttons. If the Formula box is checked, using the percent or increment buttons will save a formula. Formulas may be entered directly into the Override grid rows whether the Formula option is selected or not. The override view’s context menu allows you to rename the override row labels and add or subtract rows on the fly.

Forecast contains the current committed forecasts. These are the values that are displayed on the graph, and the values that will be written as “forecasts” in any output files that you save. The Forecast values may differ from the Statistical values if you have committed to overrides for the currently displayed forecasts or any other forecasts in the hierarchy that would impact the currently displayed forecasts.

There are three steps in the override process—selecting the point or points to override, entering the override(s) and committing to the override(s).

Points can be selected in the override window or in the graph window. The sum of the values for the points selected will be displayed in the Value edit box.

If you want to adjust the selected points by a certain percentage, enter the percentage in the Percent edit box and press the button. If you want to adjust each selected point by a certain increment, enter the increment in the Increment edit box and press the button. If you want to change the sum of the selected points to a defined value, enter the value in the Value edit box and press the button. Adjustments made using the edit boxes will appear in the target override row specified to the left of the Commit button.

You can also enter overrides for a single point by typing a new value into an override row cell or by using the right mouse button to drag it to the desired new value on the graph.

After you have entered the desired overrides and comments, click the Commit button to accept the changes and reconcile the hierarchy.

For large, complex hierarchies the reconciliation can take a little time. To minimize the reconciliation time, Forecast Pro supports a manual override mode. When this mode is active, the override window will include a Retain button as well as a Commit Button. The Retain button is used to accept overrides without reconciling the hierarchy. In this mode you would typically enter and retain all of the overrides you wish to make (i.e., for multiple items) and then click Commit to perform the reconciliation. The control to turn on manual override mode is found on the Performance tab of the Options dialog box.
Row types

The override grid lets you view and work with different types of rows. The screenshot above displays the Overrides Settings dialog box which lists the currently available rows and lets you customize their appearance. Select Overrides Settings on the Override view context menu or select Settings on the view's hamburger menu to bring up this dialog box. The current screenshot is taken from the project we created in Lesson 3 and includes a range of row types.

History rows, the Baseline row, Override rows and the Forecast row are all standardized rows which always appear in a specific order at the top of the grid. These rows are always displayed on the grid and on the Row Format tab of the Override Settings dialog. The Row Format tab on the Override Settings dialog is also where you control the formatting. Let’s consider each in turn.

**History rows.** If you select Year over Year on the History drop-down, the grid will display the demand history, by year, prior to the Baseline row. If you select Time Series, the grid will display both History and Forecast in the current Forecast row and relabel it History/Forecast.

**Baseline row.** The statistical forecast generated by Forecast Pro is used as the default baseline forecast. (Specifying alternative baseline forecasts is discussed later in this section.) Think of the baseline forecast as the starting point in establishing the final forecast displayed in the Forecast row. If no overrides are made, the final forecast displayed in the Forecast row will equal the Baseline forecast. If you enter overrides, the baseline is adjusted accordingly to establish the final forecast.

**Override rows.** Operation of the override rows was discussed in detail in the preceding section.

**Forecast row.** The Forecast Row displays the current forecast. If Time Series is selected on the History drop-down, this row will be labeled History/Forecast.

In addition to the standardized row types above, Forecast Pro allows you to add Converted rows, External rows and System rows to the grid. To add these rows, click on the Add or
Remove button on the Row Format tab on the Override Settings dialog box to bring up the dialog box shown below.

You can use the filter drop-down to select rows by type or display all rows that may be added to the grid.

![Add or Remove dialog box](image)

**Converted rows.** Converted rows display the current forecast in different units of measure. If you read in conversion factors in the Data Manager, corresponding converted rows will be available.

*External rows.* External rows contain numeric information that you have imported using the Data Manager. Common examples of imported external rows are forecasts generated outside of Forecast Pro such as sales forecasts, or management forecasts and product information such as current orders or available inventory.

*System rows.* The System rows include Inherited Overrides, Time Fence, Statistical and Integer forecasts.

Inherited Overrides are described in detail in the beginning of this section.

Time Fences are described in the *Using a Time Fence* section of the Forecast Pro Interface chapter.

*Statistical* contains the statistically based forecast generated by Forecast Pro prior to any overrides being applied.

The Integer forecast displays either the final or baseline forecasts using a special form of rounding that keeps track of the “remainder” (rounded amount) and applies it to the next period’s forecast value. This is particularly useful for low-volume forecasts or when there are large minimum order quantities, where traditional rounding can result in biased forecasts.

Consider a flat forecast of 0.4 units per month for the next 12 months. If you were to use the `ROUND()` function to round the forecast to the nearest integer the forecast would become, “0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0”. An integer forecast row for the same forecast would be, “0, 1, 0, 1, 0, 0, 1, 0, 1, 0, 0, 1”. Integer forecast settings are defined in the Advanced
The Override Forecasts View

Control tab of the Options dialog box. Details are described in the Menu Items and Dialog Boxes section of this Command Reference chapter.

Previous Forecasts. Previous forecasts, a specific type of System row that you can filter on in the Add or Remove dialog box, are simply forecasts that were generated in prior forecast cycles (i.e., that you created in the past and are stored in the Forecast Pro data base). Previous forecasts are useful for tracking how forecasts change from one forecast cycle to the next and measuring forecast accuracy. Forecast Pro archives final forecasts, statistical forecast and baselined forecasts. These archived forecasts are named “Previous Forecast #”, “Previous Statistical #” and “Previous Baseline #”, where ‘#’ indicates when the forecast was archived. For example, “Previous Forecast 1” displays the final forecasts generated one period ago, while “Previous Statistical 2” displays the statistical forecasts generated 2 months ago. Forecast Pro will display all archived periods available in the database in the Add or Remove dialog box.

Forecasts at Lead Time. Also a type of System Row, Forecasts at lead time are useful for tracking forecast changes and accuracy for specific lead times. A lead time refers to the number of periods ahead of the forecast origin (the period when the forecast was established) the forecast was made for. Thus, a one-month-ahead forecast would have lead time equals 1, a two-month-ahead forecast would have lead time equals 2, etc.

You can also create Calculated rows and Blank rows in the overrides grid.

Calculated rows. Calculated rows allow you to enter formulas using other rows, arithmetic operators and predefined “tokens” (key words). They are inserted into the grid by selecting the Forecast row (or any row underneath it) right clicking to invoke the context menu and selecting Add row. A dialog box will appear allowing you to name the calculated row. Once added, a calculated row can be added or removed from the Row Format tab on the Overrides Settings dialog box using the Add or Remove button, as described above. The next section discusses how to enter the formulas and details the supported operators and tokens.

Blank rows. Blank rows can be added to the grid to enhance readability. They are inserted in a similar fashion to calculated rows. To insert a blank row, select the Forecast row (or any row underneath it) right click to invoke the context menu and select Add row. A dialog box will appear allowing you to name the row. If you enter a name and click OK, the row will be inserted as a calculated row. If you erase the default name and click OK (i.e., process a blank input field) the row will be inserted as a blank row.

Defining calculated rows

You enter formulas by clicking on the cell you wish to modify and typing in the formula. You may enter an override cell reference by selecting a cell on the override grid while typing the formula, much like you can in Excel. If you wish to edit a previously entered formula, select the cell and press the F2 key. You can copy and paste formulas from cell to cell.

By default, the formulas in a specific calculated row will be calculated at the single level of the hierarchy on which they were entered. Any values you elect to display at other levels will be either aggregations or disaggregations of the calculated values. Depending upon your formulas, this may or may not be equivalent to applying the defined formula at the group level.

If you wish to change the default behavior for a row and calculate the formulas at all levels you can do so using the Row Properties tab (discussed below). Be aware that this option may slow down certain operations including applying overrides.
Formulas are not case sensitive. Formulas are entered in the format:

\[ \text{expression} \]

The expression can involve any of the following components.

**Numbers**
Any real number

**Operations**
+ - * / ^

**Parenthesis**
()

**Comparison operators**
= < > <= >=

**Functions**
Listed below

**Tokens**
Listed below

**Rows**
{RowName}

**Conversion factors**
{#ConversionFactorName}

Note that when a row name is used as part of a definition it must appear in braces (curly brackets).

The conversion factors are a special token that returns the value of the specified conversion factor. The token must appear in braces and have the # symbol prior to the conversion factor name. For example, if Dollars is a defined conversion factor, then {#Dollars} would be the corresponding token.

Token and row references can also include an offset by appending a [-n] to the token or row name. For example:

- \{rowname\} Returns the value of rowname for the current period.
- \{rowname\}[{-1}] Returns the value of rowname for the previous period.
- \{rowname\}[{1}] Returns the value of rowname for the next period.

Forecast Pro supports the following functions:

- **ABS(n)** Returns the absolute value of n
- **EXP(n)** Returns e raised to the \( n^{th} \)
- **LOG(n)** Returns the natural logarithm of n
- **LOG10(n)** Returns the base-10 logarithm of n
- **SIGN(n)** Determines the sign of n. Returns 1 if n is positive, 0 if n is zero and -1 if n is negative.
- **SQR(n)** Returns n squared
- **SQRT(n)** Returns the square root of n
- **IF(condition, value1, value2)** Returns value1 if condition is true or value2 if condition is false
- **INT(n)** Rounds n down to the nearest integer
- **TRUNC(n)** Truncates n to an integer
- **EVEN(n)** Rounds n up to the nearest even integer
- **ODD(n)** Rounds n up to the nearest odd integer
- **ROUND(n, decimal places)** Rounds n to the specified number of decimal places
- **MROUND(n, basis)** Rounds n to the nearest multiple of basis
- **ROUNDUP(n, decimal places)** Rounds n up to the specified number of decimal places
- **ROUNDDOWN(n, decimal places)** Rounds n down to the specified number of decimal places
- **MROUND(n, basis)** Rounds n to the nearest multiple of basis
MIN\((x, y, \ldots)\) Returns the smallest value in the specified set of values
MAX\((x, y, \ldots)\) Returns the largest value in the specified set of values
AVERAGE\((x, y, \ldots)\) Returns the average of the specified set of values
SUM\((x, y, \ldots)\) Returns the sum of the specified set of values
MEDIAN\((x, y, \ldots)\) Returns the median of the specified set of values
MODE\((n)\) Returns the mode (most frequently occurring value) of the specified set of values
NVL\((n, \text{alternative})\) Null value function. If \(n\) is blank returns \text{alternative}. If \(n\) is not blank returns \(n\).
ISNUMBER\((n)\) Returns 1 if \(n\) is a number, 0 if \(n\) is blank.
ISNULL\((n)\) Returns 1 if is blank, 0 if \(n\) is a number.

If you use Excel, you may be familiar with these functions. Forecast Pro implements these functions in the same way as Excel with one exception—cell ranges are not yet supported. For example, the following formula will return the sum of the statistical forecast for last period, this period and next period:

\[=\text{SUM(STAT[-1],STAT,STAT[1])}\]

The following, however, is not supported: \(=\text{SUM(STAT[-1]:STAT[1])}\)

Forecast Pro supports the following tokens:

- FORECAST Forecast row
- PFC# Forecast from ‘#’ periods prior
- PST# Statistical forecast from ‘#’ periods prior
- PBL# Baseline forecast from ‘#’ periods prior
- FCLT# Forecast at lead time ‘#’
- STLT# Statistical forecast at lead time ‘#’
- BLLT# Baseline forecast at lead time ‘#’
- YTD Returns the calendar year-to-date using the history and forecast values as applicable.
- QTD Returns the calendar quarter-to-date using the history and forecast values as applicable.
- STAT Statistical forecast row
- BASE Baseline forecast row
- INTFC Integer Forecast. Only available if the Integer Forecast is added to the grid in the Override Settings dialog.
- INTSTATFC Integer Statistical Forecast. Only available if the Integer Forecast is added to the grid in the Override Settings dialog.
- OVR1 The first override row
- OVR# Override row “#”
- HIST1 The most recent historic row
- HIST# The historic row “#” years prior
- HISTBL[-n] Returns either the history value or the baseline forecast value at -n. Intended for use in formulas where it may point to either a forecast or a historic period.
- HISTFC[-n] Returns either the history value or the forecast value at -n. Intended for use in formulas where it may point to either a forecast or a historic period.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HISTST[-n]</td>
<td>Returns either the history value or the statistical forecast value at -n. Intended for use in formulas where it may point to either a forecast or a historic period.</td>
</tr>
<tr>
<td>INHER</td>
<td>Inherited override row.</td>
</tr>
<tr>
<td>LOWER</td>
<td>Lower confidence limit</td>
</tr>
<tr>
<td>UPPER</td>
<td>Upper confidence limit</td>
</tr>
<tr>
<td>LEADTIME</td>
<td>The item's specified lead time</td>
</tr>
<tr>
<td>SAFETY</td>
<td>The safety stock at the item's specified lead time</td>
</tr>
<tr>
<td>SAFETY_ALL</td>
<td>The safety stock corresponding to the lead time of the current cell</td>
</tr>
<tr>
<td>DDLT</td>
<td>The demand during the item's specified lead time</td>
</tr>
<tr>
<td>DDLT_ALL</td>
<td>The demand corresponding to the lead time of the current cell</td>
</tr>
<tr>
<td>REORDER</td>
<td>The reorder point at the item's specified lead time</td>
</tr>
<tr>
<td>REORDER_ALL</td>
<td>The reorder point corresponding to the lead time of the current cell</td>
</tr>
<tr>
<td>MEAN</td>
<td>The mean of the historic data</td>
</tr>
<tr>
<td>STDEV</td>
<td>The standard deviation of the historic data</td>
</tr>
<tr>
<td>MAD</td>
<td>The within-sample mean absolute deviation</td>
</tr>
<tr>
<td>MAPE</td>
<td>The within-sample mean average percent error</td>
</tr>
<tr>
<td>SMAPE</td>
<td>The within-sample symmetric mean average percent error</td>
</tr>
<tr>
<td>BIC</td>
<td>The Bayesian Information Criterion</td>
</tr>
<tr>
<td>{#Conversion}</td>
<td>Returns the conversion factor for &quot;Conversion&quot;.</td>
</tr>
</tbody>
</table>

**Important notes:**

1. All of the above functions require that the referenced system row is added in the override grid. For example, the integer system row needs to be in the grid for INTFC to return a value. Referenced system rows can be added using the Add or Remove button in override settings.

2. Tokens that reference baseline or final forecasts are only available in calculated rows.
Formatting rows

The Row Format tab on the Overrides Settings dialog box allows you to control the order in which the rows appear and how they are formatted. Most of the options are self-explanatory, however, we will comment on a few of them.

Only items that have Display checked will be shown on the grid. The core grid rows (Baseline, Overrides, Time Fence and Forecast) are always displayed and do not have checkboxes. If you want to add something to the grid and it is not shown on the Row Format tab, add it by using the Add or Remove button, as described above.

Checking Shared applies your Override settings for that row to the Graph view, allowing for synchronized views.

To change the order of the rows, you select a row you wish to move by clicking on its name and then use the Move Up and Move Down buttons to reposition it.

Clicking the Apply button will immediately apply any changes you have made to the Override View without leaving the Overrides Settings dialog box. This is very useful when formatting the display.

The Format option allows you to display the row’s values formatted as a number, a percentage, or a currency. If you select Currency, Forecast Pro will default to the currency symbol associated with your operating system’s language selection. If you wish to use an alternative symbol, the Currency Symbol drop-down can be used to select it. Forecast Pro supports a wide variety of currency symbols, however, if the symbol you’d like to use is not supported; please send an enhancement request to support@forecastpro.com.
Defining row properties

The Row Properties tab on the Overrides Settings dialog box allows you to control how certain grid values are calculated and displayed.

The **Hier. level** column displays the level at which the data are defined. For Converted rows this will always be the lowest level since the conversion factors can only be defined at the lowest level. For External rows this column displays the level at which the data were imported. For Calculated rows this column is a drop-down which allows to specify the level to calculate the formulas or to specify that the formulas should be calculated independently at all levels.

The **Forecast row** column allows you to indicate whether the row should be treated as a forecast row. This is important, since only forecast rows can be assigned as baseline forecasts.

The **Convert** column allows you to indicate whether the row should convert to different units when you change the Units displayed in Forecast Pro.

The **Aggregate** column allows you to indicate whether External rows and Calculated rows should display aggregated group totals for levels above the **Hier. Level**.

The **Disaggregate** column allows you to indicate whether External rows and Calculated rows should display disaggregated values for levels below the **Hier. Level**.

The **Archive** column is used to indicate whether the row should be archived in the Forecast Pro database for every forecast origin. This is only recommended if you plan to access the Forecast Pro database independently of Forecast Pro and have a specific need for this information.

The **Pin to** column is used to control where a formula will appear after you update your historic data and generate a new forecast from a different forecast origin. If you select “Date” the formula will be tied to the specific date for which it was originally entered. If you select “Column” the formula will be tied to the column position for which it was originally entered.
Let's illustrate this with an example. Suppose you originally generate a 12-month forecast and the first forecast period is January 2020, so the grid displays 12 columns for the forecasts covering the span of January 2019 through December 2019. You create a calculated row and enter a formula in the 12th column (which corresponds to December 2018). Next month, you update your historic demand, re-forecast the project and the grid now displays 12 new forecasts covering the span from February 2019 through January 2020. Where does the formula you entered last month appear in the updated override grid? If you selected Pin to Date, the formula will appear in the 11th column of the display (which now corresponds to December 2019) and the 12th column (which now corresponds to January 2020) will be blank. If you selected Pin to Column, the formula will appear in the 12th column of the display (which now corresponds to January 2020).

**Specifying the baseline forecast**

By default, Forecast Pro generates a statistical forecast and then allows you to add overrides to this “baseline” forecast to create the final forecast. There may be times where you wish to use an alternative forecast generated outside of Forecast Pro as the baseline forecast rather than the statistical forecast generated by Forecast Pro.

You can set the baseline forecast to use at the end-item level (i.e., the lowest-level on the Navigator) on an item-by-item basis. The baseline forecasts displayed at group levels are always aggregations of the end-item values. If all of the end-items for a given group are using the statistical forecast as the baseline (the default), the group label for the baseline row will read “Statistical.” If any end-items for a given group are set to a baseline other than the statistical forecast the group label for the baseline row will read “Baseline.”

You can specify the baseline for an individual end-item using the override grid’s context menu. Select the forecast row you’d like to use by clicking the row label, invoke the context menu by right clicking the mouse and select Set as Baseline.

You can use the Baseline Forecasts tab of the Overrides Settings dialog box to specify baseline forecasts for groups of end-items.
The baseline selection drop-down box (selected as Default in the above image) allows you to select a forecast row to work with. The tab contains a list of all end items with a check mark to indicate whether the baseline matches the current baseline selected. You use the checkboxes and the Apply button to assign the baselines.

The Filter field can also be used to winnow down the displayed list of items. Combining filtering with the use of the Select All button provides an efficient mechanism for assigning the baselines when working with large numbers of end-items.

The Missing baseline setting controls what is displayed if the assigned baseline is partially missing (i.e., the assigned baseline contains values for some but not all of the forecast periods for a given item) or fully missing (i.e., the assigned baseline does not contain any values for a given item). In the latter case, Forecast Pro will display a warning message when you process the request.

The Default source drop-down (on the bottom right of the dialog box) allows you to specify the forecast to use as a baseline if no alternative baseline has been specified. Most users will want to leave this selection set to Statistical.

The Diagnostics View

The diagnostics view provides a variety of statistical displays to assist you in building and diagnosing custom models. To open the diagnostics view, click the diagnostics icon in the Tools group on the Forecasting tab or select Diagnostics from the drop-down on the Graph icon on the Home tab or Reports tab.

![Diagnostics View](image)

The default view is the Fitted Errors graph. Use this display to identify outliers or other problem areas of your data. The dashed horizontal lines mark the 2.5 and 97.5 percentiles. About one error in twenty extends beyond these limits.

You can right click on the Fitted Errors graph to bring up the Advanced Diagnostics context menu and select one of the other available diagnostic graphs.
Error ACF displays a graph of the error autocorrelation function. Use the error ACF to make quick assessments of correlational models like Box-Jenkins and dynamic regression. If your statistical model is well specified, then about one autocorrelation in twenty falls outside the limits marked by dashed lines, and the autocorrelations are not patterned. The computation of the error autocorrelation function is covered in the Forecast Pro Statistical Reference Manual.

ACF and PACF are provided to help you manually identify ARIMA models. The autocorrelation function (ACF) is used to identify differencing, and to identify the number of simple and seasonal MA terms. To identify differencing, select Advanced Diagnostics Settings on the context menu.

Use the Automatic button to display the differencing values selected by Forecast Pro’s automatic Box-Jenkins algorithm. Use the partial autocorrelation functions (PACF) to identify the number of simple and seasonal AR terms. Refer to the Forecast Pro Statistical Reference Manual for further information about manual identification of ARIMA models. The ACF and PACF may also be helpful for manually identifying the dynamic terms in a dynamic regression model.

Cumulative displays a cumulative graph of the currently selected item. This is especially useful when examining a Bass Diffusion model.

The Tracking Report and Tracking Report Graph Views

The Tracking Report view and its associated Tracking Report Graph view allow you to compare previously generated forecasts with what actually happened. To view the Tracking Report, your Forecast Pro database must contain archived forecasts.

To open the Tracking Report, click the Forecast Tracking icon on the Home tab or the Reports tab.
Due to its cascading-like appearance, the tracking report is sometimes referred to as a *waterfall* report. The report compares what we forecasted to what actually happened, therefore it is based on two key elements—the actual demand history and archived forecasts for the periods being analyzed.

In the example above, the actual demand history for the most current six months is shown in the first row with the green shading.

The next row down, displays the *Component Weight*. This displays the percentage that the demand represents of its parent group. Thus in our example, in January of 2018, Total>Cakes>Food-King composed 38.81 percent of the demand for its parent group, Total>Cakes. This row is only displayed if *include component weights* is selected in the Layout section of the Tracking Report Settings, as described shortly.

The next 6 rows display the forecasts generated for these periods from different forecast origins. Thus, the row labeled 2019-Dec displays the forecast when the forecast origin was December 2019 and the first forecast period was January 2020. The row labeled 2020-May displays the forecast generated the prior month when the forecast origin was May 2020 and the first forecast period was June 2020.

The waterfall report allows you to color code *lead times*. A lead time refers to the number of periods ahead of the forecast origin the forecast was made for. Thus, a one-month-ahead forecast would have lead time equals 1, a two-month-ahead forecast would have lead time equals 2, etc.

In our example, the forecasts for lead time equals 1 are all shaded in blue, the forecasts for lead time equals 3 are all shaded in magenta, the forecasts for lead time equals 6 are all shaded in yellow. The color coding is used on both the tracking report and the tracking report graph. You can control the lead times to color code using the Tracking Report Settings dialog box.

The bottom portion of the report displays cumulative statistics for different lead times. The cumulative statistics for different lead times portion of the report can include up to three sections—Series Analysis, End-item Analysis and Component Analysis. End-item
Analysis and Component Analysis are only relevant to group-level data and are not displayed if an end-item is selected. By default, only Series Analysis is shown. Use the Tracking Report settings to turn on End-item and Component Analysis, as described below.

Series Analysis displays statistics for the currently selected time series. If the selection is a group, the statistics are based on the archived group-level forecasts. The CMAPE statistic found in this section is the Component MAPE. This is a weighted MAPE where the weighting factors are the component weights (see discussion above).

End-item Analysis displays statistics based on the archived forecasts for all end-items belonging to the currently selected group. The WMAPE statistic found in this section is a weighted MAPE where the weighting factors reflect the end item’s volume. The weights are calculated by dividing each end item’s volume by the group’s volume.

Component Analysis displays statistics based on the archived forecasts for all component children (i.e., groups and/or end items one level lower in the hierarchy that are components of the currently selected group). The WMAPE statistic found in this section is a weighted MAPE where the weighting factors reflect the component children’s volume. The weights are calculated by dividing each component child’s volume by the group’s volume.

The content and format of the Tracking Report is controlled using the Tracking Report Settings dialog box. This dialog box is invoked by selecting Settings on the Forecast Accuracy icon drop-down on the Home tab or Report tab, by selecting Tracking Report Settings from the Tracking Report view’s context menu or by selecting Settings on the view’s hamburger menu.

The Forecasts section allows you to display either the statistical or adjusted forecasts. The Report type section allows you to display the forecasts, the forecast error or the percent forecast error.

The Analysis Mode section allows you to specify which cumulative lead time statistic displays to include.

Most of the items in the Layout section are self-explanatory, however, we will comment on a couple of them. The “Periods to display” controls the number of lead times to include in
the report. The “Include preceding forecasts” option displays all archived forecasts that go into the cumulative statistics rather than just the subset in the triangular display.

The *Lead time(s)* box allows you to specify up to four lead times to color code. The selected color coding is used on both the numeric and graphical displays.

You can open the Tracking Report Graph by selecting Graph on the Forecast Accuracy icon drop-down on the Home tab or Reports tab.

For each historic period, the graph display the actual historic value and the archived forecasts for the lead times selected in the Tracking Report Settings dialog box.

**The Exception Report Views**

The Exception Report views enable you to quickly find cases where your forecast error or some other performance metric has fallen outside of an acceptable range. Exception reporting reduces the need for manual review of your forecasts and allows you to focus on the items where human attention is most needed.

Forecast Pro provides a wide array of exception reports, some of which monitor the current forecasts and others which monitor your archived forecasts. The available Exception Report views are shown on the Reports tab.
Overview

All exception reports are displayed in a format similar to the example shown above. A row is included for every item in the hierarchy. The items can be filtered to show only items that need further examination, as described below. Select Filters on the hamburger menu in the upper left-hand corner of the view or on the view’s context menu to activate the filtering capability.

The initial columns identify the item. This is followed by a Date column identifying the exception period. The next two columns display the value being monitored and what it is being monitored against. This is followed by a Deviation column showing the difference and the % Deviation column showing the difference as a percent.

Double-clicking an item on an exception report will cause the Navigator to jump directly to that item. Thus, you can use the exception report as the equivalent of a Hot List to navigate through the listed items. All of the global report views (yellow icon views) support this kind of navigation.

Right clicking on the Exception Report view brings up the Exception Report context menu.
You can select All Items, Hot List or Selected Item to quickly adjust which items should be included in the report.

Exception reports are best used in conjunction with Filters and Layouts. Please refer to the *Exception Reporting* lesson in *Forecast Pro TRAC Tutorials* or the *View Window* in this manual for an overview of how to use Filters and Layouts with Exception reports.

The content and format of the Exception Report is controlled using the Exception Report Settings dialog box. This dialog box is invoked by selecting Settings on the hamburger menu or by selecting Exception Report Settings from the Exception Report view’s context menu. You may also use the Settings drop-down icon on the Reports tab and select one of the five exception reports to open settings for the selected exceptions report.
Forecast vs. History

Click on the Forecast vs. History icon on the Reports tab to open the Forecast vs. History report. The Forecast vs. History report compares forecast values to prior historical values.

The *Comparison* section at the top of the dialog box is where you define the type of Forecast(s) you want to use (Baseline, Forecast, Statistical) and the number of periods prior you want to compare to. By default, the report shows the current forecast versus the same period last year for all periods in the forecast horizon. Unchecking the “Current forecast vs. same period last year” checkbox allows you to customize the comparison periods.

The *Forecast periods to consider* section allows you to set the number of forecast periods to monitor and to specify if you want to look at each individual period or at the cumulative total across the specified forecast periods. The default setting (cumulative is not checked) monitors all forecast periods individually.

The *Include* section allows you to specify which statistics you want to show in the report. By default, the report shows Deviation and % Deviation. If you have included filters in the project (see Custom Filter Fields in the *Setting Up Your Optional Data* section of this chapter), you may add those to the report using the Filter drop-down.
Forecasts vs. Archive

Click on the Forecast vs. Archive icon on the Reports tab to open the Forecast vs. Archive report. The Forecasts vs. Archive report compares the current forecast to previously generated forecasts.

The current report compares the current forecast against the forecast we made last month (Previous Forecast 1). In the Comparison section, the left drop-down allows you to select which of the current forecasts to consider (Forecast, Baseline or Statistical) and the right drop-down allows you to select which previous forecast(s) you want to compare to. Note that you may choose multiple previous forecasts for comparison.

The Forecast periods to consider section allows you to set the number of forecast periods to monitor and to specify if you want to look at each individual period or at the cumulative total across the specified forecast periods. The default setting (cumulative is not checked) monitors all forecast periods individually.

The Include section allows you to specify which statistics you want to show in the report. By default, the report shows Deviation and Percent deviation. If you have included filters in the project (see Custom Filter Fields in the Setting Up Your Optional Data section of this chapter), you may add those to the report using the Filter drop-down.
Forecast Accuracy

Click on the Forecast Accuracy icon on the Reports tab to open the Forecast Accuracy report. The Forecast Accuracy report looks at previously generated forecasts vs. what actually happened.

The Comparison section at the top of the dialog box is where you define the type of Forecast(s) you want to use (Baseline, Forecast, Statistical) and the lead time you want to compare to. A lead time refers to the number of periods ahead of the forecast origin (the period when the forecast is generated) the forecast was made for. Thus, a one-month-ahead forecast would have lead time equals 1, a two-month-ahead forecast would have lead time equals 2, etc. By default, the report compares the forecast we made last period (Forecast(L1)) to what actually happened for the current month only.
Custom

Click on the Custom icon on the Reports tab to open the Custom report. The Custom report compares the current forecast or history to any row(s) available in the override grid.

The report shown above (taken from the project Lesson 10) compares the current forecast to the Sales Forecast (an external row). The comparison drop-down menus allow you to select if you want to compare history or a forecast (forecast, baseline or statistical) and the comparison series.

The *Periods to consider* section allows you to select how many time periods to monitor. Select User-defined to activate the spinners below the date range. Use the spinners to select the starting and ending historic periods. Selecting “0” will select the most recent historic period, “-1” will select the previous historic period and so on. As you change the spinners, the date above will update to reflect the actual starting and ending periods selected. Check *Cumulative* if you want to look at the total across the specified historical periods.

The *Include* section allows you to specify which statistics you want to show in the report. By default, the report shows Deviation and Percent deviation. If you have included filters in the project (see Custom Filter Fields in the Setting Up Your Optional Data section of this chapter), you may add those to the report using the Filter drop-down.
Waterfall

Click on the Waterfall icon on the Reports tab to open the Waterfall report..

The Waterfall report provides a complete summary of forecast accuracy across lead times. It doesn't compare items and calculate deviations like the other exception reports. It simply allows you to list statistics from the waterfall reports in a global report that can be sorted and filtered to aid in your review process.

The Display section is used to define what to show in the report. The top drop-down (currently showing Forecast) is used to select which forecasts (Forecast, Baseline and/or Statistical) to include in the report. The drop-down below that is used to select which statistics (Avg. Error, Avg. Forecast and Avg. Perc. Error) to include as additional columns in the report. The Lead time spinner is used to select the lead time for the report. The bottom drop-down in the Display section lets you choose the analysis type (Series, End Item-level or Component). Please see The Tracking Report and Tracking Report Graph Views in this chapter for more details on lead times and analysis types.

The Include section, allows you to specify additional columns to show in the report. If you have included filters in the project (see Custom Filter Fields in the Setting Up Your Optional Data section of this chapter), you may add those to the report using the Filter drop-down.

The Override Report View

The Override Report view lists items where overrides and/or comments have been made. The display is useful when reviewing the current overrides and when loading archived override sets.
To open the Override Report view, click the Override Report icon on the Reports tab.

If you double-click an item on the Override Report, the Navigator will jump directly to that item. Thus, you can use the Override Report as the equivalent of a Hot List to navigate through the listed items. All of the global report views support this kind of navigation.

The content and format of the report is controlled using the Override Report Settings dialog box. This dialog box is invoked by selecting Settings on the Override Report icon drop-down, by selecting Settings on the view’s hamburger menu or by selecting Settings from the Override Report view’s context menu.

The Display section allows you to control the override sets that will be displayed, to include columns for the Pareto output and to include columns for custom filters (if there are any defined).

*In-place only* restricts the display to the current in-place override set only. Thus, override sets made in previous states (e.g., in other units and/or hierarchies) will be omitted, as will override sets made for other origins (e.g., previous forecast periods) and override sets associated with other linked projects.

*Current origin* displays all override sets for the current origin (forecast period). Thus, override sets made in other states (e.g., in other units and/or hierarchies) will be included, but override sets associated with different forecast origins (e.g., previous forecast periods) will be omitted.

*Last origin & current origin* displays all override sets for the current and immediately previous origin (forecast period). This is often a useful display to view when you have updated the statistical forecasts and are loading override sets from the last forecast period via the Archived Overrides icon on the Imports tab.

*Custom* provides complete control over the override sets displayed. Once *Custom* is selected, the *Components* section of the dialog box is activated. *Compatible series* restricts the display to override sets where the state (i.e., units of measure and hierarchy) match the current state. *Headers only* displays the one-line header for each override set, omitting the item-level override information. The *Forecast origin* option allows you to specify the range of origins to display. Once you check *Forecast origin*, you may use the spinners to set the date range.
The Outlier Report View

The outlier report view lists items where outliers have been detected and/or corrected. To open the outlier report view, click the Outliers icon on the Reports tab or in the Tools group on the Forecasting tab.

The content and format of the report is controlled using the outlier report’s context menu. The context menu also allows you to print the currently displayed report and save it to Excel.

The Outliers tab of the Options dialog box includes an *Include iteration statistics in reports* option. If this option is active the outlier report will include detailed statistics describing the outlier detection. Consult *Outliers* in *Custom Forecasts: The Forecasting Tab* for more details. The *Forecast Pro Statistical Reference Manual* also provides additional details on Forecast Pro’s outlier detection methodology.

The Numeric Output View

The Numeric Output view displays the contents and format of the currently specified Numeric Output file. When designing the Numeric Output file, it is useful to have the Numeric Output view open. To open the Numeric Output Report, click the Numeric Output icon on the Reports tab or select Show from the Numeric Output icon drop-down on the Home tab.

The Numeric Output Settings dialog box is used to specify the format and content of the Numeric Output Report and file. To open the Numeric Output Settings dialog box, select Settings from the drop-down on the Numeric Output icon on the Home tab or the Reports tab. You may also select Settings on the hamburger menu or the view’s context menu to open the Numeric Output Settings dialog box.

The Numeric Output Settings dialog box contains both a Set as Default button and an OK button. Clicking the OK button will save your current settings for use with the current project. Clicking the Set as Default button will save your current settings for use with the current project and also save them as the default settings for all new projects.

The Numeric Output Settings dialog box contains three pages or tabs. We will discuss each tab in turn.
The Output Format tab is used to specify the basic layout for the Numeric Output file.

**The Output Section**

*Forecast file prefix.* Specify the character(s) to use as the default prefix when naming the Numeric Output file. If the *Single Output file* option is selected in the Layout section, the default Numeric Output filename will be the prefix followed by the project name followed by “Numeric Output”. If the *Single Output file* option is not selected, each output filename will be the prefix followed by the corresponding input filename.

*Default units only.* If this option is selected, the Numeric Output file will save the forecasts and other components using the default units (i.e., the units defined in the input data source). If this option is not selected, the Numeric Output file will save the forecasts and other components using the units of measure currently selected in Forecast Pro.

*Default hierarchy only.* If this option is selected, the Numeric Output file will save the forecasts and other components using the default hierarchy (i.e., the hierarchy defined in the input data source). If this option is not selected, the Numeric Output file will save the forecasts and other components using the hierarchy currently selected in Forecast Pro.

*Include items without forecasts.* If this option is selected, the Numeric Output file will include entries for any discontinued items that appear on the Navigator.

If you have included filters in the project (see Custom Filter Fields in the *Setting Up Your Optional Data* section of this Command Reference), you may add those to the Numeric Output using the Select filter fields to display drop-down.

**The Layout Section**

The Layout section of this tab allows you to specify the default data mode, the orientation (row vs. column), whether or not to include group level output and whether or not to include item-level data.
Single output file. If Single output file is selected, a single Numeric Output file containing information for all forecasted items will be written. If Single output file is not selected, then a separate Numeric Output file will be written for each input file.

Break record up into lines. If selected, each Numeric Output component specified on the Time Series Data tab (see below) will appear on a separate line of the Numeric Output file.

The Text Format section of this tab allows you to specify the conventions to use when outputting a text file. You will only be able to edit these settings when the data mode is set to Txt (text) or Mlt (text input file format).

The Pareto section allows you to include the Pareto codes and associated Pareto statistics in the Numeric Output view and output.

The Time Series Data tab is used to define the data label fields, to select the forecast components to include and to set their precision.

The Data Labels Section lets you specify what information you want to include for each item in the report.

Attributes. Include separate attribute fields for each level of the hierarchy. If you used attribute fields in your input data files to define groups, you will most likely want to select this option so that your output file will match your input file. Consult Using Attribute Fields to Define a Hierarchy in Setting Up Your Historic Data for a discussion of attribute fields.

Include record type. Include a record type field that identifies which forecast component is being output. This is useful if you use the Break record up into lines option and are outputting more than one numeric output component.

Item Name. Include a field listing the “name” of the variable as it appears on the Navigator. If the Include ancestry option is active the ancestry will be shown as part of
the item name. The variable names used for all numeric output components other than “Forecasts” will include a suffix indicating the record type.

*Description, Units, First historic date, First forecast date and Last historic date.* Include fields for the selected options.

The Numeric Output Section lists the different types of data series you can include in the report.

*History and Forecast Components.* Check the boxes next to the information you want to include. The spinners next to the items are used to specify the numeric precision of the selected series. If the precision is set to 0, the numbers will not include a decimal. Use the radio buttons under Seasonal Indexes to indicate if you want to include indexes for history and/or the forecast horizon.

*External rows.* To include external rows in your Numeric Output, select from the External rows drop-down. Use the spinner to the right to specify numeric precision for the external rows.

*Custom Date range.* By default, the Numeric Output Report will include all forecast periods if a forecast is selected and all history periods if History is included. If you want to change the periods shown in the report, select Custom date range and use the spinners to define the beginning and ending dates.

If you are outputting a fixed width text file, you may set the column widths instead of the numeric precision by selecting *Width* in the Adjust radio buttons.

The Model and Statistics tab is used to define the within-sample statistics and model details that you wish to include and to set their precision. If you are outputting a fixed width text file, you may set the column widths instead by selecting the Width radio button.

Most of the options are self-explanatory. However, we have noted some details below.

*Model Properties.* The Model Properties drop-down contains a number of different fields that describe the forecasting model selected. *ModelSpec* is a concise description of the
model used. The notation that is used here is also used in the Forecast Report. Consult the *Forecast Pro Statistical Reference Manual* for further details.

*Transform.* The Box-Cox transformation power. 1 indicates no transform, .5 the square root and 0 the natural log.

**The Item Report View**

The Item Report contains essentially the same information as the Numeric Output. The Item Report can contain Pareto information, statistical output such as the forecasting model specification and summary statistics as well as time series output such as history, forecasts, fitted values and confidence limits. The purpose of the Item Report is to provide a way to look at custom views that may be different from the formatting and structure required for the Numeric Output. The Numeric Output settings are typically defined for how the data needs to be exported within a forecasting process, while the Item Report is intended to be used more interactively.

To open the Item Report view, click the Item Report icon on the Reports tab.

If you double-click an item on the Item Report, the Navigator will jump directly to that item. Thus, you can use the Item Report as the equivalent of a Hot List to navigate through the listed items. All of the global report views support this kind of navigation.

The content and format of the report is controlled using the Item Report Settings dialog box. This dialog box is invoked by selecting Settings from the Item Report icon drop-down, or by selecting Settings on the view’s hamburger menu or from the Item Report view’s context menu. The Item Report Settings dialog box functionality is a subset of the Numeric Output Settings dialog box. Please consult *The Numeric Output View* section of this chapter for details.
Chapter 10: Saving Your Work

Forecast Pro *Forecast Projects* allow you to save your forecasting session so that you can return later and pick up where you left off or share the session with others. The forecast project saves the data, forecasts, overrides, Hot List, modifiers and all other information associated with the project as it exists when you save it.

Additionally, Forecast Pro can export eleven different types of output. The following reports can be reviewed and customized on the Reports tab and exported from the Export tab:

- **Numeric Output Files** can contain time series output such as history, forecasts, fitted values and confidence limits as well as statistical output such as the forecasting model specification and summary statistics. These files can be saved in text, spreadsheet, ODBC or XML formats. You can include output for either all items forecasted or just for the Hot List. Generally speaking, if you will be importing the forecasts into another application these are the files you will want to use.

- **Formatted Forecast Reports** can be saved to Excel. You can save these reports for the currently displayed item, all items on the Hot List or all items forecasted. The Excel workbook will include a separate worksheet for each item containing a graph (optional) and the on-screen Forecast Report. These reports are convenient if you wish to present the forecasts and/or models used to colleagues.

- The **Item Report** can be viewed on-screen and saved to Excel. This report can contain Pareto information, statistical output such as the forecasting model specification and summary statistics as well as time series output such as history, forecasts, fitted values and confidence limits.

- The **Outlier Report** can be viewed on-screen and saved to Excel. This report lists items where outliers have been detected and/or corrected.

- The **Override Report** can be viewed on-screen and saved to Excel. This report lists items where overrides and/or comments have been made.

- **Forecasts Tracking Reports** can also be saved to Excel. You can save these reports for the currently displayed item, all items on the Hot List or all items forecasted. The Excel workbook will include a separate worksheet for each item containing a graph (optional) and the on-screen Tracking Report. These reports are only available if the database includes at least one archived forecast for the given item.

- The **Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, Waterfall and Custom** reports are all types of **Exception Reports** that can be viewed on-screen and saved to Excel. Each of the reports is helpful for reviewing history, forecasts, overrides, archived forecasts, external data and identifying unusual items that may need more review and customization.

Each of the above reports may be exported for all items in the project, for items on the Hot List or for only items included in the Current Display (including filters). The following sections discuss forecast projects and these output files in more detail.

**Forecast Projects**

*Forecast Projects* allow you to save your forecasting session so that you can return later and pick up where you left off or to share the session with others. The forecast project saves the data,
forecasts, overrides, Hot List, modifiers etc. as they currently exist in memory. If you update your input data files after saving a project, when you reopen the project you’ll have the option of either generating new forecasts using the updated data or restoring the conditions present when the project was saved (i.e., not recalculating the forecasts using the new data).

Opening projects

To save a forecast project you select the File tab and then select Save on the left bar, click the Save icon on the far left of the default Quick Access Toolbar or simply use Ctrl-S. To open a forecast project, you select the File tab and then select Open on the left bar.

If you open a project and data files have not changed (i.e., the time and date stamps match), the project will restore the conditions present when the project was saved allowing you to continue your work where you left off.

If you open a project and the data files are not available, the project will restore the conditions present when the project was saved—thus you can review projects, make adjustments, etc. even if you do not have access to the data files. This will often be the case when sharing projects with colleagues.

If you open a project and data files have changed, a dialog box will appear allowing you to either generate new forecasts using the updated data or restore the conditions present when the project was saved (i.e., do not recalculate the forecasts using the new data).

Project files

The project file is usually a single zipped file with the extension FPZip. The zipped file contains three separate data files.

*The Project Settings File (* .FPProj is an XML file containing the project settings and Data Manager definitions.*

*The TRAC Database File (* .db) is a SQLite database file that contains information pertaining to the current forecast period and all previously archived forecasts.*

*The Project Snapshot File (* .fcb) is a binary file that saves the forecast components that are currently in memory (e.g., the forecasts, summary statistics, etc.) so that the session can be restored without having to read in the data, recalculate the forecasts, etc. This allows you to return to your session where you left off and to share the session with others.*
Zipped vs. unzipped projects

Forecast Pro allows you to save projects in an unzipped form. This is usually not recommended unless there is a specific issue with your operating environment that makes the unzipped format preferable.

In networked environments, working with zipped projects usually offers better performance. When you open a zipped project, Forecast Pro copies the zipped file from the network drive to a local workspace, unzips the project files and opens the project—allowing you to work on your project locally, even though it was saved to a network drive. When you resave your zipped project, Forecast Pro will zip the updated local project files and save the updated FPZip file to the network drive.

Forecast Pro defaults to saving zipped projects. To save and open unzipped projects, select FPProj as the file type in the Save as and Open dialog boxes.

Numeric Output Files

Numeric Output Files can contain time series output such as history, forecasts, fitted values and confidence limits as well as statistical output such as the forecasting model specification and summary statistics. These files can be saved in text, spreadsheet, ODBC or XML formats. You can include output for either all items forecasted or just for the Hot List. If you will be importing the forecasts into another application these are the files you will likely want to use.

You can specify the format and content of Numeric Output File in Numeric Output Settings. The operation of the Numeric Output Settings dialog box is described in The Numeric Output View.

You can preview the contents of the current Numeric Output File by clicking the Numeric Output dialog on the Reports tab.

You can save a Numeric Output file on the Export tab. First, on the left of the tab, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then, click the Numeric Output icon to save the report.

You may open Numeric Output settings without previewing the report by selecting Settings on the drop-down of the Numeric Output icon on the Reports tab or the Export tab.

Forecast Reports

Forecast Reports can be saved to Excel. You can save these reports for the currently displayed item, all items on the Hot List or all items forecasted. The Excel workbook will include a separate worksheet for each item. These reports are convenient if you wish to present the forecasts and/or models used to colleagues.

Each report contains the information found in the current Forecast Report view and (optionally) the graph found in the current graph view.

You can specify the format and content of Forecast Report using Forecast Report Settings and Graph Settings. You can open the settings dialog from the hamburger or context menu on the Forecast Report and Graph views. The operation of the Forecast Report Settings and Graph Settings dialog boxes are described in The Forecast Report View and The Graph Views.

You save a Forecast Report from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then click the small Forecast Report icon.
Item Reports

*Item Reports* can be viewed on-screen and saved to Excel. These reports can contain Pareto information, statistical output such as the forecasting model specification and summary statistics as well as time series output such as history, forecasts, fitted values and confidence limits.

To open an Item Report, you click the Item Report icon on the Reports tab. You save an Item Report from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then click the small Item Report icon.

You can specify the format and content of the report using Item Report Settings. You can open the settings dialog from the hamburger or context menu on the Item Report. The operation of the Item Report Settings dialog box is described in *The Item Report View*.

Outlier Reports

*Outlier Reports* can be viewed on-screen and saved to Excel. These reports list the items where outliers have been detected and/or corrected.

To open an Outlier Report, click the Outlier Report icon on the Reports tab. You save an Outlier Report from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then, click the small Outlier Report icon.

The content and format of the report is controlled using the Outlier Report's context menu. Please see *The Outlier Report View* for details.

Override Reports

*Override Reports* can be viewed on-screen and saved to Excel. These reports list the items where overrides and/or comments have been made.

To open an Override Report, click the Outlier Report icon on the Reports tab. You save an Override Report from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then, click the small Override Report icon.

You can specify the format and content of the report using Override Report Settings. You can open the settings dialog from the hamburger or context menu on the Override Report. The operation of the Override Report Settings dialog box is described in *The Override Report View*.

Tracking Reports

*Forecasts Tracking Reports* can be saved to Excel. You can save these reports for the currently displayed item, all items on the Hot List or all items forecasted. The Excel workbook will include a separate worksheet for each item. These reports are only available if the database includes at least one archived forecast for the given item.

Each report contains the information found in the current Forecast Report view and (optionally) the graph found in the current graph view.

You can specify the format and content of Forecasts Tracking Reports using Tracking Report Settings. You can open the settings dialog from the hamburger or context menu on the Tracking Report. The operation of the Tracking Report Settings dialog box is described in *The Tracking Report and Tracking Report Graph Views*. 
You save a Forecasts Tracking Report from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then click the small Forecasts Tracking icon.

You can print a tracking report for the currently displayed item using by selecting Print this Page from the Tracking Report view’s context menu. You can also save an Excel report for the currently displayed item using the Save this page to Excel option on the Tracking Report view’s context menu.

**Exception Reports**

Exception reports list the items where your forecast error or some other performance metric has fallen outside of an acceptable range. Exception reporting reduces the need for manual review of your forecasts and allows you to focus on the items where human attention is most needed.

There are five types of Exception Reports: *Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, Waterfall* and *Custom*. *Exception Reports* can be viewed on-screen and saved to Excel. The details of each of the Exception Reports is described in [The Exception Report Views](#).

To open an Exception Report, click the Reports tab icon for the specific Exception Report you want to view. Note that you can have all five reports open at the same time.

You save an Exception Report from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items currently included in the report. Then, click the small icon for the Exception report (*Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, Waterfall* or *Custom*) you want to save.

You can specify the format and content of the report by selecting Settings on the Exception Report’s hamburger or context menu. The operation of each Exception Report Settings dialog box is described in [The Exception Report Views](#).
Chapter 11: Custom Forecasts: The Forecasting Tab

By default, Forecast Pro will use expert selection, an Artificial Intelligence (AI) driven engine to automatically select a forecasting model for each item on the Navigator. The expert selection option works extremely well and is the method of choice for most Forecast Pro users. The expert selection algorithm is described in the Forecast Pro Statistical Reference Manual.

Alternatively, you can select alternative models and/or forecasting options using forecast modifiers. Forecast modifiers are added to items on the Navigator using the icons on the Forecasting tab or the Navigator’s context menu. Several models require the assistance of a model specification dialog box.

This chapter documents the model options and tools available on the Forecasting tab, the associated forecast modifiers and the operation of the model specification dialog boxes. Please note that in all cases, the described functionality is applied to the item selected in the Navigator.

Expert Selection

If an item on the Navigator does not have a modifier then Forecast Pro will use expert selection, an Artificial Intelligence (AI) engine, to automatically select the appropriate forecasting method. If an item on the Navigator does contain one or more modifiers and you click the Expert Selection icon on the Forecasting tab or select Model>Expert Selection on the Navigator’s context menu, the modifier(s) will be removed and Forecast Pro will use expert selection to automatically select the appropriate forecasting method.

Exponential Smoothing

Automatic Exponential Smoothing

Click the Automatic icon in the Exponential Smoothing group or select Model>Exponential Smoothing>Auto on the Navigator’s context menu to let Forecast Pro automatically select an exponential smoothing model.

The modifier associated with Automatic Exponential Smoothing is: \AUTO. Use the automatic fitting exponential smoothing model.
Simple Exponential Smoothing
Click the Simple icon in the Exponential Smoothing group or select Model>Exponential Smoothing>Simple on the Navigator’s context menu to use a simple exponential smoothing model.

The modifier associated with Simple Exponential Smoothing is: \(SIMPLE\). Use the simple exponential smoothing model.

Holt Exponential Smoothing
Click the Holt icon in the Exponential Smoothing group or select Model>Exponential Smoothing>Holt on the Navigator’s context menu to use the Holt exponential smoothing model.

The modifier associated with Holt Exponential Smoothing is: \(HOLT\). Use the Holt exponential smoothing model.

Winters Exponential Smoothing
Click the Winters icon in the Exponential Smoothing group or select Model>Exponential Smoothing>Winters on the Navigator’s context menu to use the Winters exponential smoothing model.

The modifier associated with Winters Exponential Smoothing is: \(WINTERS\). Use the Winters exponential smoothing model.

NA-CL Exponential Smoothing
Click the NA-CL icon in the Exponential Smoothing group, click the NA-CL icon in the Low Volume group or select Model>Exponential Smoothing>NA-Constant Level on the Navigator’s context menu to use the non-trended Additive Seasonality Constant Level exponential smoothing model.

The modifier associated with NA-CL Exponential Smoothing is: \(NA-CL\). Use the non-trended Additive Seasonality Constant Level exponential smoothing model.

Custom Exponential Smoothing
Clicking the Custom icon in the Exponential Smoothing group on the Forecasting tab or selecting Model>Exponential Smoothing>Custom on the Navigator context menu invokes the Exponential Smoothing Model Settings dialog box shown below.
The Model Type section of the dialog box allows you to specify Automatic selection (i.e., Forecast Pro will automatically select the form of the exponential smoothing model to apply), one of the standard models or Custom. If you select Custom, you will need to specify the form of Trend and Seasonality to use.

If you are forecasting data where the periods per cycle is greater than 13 (e.g., weekly data) you can use the Seasonal Simplification options to reduce the number of seasonal indices to use. None instructs Forecast Pro to not use seasonal simplification. Automatic allows Forecast Pro to automatically select the number of indices using out-of-sample testing. Custom allows you to specify the number of indices by specifying the “bucket size” (i.e., how many periods to combine into each seasonal index) or by setting the number of indices to use per year. Note that seasonal simplification cannot be used in conjunction with event models.

The Event Indices section allows you to specify the form of the event indices (additive, multiplicative or let Forecast Pro decide). This section will only be available if you have specified an event schedule. Furthermore, when events are used in conjunction with a seasonal model, the form of both the event indices and seasonal indices must match—so the Event Indices section will also be greyed out if Seasonality is set to anything other than None.

The Parameters section allows you to set the smoothing weights to specific values. In general, this is not a recommended practice (allowing Forecast Pro to optimize the smoothing weights is recommended). If you do wish to set the smoothing weights, you must specify a specific form for the trend and seasonality.

When you click the OK button Forecast Pro will apply the appropriate modifier on the Navigator and build the specified model.

The exponential smoothing modifiers are:
Use a custom exponential smoothing model with trend type X (N=no trend, L=linear trend, D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides) and optimized smoothing weights.

Use a custom exponential smoothing model with trend type X (N=no trend, L=linear trend, D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides) and user defined smoothing weights (A=level, B=trend, C=damping/growth, D=seasonal).

Use Forecast Pro’s automatic identification procedure to determine whether to use seasonal simplification and the appropriate bucket size.

Use seasonal simplification with n periods for each seasonal index or “bucket”.

Event Models

Event adjustment models extend exponential smoothing by allowing you to adjust for events like sales promotions, strikes or simply for unexplained outliers. Multiple events are used to account for promotions of different types or sizes, different calendar effects like Easter and Independence Day weeks, or any other “out of the ordinary” occurrence.

To build an event model, you must tell the program when events of each type occur. To do this, you must construct an event schedule which classifies each period by event code (0=no event, 1=event of type 1, 2=event of type 2, etc.). You can create event schedules interactively using the Event Manager or create them outside of Forecast Pro and import them using the Helpers row in the Data Manager. When you create an event schedule interactively, Forecast Pro will create a helper variable with this schedule.

The Event Manager

The Event Manager is used to create and modify event schedules. This section documents the options available on the Event Manager dialog boxes.

You invoke the Event Manager by clicking the Events icon on the Forecasting tab or selecting Manage events on the Graph 1 view’s context menu.
The Event Manager works in conjunction with the Graph 1 view. If the Graph 1 view is not open, clicking the Event icon on the Forecasting tab will open it for you.

The Manage Events dialog box is shown above. The Date drop-down at the top of the box is used to assign event codes to the current schedule. You select points on the graph by clicking on them and then use the drop-down to the right of the date to associate the selection with a specific event. Holding down the <Ctrl> key when selecting points on the graph allows you to select multiple points.

The display grid in the middle of the dialog box shows the event code definitions on the current schedule along with their status. Pending status indicates that the changes are not yet reflected in the current forecast model. Clicking the Commit button will accept the current changes and build the specified event model.

The Show all periods option will include all periods in the display grid regardless of whether or not events have been defined. You may select periods in the display grid and use the drop-down to assign event codes instead of selecting periods on the graph.
The Schedule drop-down is used for several purposes. When the drop-down is closed it displays the name of the event schedule associated with the current item. Opening the drop-down displays the currently available event schedules and allows you to select one. It also provides options to disassociate the currently selected schedule from the currently displayed item (New), rename the current schedule (Save as), import events from other schedules into the current schedule and to delete the current schedule from the Forecast Pro database.

Clicking the Edit button invokes the Manage Event Codes dialog box allowing you to define new event codes and edit existing ones. You can select an event code using the spinners or by clicking on it in the display grid. After editing a description, you click the Add button to update the display grid. You can remove an event code by selecting it in the display grid and clicking the Remove button. All modifications will have a status of Pending until you accept them using the Commit button. The Exit button is used to close the Manage Event Codes dialog box and return to the event manager.
Use the drop-down on the Events icon and select Event Codes to open the Manage Event Codes dialog box directly. Finally, the Events icon drop-down lists all event schedules associated with the project. Select a schedule from the drop-down to apply the modifier $EVENT=_X$, where $X$ is the selected schedule or helper, to the selected item on the Navigator.

For examples of constructing event variables and building event models, consult the Building Event Models lesson in Forecast Pro TRAC Tutorials. For statistical details, consult the Forecast Pro Statistical Reference Manual.

The following modifiers are used for Event Models:

$EVENT=_X$. Use an event model with helper _X.

$EXSM=XYZ$. Use an exponential smoothing model with trend type X (N=no trend, L=linear trend, D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides) and event type Z (M=multiplicative, A=additive, *=Forecast Pro decides). This modifier can only be used in conjunction with $EVENT=.$

$XYZ(A,B,C,D,E)$. Use an exponential smoothing model with trend type X (N=no trend, L=linear trend, D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides), event type Z (M=multiplicative, A=additive, *=Forecast Pro decides) and user defined smoothing weights (A=level, B=trend, C=damping/growth, D=seasonal, E=event). This modifier can only be used in conjunction with $EVENT=.$

**Custom Component Model**

The custom component model includes each of the components found in a custom exponential smoothing model, specifically, level, trend, seasonality and events. In a standard smoothing approach, final values of each component are estimated from the data and used to assemble the forecasts. In a custom component model, you can either let Forecast Pro estimate the final value for a given component or to customize the values to be used.

Custom component models are useful in a variety of situations including (1) customizing the trend for longer-term forecasts, (2) customizing the seasonal pattern for short data sets and (3) defining the impact of future events that have not occurred historically. Because custom component models are particularly useful for new products, Forecast Pro includes a Custom Component icon in the New Product group in addition to the primary icon on the Forecasting tab.

Clicking either Custom Component icon or selecting Model>Component on the Navigator context menu invokes the Component Model Settings box shown below.
Name: Forecast Pro names each of your component model specifications and saves them in the project’s database. These named specification sets provide a convenient way to apply the same component model specifications to multiple items on the Navigator. The Name drop-down allows you to select previously defined specification sets, create new ones, save the current set using a different name and delete the current set.

Description: The description field allows you to enter a description for the current specification set.

Starting Point: The Starting Point drop-down allows you to set the starting point for the forecasts. Automatic instructs Forecast Pro to estimate an exponential smoothing model for the data and set the starting point to the final level. Custom allows you to enter a specific value to use as the starting point. Final Historic sets the starting point to the final historic observation.

Trend (None and Linear): The trend drop-down allows you to specify the form of the trend you wish to forecast. All trends will begin at the starting point. None will yield a flat-line trend. Linear automatic instructs Forecast Pro to estimate an exponential smoothing model for the data and set the trend to the final trend estimated for the model (this will either be linear or flat-line). Linear custom will default to the linear automatic value but the slope can then be modified using the radio buttons (discussed below).

Trend (Bent): You can modify a linear trend by “bending” it up or down. When you bend a trend downward you decrease the per-period-slope increment resulting in a trend that dampens out as you forecast forward. When you bend a trend upward you increase the per-period-slope increment resulting in a trend that accelerates as you forecast forward. Bent automatic will use the linear automatic trend as the baseline which can then be bent using the radio buttons (discussed below). Bent custom will default to using the linear automatic trend as the baseline but allows you to change the slope for the baseline trend (using the Slope radio button) as well as allowing you to bend the baseline trend using the radio buttons (discussed below).
**Trend (radio buttons):** The trend radio buttons are used to customize the slope. When the Component Model Settings dialog box is open, the graph includes the current committed trend. The **Slope** button allows you to modify the slope (per-period change) directly. The **End Point** allows you to set the value of the trend at the last forecast point. The difference between the trend’s starting point and ending point can be thought of as the “vertical rise.” **Percent** allows you to specify the ending point of a bent trend model as a percentage of the vertical rise. **Total Forecast** allows you to set a value for the sum of the total forecast. **Current Year** allows you to set a value for the sum of the current year’s historic + forecast values.

**Seasonal Indexes:** The Seasonal Indexes drop-down allows you to specify the multiplicative indexes you wish to use to forecast the seasonality. **None** will yield a nonseasonal forecast. **Automatic** instructs Forecast Pro to estimate an exponential smoothing model for the data and set the seasonal indexes to the final seasonal indexes estimated for the model. **Custom** allows you to edit the currently displayed values. **Helpers** allow you to import the indexes from a helper variable. If the helper variable contains more than one year’s worth of indexes, Forecast Pro will import the final year’s values.

**Schedule:** Schedule allows you to specify an event schedule to use.

**Event Indexes:** **Event Indexes** allows you to specify the form and values for the event indexes. **None** will not apply event indexes to the forecast. **Automatic** instructs Forecast Pro to estimate an exponential smoothing model for the data and set the event indexes to the final event indexes estimated for the model. **Custom additive** allows you to edit the currently displayed values and apply them as additive indexes. Please note that the displayed values may correspond to a multiplicative model and, if so, should be changed to values that reflect incremental units driven by each event code. **Custom multiplicative** allows you to edit the currently displayed values and apply them as multiplicative indexes.

Click OK or Apply on the Component Model Settings dialog box to apply the model shown in the name drop-down to the item selected on the Navigator. Alternatively, you may open the drop-down on the large Custom Component icon on the Forecasting tab and select a model name.

The following modifier is associated with the custom component model.

**Model>Component:** |COMP=|name. Use a custom component model with the specifications defined in name.

---

**Dynamic Regression**

Dynamic regression produces a forecast based on the forecasted item’s history (like univariate methods) and that of the explanatory variables (e.g., product promotion, advertising, demographic variables, macroeconomic indicators, etc.).

Clicking the Dynamic Regression icon on the Forecasting tab or selecting Dynamic Regression>Manage or Models>DYNAMIC REGRESSION on the Navigator context menu invokes the Dynamic Regression dialog box shown below.
Name: Forecast Pro names each of your dynamic regression model specifications and saves them in the project’s data base. These named specification sets provide a convenient way to apply the same dynamic regression model specifications to multiple items on the Navigator. The Name drop-down allows you to select previously defined specification sets, create new ones, save the current set using a different name and delete the current set.

Description: The description field allows you to enter a description for the current model selection.

Explanatory variables: Explanatory variables allow you to capture how the dependent variable changes in response to external variables. The Explanatory variables field lists all explanatory variables (both global and item-specific) read in through the Data Manager. Please see the Explanatory Variables section of “Setting up your Optional Data” for details on the differences between global and item-specific explanatory variables.

System variables: There are two type of terms that can be included in a dynamic regression models—explanatory variables and dynamic terms. Explanatory variables are defined above. Dynamic terms capture how the dependent variable changes in time and can help forecast trends and seasonal patterns in a similar fashion to extrapolation methods such as Box-Jenkins and exponential smoothing.

The System variables field list dynamic terms as well as well as system terms for defining additional explanatory variables in Forecast Pro.

Each of these system terms starts with an underbar to identify it as a Forecast Pro defined variable. These terms include the following:

_PERIOD(n) creates a dummy variable for period n. The dummy variable will have a value of 1 for the nth period in the seasonal cycle and a value of 0 for all periods. For example, if you are using monthly data, _Period(3) will have a value of 1 for every March and a value of 0 for all other time periods.
_SPIKE(year, period) is used to create a dummy variable for a single period. For example, for a monthly data set, _SPIKE(2017,7) has a value of 1 for July 2017 and a value of 0 for all other periods. This function can be useful when modeling outliers.

_STEP(year, period) is used to create a variable that consists of all zeroes prior to a specified time period and all ones thereafter. For example, for a monthly data set, _STEP(2017,7) will have a value of 0 prior to July 2017 and a value of one for July 2017 and thereafter. This function can be useful when modeling level shifts.

The Systems variables list box may also include the following dynamic terms:

 //_CONST is used to include a constant term in the model. A constant term has a value of 1 for all time periods.

 //_TREND is used to include a linear trend term in the model.

 //_DEPEN[endent][-n] is used to include a lagged dependent variable in the model. For example, if you are modeling the item Sales, DEPENDENT[-1] is Sales for the prior period.

 //_AUTO[-n] is used to create a Cochrane-Orcutt model which includes a variable equal to the fitted model error from n periods earlier. For example, when you add _AUTO[-1] to the model, the program uses the fitting error from time t-1 to help predict the fitting error for time t.

Forecast Pro offers an Automatic dynamics mode whereby you specify the explanatory variables you wish to use, and the program automatically determines the dynamic terms to include. When you use Automatic dynamics, the dynamic terms are not visible in the Dynamic Regression dialog box.

When you double click on an item in the Terms list box, it is added to the Model box. When you add _STEP or _SPIKE, you will be asked to specify a date to use before it is added. Once you have added a variable to the Model box, it can be edited using the context menu as described in the Model section below.

**Model:** The Model box lists all terms that you have added to the model. To the left of each item is a checkbox to indicate if the item should be included in the regression. If this box is checked, the term will be included in the model. If the box is not checked, the term will be tested in the dynamic regression test batteries but will not be included in the model. If Automatic dynamics is selected, the dynamic terms will not appear in the Terms and Model boxes, but an optimized set of dynamics terms will be included in the model.

Each term in the Model box can be adjusted using the Model box’s context menu. Right click on the item in the Model box to activate the Model box’s context menu.

- **Clear** will remove all terms from the dialog box.
- **Remove** will remove just the selected item from the Model box.
- **Lag** allows you to adjust the specified lag. You can use the lag selection to create lagged explanatory variables or to adjust the lags for the _AUTO and _DEPEN[endent] terms.
- **Transform** allows you to use a logarithm, square root or inverse transform on the selected variable. Transform is not available for dummy variables or if the transform cannot be applied to the selected variable (e.g. logarithm for items with zero values).
- **Edit** allows you to change the specified period for the dummy variables (_PERIOD, _STEP and _SPIKE).

**Optimize Dynamics (button):** This button will replace any existing dynamic terms in the model with a set of dynamic terms selected by Forecast Pro. Note that the optimal model
dynamics are selected for the item currently selected on the Navigator and the specified non-dynamic terms in the Model box. Once the optimal dynamics are added—they are simply part of the specified model—they will not be automatically updated if you subsequently change the model.

**Automatic Dynamics (check box):** Forecast Pro offers an Automatic dynamics mode whereby you specify the explanatory variables you wish to use and the program automatically determines the dynamic terms to include. Automatic Dynamics is selected by default.

There are important (but subtle) differences between a model specification that uses the Automatic Dynamics option and a model specification that used the Optimize Dynamics button to determine the dynamics.

1. **If you apply the same model specification to multiple items on the Navigator, the model specification that uses automatic dynamics will select the dynamic terms independently for each item. The model specification built using the Optimized Dynamics button will simply apply the specified terms to each item.**

2. **If you update your project with new data and reforecast, the model specification that uses automatic dynamics will re-select the dynamic terms using the new data (potentially changing the selected terms). The model specification built using the Optimized Dynamics button will simply apply the previously specified terms to each item.**

Note that the dynamic regression model specification can also be edited with the context menu in the Forecast Report view. Right click on a term in the model details section of the report to activate the context menu and remove an item. The Variable Test Specification battery and Dynamics Test Battery sections of the report list explanatory variable and dynamic to consider adding to the model. To add a term to the model, right click on the term you wish to add and select **Add term** from the Forecast Report context menu.

In order to generate forecasts, Forecast Pro needs values for each explanatory variable for all periods in the forecast horizon. These values may be provided in the explanatory variables file, or you may use Auto Extend if you want Forecast Pro to use expert selection to generate forecasts for any explanatory variable that does not have values provided for all periods in the forecast horizon. Forecast Pro will provide values only for those periods where none was provided. By default, Auto Extend is not selected. To select Auto Extend, open the Options dialog box by clicking the Options icon on the Home ribbon tab and then go to the Advanced Controls tab on the Options dialog box.

Click OK or Apply on the Dynamic Regression dialog box to apply the model shown in the name drop-down to the item selected on the Navigator. Alternatively, you may open the drop-down on the Dynamic Regression icon on the Forecasting tab and select a model name.

The following modifier is associated with the dynamic regression model.

\[ DR=\text{name} \]. Use a dynamic regression model with the specifications defined in \text{name}.

**New Product Models**
By Analogy

The concept behind the Forecast by Analogy model is very simple. The approach is sometimes referred to as a “looks like” analysis. The model assumes that the initial sales over the first few time periods for a new product will follow the same pattern as the initial sales of an existing, similar product as it launched. To use this method, you must supply the launch profile or “analog series” in the form of a helper variable. This launch profile is simply sales for the analog product, starting with the launch period and extending for as many time periods as deemed relevant.

If the product has not yet launched (i.e., there are no historic data available), then you must also supply an estimate of the initial sales over a specific period of time (the “launch total” over the “launch horizon”). Forecast Pro will then create the forecast by proportionally allocating the launch total over the launch horizon using the analog series to define the proportions.

If any historic demand for the new product is available, you may either supply the launch total and launch horizon or allow Forecast Pro to calculate the forecasts by fitting the existing data to the analog series.

Clicking the By Analogy icon on the Forecasting tab or selecting Model>By Analogy on the Navigator context menu invokes the Forecast by Analogy Model Settings dialog box shown below.

The Select the analog variable box displays the currently available helper variables and allows you to select the one you’d like to use as the analog series. If historic demand exists, the Estimated launch total displays the launch total calculated using the current analog variable and the historic demand. The Specified launch total allows you to input a specific launch total to use. The Launch horizon allows you to specify the length of the launch horizon. The default launch horizon equals the length of the history, if any, plus the current forecast horizon.

The Launch date option is only available if the product has not yet launched (i.e., there is no historic demand for the product). It allows you to specify when the product will come on line, allowing you to set up the forecasting model in advance of the launch date.

The Automatically extend option will automatically forecast the analog variable if it does not cover the full launch horizon. The Align seasonality option will (if necessary) adjust the beginning period of the analog series so that it aligns with the launch date’s period. For example, if the analog series started in January and the launch date corresponded to March, then selecting this option would result in using the analog series’ first March observation as the first analog series data point (thus aligning the seasonal patterns of the analog series and the new product).
**Bass Diffusion**

*Expert selection after* is used to specify a date where Forecast Pro should stop using the Forecast by Analogy method and switch to using expert selection. For example, if you set *Expert selection after* to January 2020, Forecast Pro would use the Forecast by analogy approach until your historic data included February 2020.

Click OK or Apply on the Forecast by Analogy Model Settings dialog box to apply the by analogy model.

The modifiers associated with Forecast by Analogy are:

- \( \text{ANALOG}_X \). Use the by analogy model with automatic calculation of the launch total. \( X \) is the name of the time series containing the analogy series.
- \( \text{ANALOG}_X(A,B) \). Use the by analogy model with a specified launch total of \( A \) and a specified launch horizon of \( B \).
- \( \text{ANALOG}_X(A,B,C,D) \). Use the by analogy model with a specified launch total of \( A \), a specified launch horizon of \( B \) and a specified launch date with a starting year of \( C \) and starting period of \( D \). This option is only available when the series being forecasted has no historic data.
- \( \text{ANALOGEX}, \text{ANALOGAL}, \text{ANALOGD} \). There are three suffixes that may appear after the keyword ANALOG. EX appears if the *Automatically extend* option is selected. AL appears if the *Align seasonality* option is selected. D appears if the *Expert selection after* option is selected. If all three options are selected, all 3 suffixes will appear after the keyword ANALOG.

**Bass Diffusion**

The Bass model is most often used to forecast first time purchases of new-to-world products.

The model tries to capture the adoption rates of two types of users—innovators and imitators. Innovators are early adopters of new products and are driven by their desire to try new technology. Imitators are more wary of new technology—they tend to adopt only after receiving feedback from others.

The Bass model uses two coefficients to quantify the adoption rates. The *Coefficient of Innovation*, referred to in the literature as “\( p \)”, controls the adoption rate for the innovators. The *Coefficient of Imitation*, referred to in the literature as “\( q \)” controls the adoption rate for the imitators.

If you have 5 or more historic data points, these coefficients can be fit to the data. To build a Bass model with fewer than 5 data points you must set the values for these coefficients along with the total number of potential adopters. Typically, “\( p \)” is between 0 and 0.1, while “\( q \)” is between 0.3 and 0.5.

Clicking the Bass Diffusion icon or selecting *Model>Bass Diffusion* on the Navigator context menu invokes the Bass Diffusion Model Settings dialog box shown below.
If you have five or more data points, the *Generate coefficients automatically* option allows you to instruct Forecast Pro to automatically fit the model parameters to the data. If you do not select *Generate coefficients automatically*, you’ll need to supply the model coefficients and potential market size.

The modifiers associated with the Bass diffusion model are:

\[BASS\]. Use the Bass diffusion model with automatically generated coefficients and potential market size.

\[BASS(p,q,m)\]. Use the Bass diffusion model with user defined parameters p, q and m.

**Custom Component Model**

Click the Custom Component icon to invoke the Component Model Settings dialog box. See *Custom Component Model* for a detailed description of the dialog box.

The following modifier is associated with the custom component model.

Model>Component: \[COMP=\text{name}\]. Use a custom component model with the specifications defined in \text{name}.

**Low Volume Models**

**Intermittent Data**

Click the Croston’s icon or the Forecasting tab or select Model>Intermittent on the Navigator context menu to use Croston’s intermittent demand model.

Model>Intermittent: \[INTER\]. Use the Croston’s intermittent data model. The Croston’s model is designed for data sets where the demand for any given period is often zero and the exact timing of the next order is not known.
Discrete Data

Click the Discrete icon or the Forecasting tab or select Model>Discrete on the Navigator context menu to use simple exponential smoothing model and base confidence limits on one of the discrete distributions (Poisson or negative binomial)

Model>Discrete: [DISCRETE]. Use a simple exponential smoothing model and base confidence limits on one of the discrete distributions (Poisson or negative binomial). This option is used to obtain better estimates of the confidence limits for low volume integer series (typically with many zeros).

NA-CL Exponential Smoothing

Click the NA-CL icon or select Model>Exponential Smoothing>NA-Constant Level on the Navigator’s context menu to use the non-trended Additive Seasonality Constant Level exponential smoothing model.

|NA-CL| is the modifier for NA-CL exponential smoothing.

Other Forecasting Options

Box-Jenkins (ARIMA)

Clicking the Box-Jenkins icon in the Other group or selecting Model>Box-Jenkins>Auto on the Navigator context menu instructs Forecast Pro to automatically select a Box-Jenkins (ARIMA) based on out-of-sample fit combined with some Artificial Intelligence expert system rules.

|BJ| is the modifier for automatic Box-Jenkins model.

Selecting Custom from the drop-down on the Box-Jenkins icon on the Forecasting tab or selecting Model>Box-Jenkins>Custom on the Navigator’s context menu will open the dialog box shown below.
The Model Type section of the dialog box allows you to specify Automatic (i.e. Forecast Pro will automatically determine the ARIMA model orders) or Custom (i.e. you will explicitly select the model orders to use). In addition, there are options to include a constant term in the model and to apply a power transformation.

When you click the OK button, Forecast Pro will apply the appropriate modifier on the Navigator and build the specified model. The custom Box-Jenkins modifiers are:

- \( \text{ARIMA}(p,d,q) \): Use a non seasonal Box-Jenkins model with model orders \( p, d \) and \( q \).
- \( \text{ARIMA}(p,d,q)\times(P,D,Q) \): Use a seasonal Box-Jenkins model with model orders \( p, d, q, P, D \) and \( Q \).
- \( \text{CONST} \): Include a constant intercept in the Box-Jenkins model.

**Best-fit Line**

Click the Best-fit Line icon on the Forecasting tab or select **Models>Curve Fit>Straight Line** on the Navigator’s context menu to fit a straight line to the data.

\( \text{CFIT=} \text{LINE} \) is the modifier to fit a straight line to the data set.

**Same as Last Year**

Click the Same as Last Year icon on the Forecasting tab or select **Model>Very Simple Models>Same as Last Year>No Change** from the Navigator’s context menu to set each forecasted value to equal the value for the same period last year (either history or forecast as the case may be).

Selecting Plus Percent or Plus increment from the drop-down on the Same as Last Year icon or selecting **Model>Very Simple Models>Same as Last Year>Plus Percent or Model>Very Simple Models>Same as Last Year>Plus Increment** from the Navigator’s context menu will open the dialog box shown below.

![Dialog Box](image)

*Same as last year* (selected by default when opened from drop-down) sets each forecasted value to equal the value for the same period last year (either history or forecast as the case may be). The *Percent* option (selected by default when Plus percent is selected from the drop-down) sets each forecasted value to equal the value for the same period last year plus the specified percentage. The *Increment* option (selected by default when Plus increment is
selected from the drop-down) sets each forecasted value to equal the value for the same period last year plus the specified increment.

Selecting Plus delta percent from the drop-down on the Same as Last Year icon or selecting Model>Very Simple Models>Same as Last Year>Plus Delta Percent on the Navigator’s context menu will set each forecasted value to equal the value for the same period last year adjusted by the percentage change between the value for the same period last year and the same period two years ago. That is, the model assumes that sales will grow at the same percentage rate as last year.

Selecting Plus delta increment from the drop-down on the Same as Last Year icon or selecting Model>Very Simple Models>Same as Last Year>Plus Delta Increment on the Navigator’s context menu will set each forecasted value to equal the value for the same period last year adjusted by the unit change between the value for the same period last year and the same period two years ago. That is, the model assumes that sales will grow by the same number of units as last year.

The modifiers associated with Same as Last Year models are:

\( \text{SALY} \). Set each forecasted value to equal the value for the same period last year (either history or forecast as the case may be).

\( \text{SALYP}=n \). Set each forecasted value to equal the value for the same period last year plus the specified percentage \((n)\).

\( \text{SALYI}=n \). Set each forecasted value to equal the value for the same period last year plus the specified increment \((n)\).

\( \text{SALYDP} \). Set each forecasted value to equal the value for the same period last year adjusted by the percentage change between the value for the same period last year and the same period two years ago. That is, the model assumes that sales will grow at the same percentage rate as last year.

\( \text{SALYDI} \). Set each forecasted value to equal the value for the same period last year adjusted by the unit change between the value for the same period last year and the same period two years ago. That is, the model assumes that sales will grow by the same number of units as last year.

**Moving Average**

Click the Moving Average icon on the Forecasting tab or select Model>Very Simple Models>Simple Moving Average on the Navigator’s context menu to open the dialog box shown below.
Specify the number of terms used or check *Automatic* to have Forecast Pro automatically select the number of terms. Click OK or Apply to apply the moving average model.

The modifiers associated with moving averages are:

- **|SMA=n.** Use an n-term simple moving average.
- **|SMA.** Use a simple moving average where Forecast Pro automatically selects the number of terms to use.

**Curve Fitting**

Forecast Pro offers the following curve fitting approaches: Best-fit line, Quadratic, Exponential and Growth. Each of these methods can be selected from the drop-down on the Curve fitting icon on the Forecasting tab or from *Models>Curve Fit* on the Navigator’s context menu.

Click the Curve Fitting icon on the Forecasting tab or select *Models>Curve Fit>Automatic* on the Navigator’s context menu to use the curve fitting routine that best fits the historic data.

The modifiers for moving average models are:

- **|CFIT.** Use the curve fitting routine that best fits the historic data.
- **|CFIT=LINE.** Fit a best-fit straight line to the data set.
- **|CFIT=QUAD.** Fit a quadratic curve to the data set.
- **|CFIT=EXPO.** Fit an exponential curve to the data set.
- **|CFIT=GROW.** Fit a growth curve (S-curve) to the data set.

**Weight (Weighting Transformations)**

A weighting transformation is most commonly used to de-seasonalize your variables using externally supplied seasonal weights, or to normalize the data for trading day effects (e.g., 4-4-5 calendars, number of working days per month, etc.).

To use a weighting transformation, you must create a *helper* variable containing the weights. Helper variables names *must* start or end with an under-bar. Helper variables are
not forecasted, and their values are not included in group totals. Helper variables are used in conjunction with event models, by analogy models and weighting transformations.

To apply a weight transformation, click on the Weight icon in the Other group on the Forecasting tab or select Weights> Select on the Navigator’s context menu to open the dialog box shown below.

Select the helper variable with the weights you want to apply and click OK to apply the forecast modifier. The following modifier is used to specify the weighting transformation.

Weights> Select: | WGT = _X. Use a weighting transformation. _X is the name of the time series containing the weights.

The procedure divides each value of the specified time series by the corresponding value (weight) in _X. It then forecasts the de-weighted variable and multiplies the forecasts by their corresponding weights. The weighting variable _X must span the entire history and forecast period for each variable to be forecasted.

**Discontinue**

Click on the Discontinue icon in the Other group on the Forecasting tab or Discontinue on the Navigator’s context menu to discontinue the item selected on the Navigator.

Select Discontinue after on the drop-down on the Discontinue icon on the Forecasting tab to open a dialog box where you can specify the date after which the selected item should be discontinued.

The discontinue modifiers are:

| DISCONT. Treat the specified item as discontinued. Discontinued items are not forecasted but their historic demand does go into group-level aggregates.

| DISCONT(AFT)(Year, Period). Treat the specified item as discontinued after the specified date.

**Fixed Value**

*Fixed forecast value* sets the forecast to the specified value.
Click the Fixed Value icon in the Other group on the Forecasting tab or select Model>Very Simple Models>Fixed Forecast Value on the Navigator’s context menu to open the Very Simple Models dialog box with Fixed forecast value selected.

Enter the desired forecast value and click OK or Apply to apply the model.

Select Fixed Value After on the Fixed Value icon drop-down or select Model>Very Simple Models>Fixed Forecast Value After on the Navigator’s context menu to invoke the dialog box shown below that sets the forecast to the specified value after the specified date. This option is often used when you plan to discontinue an item at a specific time and wish to set the forecast to zero.

The modifiers associated with fixed value forecasts are:

|FIXED|=n. Set each forecasted value to n.

|FIXED AFT|= (Year, Period, n). Set each forecasted value which falls after the year and period specified to n.

**Custom Modifiers**

Click on the Custom icon in the Other group on the Forecasting tab or select Custom Modifier on the Navigator’s context menu to enter modifiers explicitly.
All modifiers may be entered using the Custom Modifier dialog box. There are also some modifiers that must be entered using the Custom Modifier box, including:

|LOWER|=l. Set the lower confidence limit equal to the value \( l \). \( l \) must be between 0.1 and 50.0 inclusive.

|UPPER|=u. Set the upper confidence limit equal to the value \( u \). \( u \) must be between 50.0 and 99.9 inclusive.

|CONF(l,u)|. Set the lower confidence limit equal to the value \( l \) and the upper confidence limit equal to \( u \). \( l \) must be between 0.1 and 50.0 inclusive and \( u \) must be between 50.0 and 99.9 inclusive.

|LEADTIME|=n. Set the lead time for the safety stock to \( n \). The specified lead time appears highlighted in the Safety Stock section of the Forecast Report and determines the values written to the Numeric Output file. Fractional entries (e.g., 1.5) are permitted.

|TIMEFENCE|=n. Set the length of the time fence for the specified item to \( n \). Be aware that if you use the \TIMEFENCE modifier to create a time fence shorter than the global time fence, it will shorten the time fence for all associated parent groups of the item.

|START(Year, Period)|. Only use historic data after the specified date to estimate the specified item’s forecast model.

|POW=key| Use a Box-Cox power transformation. Key may equal LOG, SQRT, INVERSE or any decimal number from -1.0 to 1.0. If you enter \POW=AUTO, Forecast Pro will test your data and implement an appropriate Box-Cox transformation (or none at all). Consult the Forecast Pro Statistical Reference Manual for a discussion of the Box-Cox power transformations.

### Group Level (Reconciliation Modifiers)

If no group-level reconciliation modifiers have been specified, a bottom-up approach will be used to reconcile the forecasts. The procedure operates as follows.

First, Forecast Pro prepares forecasts for all groups and items.

Then, Forecast Pro recomputes the group-level forecasts by aggregating the constituent forecast (bottom up). The original group level forecasts are replaced, but their confidence limits are retained and proportionately adjusted.

Three group-level modifiers can be used to specify alternative reconciliation approaches or leverage group data structure. These modifiers can only be used on group-level data.
**Top-down**

To apply top-down reconciliation, click the Top-down icon in the Group Level group on the Forecasting tab or select *Top-down* from the Navigator’s context menu.

This procedure begins by preparing forecasts for all groups and items. Then it proportionally adjusts the nested lower level item and group forecasts to sum to the selected group’s forecast. Please consult *Reconciling the Hierarchy* for more details.

Top-down reconciliation uses the following modifier:

\TOPDOWN. Directs Forecast Pro to perform top-down reconciliation for all members of the indicated group.

**Custom Allocation**

To apply custom allocation, click the Custom Allocation icon in the Group Level group on the Forecasting tab or select *Custom Allocation* from the Navigator’s context menu.

Note that Custom Allocation is only available when you have defined the proportions in a file, table or query and read it into Forecast Pro using the Definitions row in the Data Manager, and it is only available for the group(s) one hierarchy level above the level at which the proportions are defined. Consult *Definitions: Custom Allocations* in *Setting up Your Optional Data* for details.

The procedure begins by creating forecasts for the specified group and then using the user-defined proportional factors to allocate the group forecast down one level. Any additional lower levels are adjusted via a top-down procedure unless they too are using Custom Allocation.

Custom Allocation uses the following modifier:

\CALL. Directs Forecast Pro to use user-defined proportionalities to allocate the group-level forecast down to the next level.

**Indexes**

Click the Indexes icon in the Group Level group on the Forecasting tab or select *Indexes* from the Navigator’s context menu to use a Group level seasonal index for all items within the group.

Indexes uses the following modifier:

\INDEXES. Directs Forecast Pro to calculate the seasonal indexes at the indicated group level and use them to de-seasonalize the histories for the nested items and groups. The de-seasonalized series are then forecasted and as a final step re-seasonalized. This approach works well when the items share the same seasonality. It allows one to deal with items whose histories are too short to extract seasonality directly. You cannot use \INDEXES if the group level includes zeros or negative numbers. You cannot nest \INDEXES groups within each other. Model parameters are re-estimated for each item of the \INDEXES group.
Tools

Diagnostics

Click the Diagnostics icon in the Tools group on the Forecasting tab to open the Diagnostics View.

Consult The Diagnostics View for details on available functionality.

Create Helper

Helper variables are required for event modeling, forecast by analogy and the weighting transformation. Helper variables may also be used in Custom Component and Dynamic Regression models. Helpers are identified by a preceding or trailing under-bar in their name.

Event schedules are created interactively using the Event Manager, or you can create helper variables containing the event schedules in Excel or in a database and import them into your project using the Data Manager. Event Schedules are not created with the Create Helper icon.

Forecast by analogy requires a helper variable containing the analogy series. Using a weighting transformation requires a helper variable containing the weights. Depending on your needs, you can either create forecast by analogy and weighting transformation helper variables using the Create Helper icon or you can create them in Excel or in a database and import them into your project using the Data Manager (see Helper Files in the Setting Up Your Optional Data section of this Command Reference chapter).

To use Create Helper, select the item which you want to base the helper variable upon on the Navigator, and then click on the Create Helper icon in the Tools group on the
Forecasting tab or select *Helper variable> Create* on the Navigator’s context menu to open the Create Helper Variable dialog box.

To create the helper variable, select the desired contents, adjust the date range (if necessary) and click OK. Forecast Pro will then create the helper variable and save it in your project.

By default, the helper variable will be named “*_selection*” where *selection* is the name of your current Navigator selection. You may rename the helper variable via the Name field prior to clicking OK.

The *Seasonal component* option is designed for use with the custom component model. The custom component model allows you to import seasonal indexes from a helper file. The Seasonal component option on the Create Helper Variable dialog box estimates a set of seasonal indexes which can then be imported into a custom component model. For example, say you want to build a custom component model for a given SKU that uses the seasonal indexes calculated from the SKU’s corresponding product-level group. You would select the product-level group, create the helper variable and then import the indexes from the helper when you build a custom component model for the SKU.

If you wish to delete a helper variable you must first save your project, then select the helper variable on the Navigator, then right click to invoke the Navigator’s context menu and then select *Helper variable>Delete*.

**Outliers**

Click on the Outliers icon in the Tools group on the Forecasting tab to open the Outliers tab in the Options dialog box.

When you generate forecasts, Forecast Pro uses the current settings in the Outliers tab on the Options dialog box to determine the default behavior for detection and correction of outliers. There are three choices:

*None*. Do not detect nor correct for outliers.

*Detection only*. Detect and report outliers but do not correct for them (i.e., base the forecasts on the uncorrected values).

*Detection and correction*. Detect and correct outliers (i.e., base the forecasts on the corrected values).
Please consult The Outliers Tab in Forecast Pro Options for more details on the settings available in the Outliers tab.

You may override project level-setting for an end-item selected on the Navigator by selecting None, Detected or Corrected from the drop-down on the Outliers icon. Forecast Pro only detects outliers for end-items (i.e., non-group level data), so the selections are not available if a group level is selected on the Navigator.

Outliers are associated with the following modifiers:

* (no modifier). Revert back to the default project-level setting (specified on the Outliers tab on the Options dialog box) for the specified item. This option is used to remove any of the outlier modifiers (listed below) from the Navigator.

* \( \text{OUTLIER}=\text{OFF} \). Do not detect nor correct outliers for the specified item.

* \( \text{OUTLIER}=\text{DETECT} \). Detect and report outliers for the specified end-item, but do not correct for them (i.e., base the forecasts on the uncorrected values).

* \( \text{OUTLIER}=\text{CORRECT} \). Detect and correct outliers for the specified end-item (i.e., base the forecasts on the corrected values).

Finally, select Outliers on the drop-down on the Outliers icon to open the Outlier Report view. The Outlier Report is a global report that list all outliers identified in the project. This view is described in detail in The Outlier Report View.
Chapter 12: Working with Hierarchies

This chapter discusses the strategies that Forecast Pro uses to produce consistent forecasts for hierarchical data.

Defining the Hierarchy

Product data can almost always be organized into several levels of aggregation. Suppose that the lowest-level forecasts you need to generate represent SKUs (Stock Keeping Units). SKU-level forecasts are often needed to support production planning and inventory control. The corporation might aggregate these SKUs first into products and then into product lines for marketing and sales. These might be aggregated further into geographical regions for the benefit of top management.

For the purposes of this discussion, we will be referring to end-items and groups. End-items are the lowest-level data in your hierarchy. In the above example, each SKU would be an end-item. Groups are aggregations of end-items. In the above example, products, product lines and geographical territories would all be examples of groups.

Forecast Pro allows you to define product hierarchies and create one set of self-consistent forecasts. It allows top-down, bottom-up or user-defined reconciliation, seasonal adjustment based upon aggregate data and model selection at the aggregate level.

It is not necessary that the end-item histories begin and end at the same time. Thus group-level data may consist of end-items that have been retired or replaced by new end-items. Obsolete end-items will contribute to the group-level history but will not themselves be forecasted. You will notice that the starting and ending dates for the overall historic data consist of the starting date for the oldest end-item and the ending date for the newest. Forecasts will be prepared for all end-items and groups that are “alive” at the end of the data set. Those whose histories terminate before that time are considered dead—they contribute to the historic aggregates (and therefore influence aggregate forecasts), but they are not themselves forecasted.

How to organize your data into hierarchies was discussed in the Setting Up Your Historic Data chapter.

Reconciling the Hierarchy

If no group-level reconciliation modifiers have been specified, a bottom-up approach will be used to reconcile the forecasts. The procedure operates as follows.

First Forecast Pro prepares forecasts for all groups and end-items.

Forecast Pro then recomputes the group-level forecasts by aggregating the constituent forecasts (bottom up). The original group-level forecasts are replaced, but the widths of their confidence limits are retained and re-centered on the new forecasts.

There are two alternative reconciliation approaches, top-down and custom allocation. Both approaches are only available for group-level items.

Top-down Reconciliation

Top-down reconciliation directs Forecast Pro to perform top-down reconciliation for all members of the indicated group. First Forecast Pro prepares forecasts for all groups and
end-items. Then it proportionally adjusts the nested lower-level end-item and group forecasts to sum to the group forecast. If the top-down group is itself nested within larger groups, the forecasts for the larger groups are computed by the bottom-up approach.

You may select top-down reconciliation by, on the Navigator, selecting the group item at which you want to apply top-down and then selecting the Top-down icon in the Group Level group on the Forecasting tab. Alternatively, you may right click on the group level item on the Navigator and select Top-down from the context menu. In either case, you will see a \TOPDOWN modifier appear on the group level item which you selected.

In the example above, \TOPDOWN directs Forecast Pro to compute forecasts and confidence limits for the groups Commercial and Retail at the group level. The end-item forecasts and confidence limits are multiplicatively adjusted so that the end-item forecasts sum correctly to the group level forecasts. Forecasts for the group Brand are obtained by bottom-up aggregation of the groups Retail and Commercial.

Note the assumptions behind this approach. We have assumed that the nested end-items are statistically similar, so that we can obtain better forecasts of the groups Retail and Commercial by forecasting them as a unit. However, Retail and Commercial show distinctly different patterns. Thus, the best forecasts of Brand are obtained by direct aggregation of the two member groups.

Using Top-down reconciliation for Brand rather than Retail and Commercial would direct Forecast Pro to reconcile the entire hierarchy using a top-down approach. Usually, in a hierarchy involving three or more levels of aggregation, you will want to place the \TOPDOWN modifiers somewhere near the middle.

Two things happen as we move from item-level data upwards through the hierarchy. First, the effects of irregularity decrease through aggregation. Aggregate data series are typically more stable and reliably forecastable than disaggregate data. Second, statistical models become more complex and distinct from each other.

Custom Allocation

Custom allocation uses user-defined proportionalities to allocate the group-level forecast down to the next level. You must define the proportions in a file, table, or query and read it
Reconciling the Hierarchy

into Forecast Pro using the Definitions row in the Data Manager. Consult Definitions: Custom Allocations in Setting Up Your Optional Data chapter for details. Note that Custom Allocation can only be applied to the group level directly above the level at which you defined the proportions.

The procedure begins by creating forecasts for the specified group and then using the user-defined proportional factors to allocate the group forecast down one level. Any additional lower levels are adjusted via a top-down procedure unless they too are using custom allocation.

To apply custom allocation reconciliation, on the Navigator select a group item one level above the level at which the proportions are defined and then select the Custom Allocation icon in the Group Level group on the Forecasting tab. Alternatively, you may right click on the group level item on the Navigator and select Custom Allocation from the context menu. In either case, you will see a \CALL modifier appear on the group level item which you selected.

Indexes

The third icon that appears in the Group Level group on the Forecasting tab is Indexes. Clicking the Indexes icon applies an \INDEXES modifier to the selected group level item on the Navigator. Using Indexes directs Forecast Pro to calculate multiplicative seasonal indexes at the selected group level and then use those indexes to de-seasonalize the histories for the nested end-items and groups. The de-seasonalized series are then forecasted and re-seasonalized.

The Indexes approach works well when the end-items share the same seasonality. It allows one to deal with items whose histories are too short to calculate seasonality.

Indexes can be used if the selected group level series does not include zeros or negative numbers. You cannot nest \INDEXES groups within each other. Model parameters are re-estimated for each end-item and nested group of the \INDEXES group.

Now consider the case where both the \TOPDOWN and \INDEXES keywords are used for Retail and Commercial. In this case, Forecast Pro extracts seasonal indexes for these groups at the group level. It then deseasonalizes each end-item’s history using the indexes from the parent group, forecasts the resulting nonseasonal data, and then re-seasonalizes the forecasts. The forecasts are then reconciled using a top-down procedure as already described.

A note about negative values

In a multiple-level problem, it is assumed that the data are basically nonnegative—the aggregate level data must be non-negative, but the item level data can include a few negatives.

Negative sales figures are relatively common since many companies register returns as negative sales. Furthermore, returns are often accumulated on the books and taken as occasional “hits” on sales. While this may make good accounting sense, it raises forecasting problems and will certainly decrease accuracy. Ideally, companies would either distribute returns to the months in which the products were shipped or maintain returns as an entirely different historic record. Nevertheless, listing sales as negative is common and must be dealt with in some way.

Beyond an expected decrease in accuracy for forecasts from a product with negative sales, negatives pose a technical problem for product hierarchies. Multiplicative seasonal indexes cannot be extracted from a nonpositive series, and additive indexes cannot be
disaggregated to nested products. Thus, if the group level data contain negatives, Forecast Pro will use an additive index model and seasonal disaggregation will not be allowed (i.e., the \INDEXES flag will be ignored). In the case of positive group level data with negative values in the constituent data, the multiplicative adjustment of negative values may have a different effect than one expects—a seasonal index of 1.5 to a sales figure -100 yields the value -150.
Chapter 13: Collaboration

Corporate forecasting often requires collaboration among colleagues. Perhaps your manager wishes to review your forecasts and make a few changes. Perhaps you want to run your forecasts past the sales force who may know about pending orders. Perhaps your business has distinctly different markets that require specific individuals to work on specific markets. Whatever the reason, it is often useful to be able to work with others to establish the final forecasts.

There are three basic strategies for working with others using Forecast Pro—sharing a single stand-alone project, using Forecast Pro’s Excel Add-In and consolidating multiple projects into a “super project” using the Super Project Manager. There are pros and cons to each approach.

Sharing a stand-alone project is the most straightforward way to work with others to establish the final forecasts. Using this approach, the forecaster begins by creating forecasts for all items that need to be forecasted, enters any desired overrides and saves a forecast project—often to a network drive. The project can then be opened by anyone using Forecast Pro (Forecaster or Collaborator licenses) to review, make changes, etc. If there is a third individual who needs to review the project, that person would do so after the second individual has updated the project. Only one person at a time can access the standalone project, so the changes must be done sequentially.

Excel Collaboration provides an easy way for colleagues to adjust forecasts without having to pass around a project. Instead, collaborators simply adjust the forecasts in Excel and then send those adjustments back to the project owner(s) to import into the project. The Forecast Pro Add-In provides an intuitive Excel based interface for collaborators to make changes and prepares the file to import back into the stand-alone project.

Please note that the Forecast Pro Add-In is required for editing Collaboration Sheets. The Forecast Pro Add-In is included in all licensed product installs.

Finally, the super project approach allows you to break large forecasting jobs into smaller pieces that can be worked on separately and then consolidated. To implement this approach you first create, forecast and save separate component projects and then use the Super Project Manager to combine the component projects into a new super project that allows you to view and manipulate the consolidated forecast. A Super Project can only be created by someone with a Forecaster license, but it can be used by anyone using Forecast Pro (Forecaster or Collaborator licenses).

A forecasting process that uses a stand-alone project, either one with sequential review or one using the Forecast Pro Excel Add-in, is much simpler to implement and maintain than one that uses a super project. If it is not essential that your total hierarchy be broken out into smaller pieces, using the Forecast Pro Add-In or a sequential review of stand-alone projects are the preferred approaches. If a super project is necessary, it might be helpful to use Excel Collaboration in conjunction with a super project to minimize the complexity of the forecasting process.

For more information, please consult the Collaborating with Colleagues lesson in Forecast Pro TRAC Tutorials.
Excel Collaboration

Creating Forecast Pro Collaboration Worksheets

To open the Excel Collaboration dialog box, click the Excel Collaboration icon on the Home tab. The dialog box will open to the Create tab.

Create a new file

Template drop-down: The first step is to select a Template. There are two available templates for creating Forecast Pro collaboration sheets - In Place and By Selection. The In Place template exports the forecasts for all exported items to a single sheet for editing. The By Selection template displays only one item at a time and includes a selection drop-downs for choosing the item. An example for each template is shown in the Forecast Pro Add-In section of this chapter.

Export to: This text field specifies where you want to save your collaboration sheet. By default, collaboration sheets are saved in “C:\Users\Public\Documents\Forecast Pro\Forecast Pro TRAC v6\Excel Collaboration”.

Define Data

Hierarchy Level: Forecast Pro allows you to make overrides at any level of the hierarchy, but all items exported to a give file must be at the same level of the hierarchy. By default, Forecast Pro selects the lowest hierarchy level in the Hierarchy drop-down.
Override Row: The Override row drop-down lists all available override rows as well as a row that may not be shown in the override grid, Excel Collaboration. Recall that when working with override rows, higher number rows take precedence over lower number rows. If there are multiple overrides for the same item and forecast period, the override row that is lowest in the grid is used in the final forecast. The Excel Collaboration row takes precedence over all other override rows. If a sales representative uses the Excel Collaboration row, he or she is guaranteed that the final forecast will integrate his or her overrides. Excel Collaboration is the default selection.

Date Range: The Date Range spinners are used to tell Forecast Pro how many historical and forecast periods you want included in the Collaboration Worksheet. Historical sales are helpful when determining if a forecast makes sense. If the left spinner shows “-12”, the collaboration worksheet will contain 12 periods of history. The corresponding date is shown right above the spinner.

Select Items

There are five options for defining the items you want to export

All: Exports all items to the collaboration worksheet.

Filtered – single file: If this option is selected, you must also specify a Filter in the drop-down to the right of Filtered – single file and then select one or more filter values in the Value(s) drop-down. The items with filter values corresponding to your selected value(s) will be exported to a single collaboration worksheet. The Filters drop-down is populated with all filters that you have read in using the Data Manager. You need to have read in at least one filters file to use this option. Please consult Custom Filter Fields in Setting Up Your Optional Data.

Filtered – multiple file: If this option is selected, you must also specify a Filter in the drop-down to the right of Filtered – multiple file and then select one or more filter values in the Value(s) drop-down. The Select All button will select all values. The items with filter values corresponding to your selected value(s) will be exported to multiple collaboration worksheet. A collaboration worksheet will be created for each selected value, using a default naming convention. The Filters drop-down is populated with all filters that you have read in using the Data Manager. You need to have read in at least one filters file to use this option. Please consult Custom Filter Fields in Setting Up Your Optional Data.

Current hot list: Export items on the current hot list.

Saved hot list: When working with hot lists, you can save a hot list using the Hot list icon in the Other Group on the Export tab or by selecting Save Hot list on the Hot List context menu. These files will contain a list of the items on the hot list. Select a saved hot list by clicking the browse button and selecting the file.

Total Items: This is a non-editable text field that displays the total number of items you have selected to export.

Export: The Export button is used to generate the collaboration sheet(s) as specified. If you are using Filtered – multiple file, Forecast Pro will automatically save and display the exported worksheets in the Existing Sheets display. In all other cases, you will be prompted to save the file. After you confirm the file save, the sheet will be listed in the Existing Sheets display.

Existing Sheets
The Existing Sheets display lists all collaboration worksheets that have been exported from the current project, along with key information about the collaboration worksheet. Most of these fields show information about the structure of the exported file. However, the Last Updated and Status fields are dynamic and will change as you move through your forecasting process. Right clicking on any of these files will bring up a context menu. From this context menu you can remove the file association from the project, open the file in Excel or open the folder where the file was saved.

**Updating Collaboration Sheets**

Forecast Pro Collaboration is designed to work within an on-going forecasting process. Instead of creating new Collaboration Worksheets each forecast cycle, forecast project owner(s) may want to simply update the Forecast Pro Collaboration Worksheets from last month with the updated history and forecasts.

When you update a collaboration sheet, Excel will use the settings used to originally create the collaboration sheet to update the sheet. If you are exporting 12 months history and 12 months of forecasts, Forecast Pro will do so from the updated forecast origin (last period in the historic data). If the filter values or saved hot list have been updated, Forecast Pro will export items from the updated filter or hot list files. Finally, if you have inserted additional worksheets into the collaboration sheet, those worksheets will be kept in the updated file.

To open the Excel Collaboration dialog box, click the Excel Collaboration icon on the Home tab. The Update tab is shown below.

Select existing files(s) to export: The Select existing files(s) to export display lists all collaboration worksheets associated with the current project. It displays the same files as the Existing Sheets display on the Create tab. You may right click on any of the files and
open the context menu to export the file, remove the file association, open in Excel or open the folder where the file is saved.

Export: To export one or more of the existing file(s), select the files you want to export and then click the Export button.

Select All: The Select All button selects all files on the list. This provides an easy way to update all associated files at once.

**Importing Forecast Pro Collaboration Worksheets**

To open the Excel Collaboration dialog box, click the Excel Collaboration icon on the Home tab. The Import tab is shown below.

Select existing files(s) to import: The Select existing files(s) to import display lists all collaboration worksheets associated with the current project. It displays the same files as the Existing Sheets display on the Create tab. You may right click on any of the files and open the context menu to import the file, remove the file association, open in Excel or open the folder where the file is saved.

Import: To import one or more of the existing file(s), select the files you want to import and then click the Import button.

Select All: The Select All button selects all files on the list. This provides an easy way to import all associated files at once.

Import Other: At times, you may want to import valid collaboration sheets that are not associated with the current project. To add a file to the Existing files display, click the
Import Other button and select the file. Any collaboration sheets you add to your project must have the same hierarchy structure as your project. There may be items in the collaboration sheet that are not in the project but overrides for those items will be ignored.

**Editing Collaboration Sheets in Excel**

The Forecast Pro Excel Add-in will not be accessible in Excel until you start Forecast Pro. Please start Forecast Pro to automatically activate the add-in. If you start the program with Excel open, you will need to close and re-open Excel for the add-in to be activated. If the add-in is not running, you will see instructions in the collaboration sheet for how to proceed. Please note that the Forecast Pro Add-In will not run if you do not have a licensed Forecaster or Collaborator installed.

If the add-in is properly installed and running, the collaboration sheet is populated with your data when you open it in Excel. The two built-in templates, *In Place* and *By Selection*, are described below.

**In Place Collaboration Sheets**

The *In place* template will render a collaboration worksheet like the one shown below

The *In Place* collaboration worksheet includes all items selected for export in the Excel Collaboration dialog box. The columns on the left show the hierarchy attribute values for each item. You may use the Excel filters to display subsets of the hierarchy. The gray columns show the exported history. In this example, three months of history were exported by setting the left date spinner to -3. Finally, the columns to the right of the history columns show the forecast values. In this case, the right date spinner in the Excel Collaboration dialog box was set to 12, specifying that 12 forecast periods should be exported.

Please note that the attribute and history data is not editable. Only the forecast values may be updated. You may also use the empty cells to the right of forecast values as well as the space below the display.
To edit a forecast value, simply enter the override value in the selected cell. When you change a value, the cell will turn orange to indicate that a change has been made.

The Forecast Pro Add-In edits the cell context menu to disable certain functionality that is not available in the collaboration sheet (e.g. inserting rows or columns) and to add in Add-In functionality. The cell context menu is opened by right clicking on a cell. There are four additional entries added to the context menu:

- **Restore Forecast**: Restores the exported forecast value in the selected cell.
- **Insert/Edit Comment**: Overrides should always be accompanied by a comment documenting why the override was made. To enter override comments to import into Forecast Pro project, select **Insert/Edit Comment** on the cell context menu to open the following dialog box:

  ![dialog box]

  The textbox shows the existing comment, if there is one. Enter or update the comment in the text field and click OK. Once a comment has been written, you will see a red triangle in the upper right-hand corner of the cell. If you hover over the commented cell, you will see the comment.

  **Delete Comment**: Removes the comment from the selected cell.

  **About Forecast Pro**: Open a dialog box that displays information about the Forecast Pro Add-In you are running.
When you are done editing, simply save the Forecast Pro collaboration sheet. When the collaboration sheet is read into the Forecast Pro project, all overrides and comments will be imported into the project.

**By Selection Collaboration Sheets**

If you use a *By Selection* template, the collaboration sheet will look similar to the override grid view in Forecast Pro.

On the left hand side, there will be a drop-down for each attribute in your hierarchy. The drop-downs are used to select the item to display in the graph and grid. The currently selected item is shown on the graph as well as in the top left corner of the override grid.

The override grid shows the Baseline Forecast, all override rows (with Forecast Pro comments now shown as comments) and the final forecast at the time of export. Below the exported forecast is an orange row for entering overrides. The orange overrides row is the only editable row in the grid. The row label includes the name of the override row that will be used when the collaboration sheet is read into the Forecast Pro project (“Demand Forecasting” in the example above). Below the overrides row, the Updated Forecast row shows the forecast with the overrides you have entered.

To enter overrides, simply enter the override value into a cell in the orange override row. You may make a comment for the override using the cell context menu (right click on a cell to view the cell context menu), as described above in the *In Place Collaboration Sheets* subsection. You may also delete comments and view the About Forecast Pro dialog box from the cell context menu.
Working with Super Projects

There are three basic strategies for working with others using Forecast Pro—sharing a single stand-alone project, using Forecast Pro’s Excel Add-In and consolidating multiple projects into a “super project” using the Super Project Manager.

Sharing a stand-alone project is the most straightforward way to work with others to establish the final forecasts. Using this approach, the forecaster begins by creating forecasts for all items that need to be forecasted, enters any desired overrides and saves a forecast project—often to a network drive. The project can then be opened by anyone using Forecast Pro (Forecaster or Collaborator licenses) to review, make changes, etc. If there is a third individual who needs to review the project, that person would do so after the second individual has updated the project. Only one person at a time can access the standalone project, so the changes must be done sequentially.

Forecast Pro’s Excel Add-In also relies on a single stand-alone project, but it allows multiple collaborators to make changes non-sequentially. The forecaster owns the standalone project. From the standalone project, the forecaster creates and then distributes multiple “Forecast Pro” Excel files to collaborators to make overrides. The Forecast Pro Add-In provides an intuitive Excel based interface for collaborators to make changes and prepares the file to import back into the stand-alone project. The collaborators then send the files back to the forecaster, who imports each file into the stand-alone project to consolidate all changes. When using Excel Collaboration, the collaborators use overrides, but they are not adjusting the forecast models. The details of using Excel Collaboration are detailed in Using Excel Collaboration.

Alternatively, the super project approach allows you to break large forecasting jobs into smaller pieces that can be worked on separately and then consolidated. To implement this approach you first create, forecast and save separate component projects and then use the Super Project Manager to combine the component projects into a new super project allowing you to view and manipulate the consolidated forecast.

Pros and cons

To illustrate the pros and cons of each approach, let’s consider the following example. A company sells their products in three countries—the United States, Canada and Mexico. They employ three different demand planners, each of whom is responsible for forecasting a specific country. After the demand planners have completed their forecasts, they meet with management to review the forecasts and make any required adjustments.

In this example, Excel Collaboration is not an option because the three forecasters are responsible for both generating baseline forecasts and adjusting those forecasts with overrides. Excel Collaboration only allows for overriding existing forecasts.

Accomplishing this using a single stand-alone project would require a sequential review process. For example, assume the demand planner for the United States goes first. He or she would create a forecast project which includes all three countries and then review and make adjustments to the United States data and save the project. Next, the planner for Canada would open the project, review and adjust the Canadian data and save the revised project. Next, the planner for Mexico would open the project, review and adjust the Mexican data and save the revised project. At this point, the demand planners’ forecasts are complete, and the project is ready for the management review meeting.
Clearly, there are some downsides to the above procedure. One is that the demand planners cannot work on their country-level forecasts simultaneously—they have to wait until it is their turn to do so. Another problem is that even though they are working on a single country, the project contains data and forecasts for all three countries, which makes it harder to manage and more prone to error.

The advantage of a forecasting process that uses a sequential review of a single stand-alone project is that it is much simpler to implement and maintain than one that uses a super project. If it is not essential that your total hierarchy be broken out into smaller pieces, then sequential review of stand-alone projects is the preferred approach.

Using the super project approach with our example, we would create a separate forecasting project for each country and then consolidate them into a new super project which includes all three countries. The advantage is that the three demand planners can work on their forecasts simultaneously using a project that only contains their country. When all three are done, the Super Project Manager is used to create a super project containing the consolidated forecast.

**Creating a super project**

The steps to create a super project are:

1. Create the data files for the component projects.
   The super project’s historic data definition will include all of the component projects’ data files. Therefore, you need to construct the data files for the component projects so that when they are combined they create the consolidated hierarchy correctly.

2. Select the number of override rows required and other settings.
   To import the component projects’ overrides into the super project the number of override rows needs to be consistent across the component projects. To ensure a consistency between the statistical forecasts in the component projects and the super project, you will want to decide on all options relating to the forecasts (e.g., forecast horizon, confidence limits settings, outlier correction settings, etc.) up front and keep them consistent across the component projects.

3. Create the component projects

4. Use the Super Project Manager to create the super project

Prior to creating your first super project the *Collaborating With Colleagues* lesson in *Forecast Pro TRAC Tutorials*. This lesson walks you through the process of using the Super Project Manager to create a super project.

**Updating a super project**

How you update your component projects and super project will depend on the details of your forecasting process.

Many users do not modify the forecasts in the super project, but rather just use the super project as a way of viewing the consolidated forecast and saving output files. If this is the case, you may want to simply update the component projects and create a new super project every time new data becomes available.
If you are entering modifications (e.g., overrides and modifiers) in the super project then the updating process may be a bit more involved. If necessary, you can import overrides and modifiers from the super project into the component projects using the Data Manager. Once the component projects are updated the Super Project Manager allows you to either delete the super project's overrides and/or modifiers prior to importing from the component projects or leave them intact.

As you can see, setting up and maintaining super projects is reasonably complex. Keep in mind that Business Forecast Systems and Forecast Pro distributors also offer consulting services to help you establish your forecasting process.
Chapter 14: Understanding How Forecast Overrides are Allocated

The override facility in Forecast Pro allows you to adjust your forecasts. Changes made at any level of the forecasting hierarchy will automatically reconcile all levels. This chapter was written to clarify exactly how the reconciliation is performed and document cases where adjustments cannot be fully implemented due to conflicting overrides or program settings.

The examples in this chapter assume that you are making adjustments to the statistical forecasts, however, if you have defined alternative baseline forecasts or generated an inherited forecast row the overrides will be made to these forecasts using the same logic.

Adjustments Made to a Single Level

In this section we will describe how Forecast Pro reconciles the forecast hierarchy when overrides are made to a single level of the hierarchy.

Important: If you restrict your overrides to a single level of the hierarchy, the reconciliation process is simple and intuitive. We strongly urge you to limit your overrides to a single level if at all possible.

Figure 1 below depicts a simple forecast hierarchy prior to any overrides being entered. Notice that at this point the Statistical forecasts equal the committed Forecasts.

Let's now modify the above hierarchy by overriding the forecast for ItemA1 to equal 75. This results in the hierarchy shown in Figure 2 below.
Adjustments Made to More Than One Level

In this section we will describe how Forecast Pro reconciles the forecast hierarchy when overrides are made to more than one level of the hierarchy.

Important: There are many ways that this type of reconciliation could be performed—each one leading to different forecasts. If you plan to make overrides at more than one level of the hierarchy, it is essential that you understand how Forecast Pro performs the reconciliation.

Figure 2.

Notice that at this point the committed Forecasts for GroupA and Total do not equal the Statistical forecasts.

If we had started with the hierarchy depicted in Figure 1 and adjusted the GroupB forecast to 75 (rather than ItemA1) we would generate Figure 3.

Figure 3.

Notice that the committed Forecasts for ItemB1, ItemB2 and Total do not equal the Statistical forecasts. Notice also that Forecast Pro allocated the GroupB override to ItemB1 and ItemB2 based on the proportions established by their Statistical forecasts.

Adjustments Made to More Than One Level

In this section we will describe how Forecast Pro reconciles the forecast hierarchy when overrides are made to more than one level of the hierarchy.

Important: There are many ways that this type of reconciliation could be performed—each one leading to different forecasts. If you plan to make overrides at more than one level of the hierarchy, it is essential that you understand how Forecast Pro performs the reconciliation.

Figure 4 below depicts a forecast hierarchy where ItemA1 has been overridden to equal 75. (It is identical to Figure 2.)
Adjustments Made to More Than One Level

Let's now modify the above hierarchy by overriding the forecast for Total to equal 475. This results in the hierarchy shown in Figure 5 below.

Figure 4.

Making adjustments at more than one level introduces the concept of locked and unlocked volume and forecasts. Proportional allocations of unlocked volume are made using unlocked forecasts.

Notice that:

1.) When we adjusted Total to 475, 75 units were locked due to the override on ItemA1 and 400 units were unlocked and needed to be allocated downward.

2.) Forecast Pro used the Unlocked statistical forecasts for GroupA and GroupB to determine the allocation proportions for the 400 unlocked units from Total.

3.) Forecast Pro did not alter the committed Forecast value for ItemA1 because it had been explicitly overridden (i.e., it was locked). Therefore, the 100 units of unlocked volume from GroupA was allocated exclusively to ItemA2 (the only unlocked item in GroupA).

4) Forecast Pro used the Unlocked statistical forecasts for ItemB1 and ItemB2 to determine the allocation proportions for the 300 unlocked units from GroupB.

Let's now modify the above hierarchy by overriding the forecast for Item A2 to equal 75. This results in the hierarchy shown in Figure 6 below.

Figure 5.
Examples Where Overrides Cannot be Allocated

Notice that GroupA has no unlocked volume so the 325 units of unlocked volume from Total are allocated exclusively to GroupB.

Examples Where Overrides Cannot be Allocated

If you make forecast overrides to more than one level of the hierarchy you can generate situations where the overrides cannot be allocated. In these instances an error message will be displayed and the override will not be applied.

Figure 7 below depicts a forecast hierarchy where ItemA1 and ItemA2 have both been overridden to equal 75 and ItemB1 has been overridden to equal 150.

Figure 7.

Suppose you try to override the forecast for GroupA to equal 100. The override could not be applied because both ItemA1 and ItemA2 are "locked". Forecast Pro will display an error message and reject the override.

Let’s now modify the above hierarchy by overriding the forecast for GroupB to equal 50. This results in the hierarchy shown in Figure 8 below.
Notice that the override for GroupB resulted in a negative committed Forecast for ItemB2. This result assumes that the “Allow Negative Forecasts” setting in the Forecast Pro Options dialog box was selected. If this setting was not selected, the override could not be made and Forecast Pro would display an error message and reject the override.

**Summation**

It should be quite apparent that if you make adjustments to more than one level of a hierarchy the reconciliation becomes quite complex. Although several of the examples presented seemed involved, they were actually quite simple hierarchies consisting of only 3 levels and 4 end-items. Most users of Forecast Pro are working with thousands of items and much more complex hierarchies.

In developing the reconciliation routine for Forecast Pro the authors considered using several different algorithms. In many situations the choice of which algorithm to use would change the forecast values—sometimes significantly. None of the algorithms were “statistically superior” to the others—they were simply different.

Virtually all of the complexity (and differences between algorithms) disappears if you restrict yourself to making forecast adjustments to a single level of the hierarchy. Although we’ve stated this previously, it’s worth repeating:

*If you restrict your overrides to a single level of the hierarchy, the reconciliation process is simple and intuitive. We strongly urge you to limit your overrides to a single level if at all possible.*
Appendices

Speeding Up the Program

If decreasing processing time is important for your application, you may wish to investigate some of the following options.

1. Use the 64-bit Version

Forecast Pro can be installed as either a 32-bit or 64-bit application. If you are currently running the 32-bit version, migrating to the 64-bit version will speed up various operations such as opening and saving projects and will also allow you to work with larger data sets.

2. Work Locally

Working with projects stored on a network drive can be substantially slower than working on a project stored locally. Reading input data over the network and saving output files to network drives can also be substantially slower than reading and writing from a local drive.

If you are currently saving your projects to a network drive, saving them to a local drive will improve performance considerably. If you are currently reading your input data from a network drive and/or saving output files to a network drive, moving them to a local drive will speed up read/write operations considerably.

3. Use Zipped Projects

As we mentioned above, in some networked environments, working with projects stored on a network drive can be substantially slower than working on a project stored locally. To improve performance in these cases, Forecast Pro supports “zipped” projects. When you save a zipped project, Forecast Pro zips the four standard project files described in a previous section of this manual into a single file with the extension .FPZip.

When you open a zipped project, Forecast Pro copies the zipped file from the network drive to a local workspace, unzips the project files and opens the project—allowing you to work on your project locally, even though it was saved to a network drive. When you resave your zipped project, Forecast Pro will zip the updated local project files and save the updated .FPZip file to the network drive.

To save and open zipped projects, you select FPZip as the file type in the File>Save as and File>Open dialog boxes.

4. Upgrade Your Hardware

Upgrading your hardware will improve performance dramatically. Forecast Pro will run on any Intel processor from the 386 on. Since this product deals with large amounts of floating point data, it makes sense to run it on as fast a machine as possible.

As an illustration, using expert selection and four years of monthly history per item, a Core2/2.2GHz machine forecasted 10,000 items in 39 seconds. The same run took 4 minutes on a Pentium III/600MHz machine and 24 minutes on a Pentium/90MHz.

Having enough RAM is also important—we recommend 2 Gigs if you are running a 32-bit operating system and as much RAM as your budget can afford if you are running a 64-bit operating system.
As you use the program, Forecast Pro is storing and retrieving a great deal of information in memory. If you do not have an adequate amount of RAM Forecast Pro will resort to using virtual memory (i.e., caching to your hard drive). This is substantially slower than using RAM. Increasing the amount of RAM in your computer will improve performance of all of your applications.

5. Use Manual Override Mode

If you make overrides to large complex hierarchies, the reconciliation can take a little time. To minimize the reconciliation time, Forecast Pro supports a manual override mode. When this mode is active, the override window will include a Retain button as well as a Commit button. The Retain button is used to accept overrides without reconciling the hierarchy. In this mode you would typically enter and retain all of the overrides you wish to make (i.e., for multiple items) and then click Commit or the red Recalculate icon (-ren) to perform the reconciliation. The control to turn on manual override mode is found on the Performance tab of the Settings>Options dialog box.

6. Use Manual Forecast Mode

By default, Forecast Pro will automatically recalculate the forecasts and re-reconcile the hierarchy every time you apply a forecast modifier. For large hierarchies this can be time consuming. Forecast Pro allows you turn on manual recalculation using an option of the Performance tab of the Settings>Options menu. If you turn this option off, when you specify a forecast modifier the forecasts will not be updated until you click the red Forecast icon (ren) or the red Recalculate icon (ren). This allows you to specify multiple forecast modifiers without having to wait for the program to recalculate the forecasts in between each specification.

7. Reduce the Size of the Forecast Archive

By default, Forecast Pro will archive the last 12 forecasts you’ve created in the project’s database. Forecast Pro allows you to limit the number of periods archived using the Periods to retain in archive spinner on the Performance tab of the Settings>Options menu. Reducing the number of archived forecasts will result in a smaller project and better performance for many program operations (e.g., opening and saving projects, loading the tracking report, etc.).

8. Optimize Outlier Detection and Correction for Speed

The outlier detection and correction algorithm will slow down the processing. If you wish to use outlier detection and correction but speed is of concern, one option is to initially run the forecasts in the detection only mode to detect the outliers and then turn outlier detection off and use the \OUTLIER=CORRECT modifier to perform the corrections on the detected items.

9. Don’t Use .xlsx Files

If you are using .xlsx files you might consider switching to csv or xls files. Xlsx files are slower to read than csv and xls files and use over twice as much memory. Also, if you are using large spreadsheet files breaking them up into several smaller files or increasing the amount of RAM available will speed up processing.

10. Optimize Model Selection For Speed

Specifying “Exclude ARIMA” on the Performance tab of the Settings>Options dialog box will speed up forecast generation considerably. This option will remove Box-Jenkins models from consideration when using expert selection.
If you are forecasting data where the number of periods per cycle is greater than 13 (e.g., weekly data) you might consider turning on the “Exclude seasonal simplification” option in the Performance tab of the Settings>Options dialog box. If this switch is on, Forecast Pro’s expert selection mode will not consider seasonally simplified forms of exponential smoothing models. This will speed up forecast generation considerably.

Specifying the models to use rather than using the expert selection will substantially improve performance. This will require some work to determine the best type of model to use for your data. The best way to determine the appropriate model for your data set is to experiment using the forecast evaluation procedures (see methodology chapter in the Forecast Pro Statistical Reference Manual for details).

**Using a Time Fence**

Time fences are used to “lock” forecast values for a specific number of periods so that they can’t be changed via user overrides or by the generation of new statistical forecasts as new data become available. Time fences can be useful in environments where after forecasts have been finalized and acted upon (i.e., production has been scheduled, orders have been placed, etc.), there is a window of time where making changes is not feasible.

The screen above shows the Forecast overrides view for an item with a 3-month time fence. Notice the second to last row of the grid is labeled Time Fence. The values displayed in this row are the unchangeable fenced values and the same values appear in the final Forecast row.

Notice that the statistical forecast for August (303,178) does not equal the time fence value (294,192). This is because August’s time fenced value was established when last month’s forecasts were generated.

Let’s now consider what happens next month. We update our data with August’s sales, open last month’s project and generate new statistical forecasts. Our 3-month time fence will now cover August through October. August and September’s time fenced values will be
 retains last month’s time fenced values and November’s time fenced value will equal last month’s final forecast for November.

**Time Fence Settings and Options**

*Turning on the time fence:* When you first create a project, the time fence will be turned off. You turn the time fence on by selecting Operations>Time Fence>Enable. Once you turn a project’s time fence on, *it cannot be turned off!*

![Options dialog box](image)

*Setting the length of the time fence:* The default length for the time fence can be specified on the Override tab of the Options dialog box (shown above).

You can override the global setting on an item-by-item basis using the custom modifier `\TIMEFENCE=n` where `n` is the number of periods you wish to use. Be aware that if you use the `\TIMEFENCE` modifier to create a time fence shorter than the global time fence, it will shorten the time fence for all associated parent groups of the item.

*Freezing the next period:* Selecting Operations>Time Fence>Freeze Next Period will increase the length of all time fences in the current project by one period for the current forecast origin. If you subsequently, update your data with the next observation and create a new forecast (thus changing the forecast origin) the time fence lengths will revert back to their pre-Freeze-Next-Period settings. This option provides a way of insuring that after the forecasts are finalized someone doesn’t inadvertently alter the frozen periods’ forecasts prior to the data being updated, new forecasts being generated and the frozen periods’ forecast becoming an officially fenced value.

**Command Line Operation**

You can run Forecast Pro noninteractively. When the command line to execute the program includes a project filename (*.FPZip or .FPProj if the project is unzipped) and the `/b` parameter, Forecast Pro will read in the data, create the forecasts, save all output files and then exit. This feature is particularly useful when you are integrating forecasting with other software systems and need a “hands-off” approach.
To drive Forecast Pro entirely automatically, follow these two steps.

1.) Prepare a valid project and place it in your project directory. The easiest way to prepare this file is to use Forecast Pro interactively to define all desired project settings, historic data, output formats and (optionally) forecast modifiers and overrides, and then save the project using File>Save.

Alternatively, you can generate the file externally but this will require understanding the project file and the (optional) corresponding db file formats.

2.) Drive Forecast Pro by issuing the command

   "C:\Program Files\Forecast Pro\Forecast Pro v6\ForecastProTRAC.exe" Test.FPZip /b

where we assume that the program is located in the directory “C:\Program Files\Forecast Pro\Forecast Pro v6” and a project named Test.FPZip is located in your current project directory. The “/b” parameter is used to indicate that you wish to run in command-line (batch) mode.

If you want to apply the settings from a layout in the project, you may do so by adding "\BOOKMARK=Name” to the command shown above. For example, "\BOOKMARK=Layout01” will apply the settings from a layout named Layout01.

You can issue the command in any number of ways, including:

- Select Run from the Start menu and issue the command from there.
- Set up a shortcut to issue the command.
- Issue the command from within a different application using a system call.

The Command Line tab of the Settings>Options dialog box allows you to specify several key command line forecasting options and the output files to save in command-line mode. This tab’s functionality was fully described in the Menu Items and Dialog Boxes section earlier in this chapter.

Important Notes

1. If there are spaces in the pathname you must include quotation marks as illustrated in the example above.

2. If you do not want the Forecast Pro menu to appear, run the program minimized.

End-User License Agreement

This End-User License Agreement (“EULA”) is a legal agreement between Licensee (either an individual or a single entity) and Business Forecast Systems, Inc. (“BFS”) for the BFS software that accompanies this EULA.

1. DEFINITIONS

A. “BFS” means Business Forecast Systems, Inc., 68 Leonard Street, Belmont, MA 02478 USA, the author and owner of the copyright of this computer program product.

B. “Computer” means the single computer, workstation, terminal or other digital electronic device on which You use this program.
C. “Software” means the set of computer software programs in this package, regardless of the form in which You subsequently use it.

D. “Licensee” means an individual or single entity exercising rights under and complying with all the terms of this EULA. In the remainder of this EULA, the Licensee is referred to as “You.”

E. “Authorized User” means the Licensee in the case where the Licensee is an individual. In the case where the Licensee is an entity, “Authorized User” means (i) an employee of the Licensee, but only while such employee is acting within the scope of such employee’s employment by Licensee; and (ii) the primary user of the Computer on which the Software is installed.

If You do not agree with the terms of this EULA, BFS does not grant any license to the Software and You should not download, install or use the Software. In such event that You do not agree with the terms of this EULA and have already installed or downloaded the Software, You must remove the Software from your Computer and return to BFS the complete software package, including disks and printed materials and destroy all copies (or, if You downloaded the Software, notify BFS in writing that You have removed the Software from your Computer and destroyed all copies). If You do not comply with these return and notification requirements within thirty days (30) of your receipt of the Software, You will not be entitled to a refund of any license fees You paid.

2. OWNERSHIP

BFS retains title, ownership and all rights and interests in and to the Software, documentation and all other materials supplied by BFS. BFS does not sell the Software or any copies thereof, but only grants limited licenses to use the Software in accordance with the terms of this EULA.

3. GRANT OF LICENSE

Upon acceptance of this EULA, BFS grants You a non-transferable, non-exclusive, limited right to use this copy of the Software. You may use the Software and the associated documentation only in connection with one Computer. You may physically move the Software from one Computer to another, provided that the Software is used on only one Computer at a time. You may not move the Software electronically from one Computer to another over a network. This license is granted for use by an individual Authorized User, and, in no event shall there be more than one Authorized User on the Computer where the Software is installed; e.g., there shall be no common sharing of a "Forecast Pro computer." Each Authorized User must have a separate license to use the Software on his or her Computer.

4. LICENSE RESTRICTIONS

You acknowledge that the Software and its structure, organization and source code constitute valuable trade secrets of BFS. You shall not, nor shall permit, assist or encourage any third party to:

- copy, modify, adapt, alter, translate, reverse engineer, decompile, disassemble, or attempt to derive the source code for the Software.
- merge the Software with other software and/or create derivative works from the Software.
- sublicense, distribute, publish, sell, lease, rent, loan, or otherwise transfer or allow access to the Software to any third party.
- use the Software in the operation of a service bureau.
• defeat, disable or circumvent any security measures BFS may use to prevent unauthorized use or copying of the Software.

5. TRANSFER OR REPRODUCTION
You may not transfer or reproduce the Software with the exception of making a maximum of two (2) copies of the Software to be used for backup purposes only. When using a Computer with a hard disk, one copy of the Software may be installed on the hard disk provided that the copy is removed if the Software is used on another Computer.

6. LIMITED WARRANTY
THE SOFTWARE, THE DOCUMENTATION AND ANY OTHER MATERIALS THAT MAY BY BE PROVIDED BY BFS ARE PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND. BFS HEREBY EXPRESSLY DISCLAIMS ALL WARRANTIES WITH REGARD TO THE SOFTWARE, THE DOCUMENTATION AND ANY OTHER MATERIALS, WHETHER EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND ANY WARRANTIES ARISING OUT OF COURSE OF DEALING OR COURSE OF PERFORMANCE. BFS EXPLICITLY DOES NOT WARRANT THAT THE SOFTWARE WILL MEET ALL OF YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE ERROR-FREE. YOU ACKNOWLEDGE THAT YOU HAVE RELIED ON NO WARRANTIES AND NO WARRANTIES ARE MADE HEREIN BY BFS.

7. LIMITATION OF LIABILITY
BFS SHALL NOT BE LIABLE FOR ANY LOSS OR DAMAGE THAT MAY BE RELATED TO THE FURNISHING, PERFORMANCE, OR USE OF THE SOFTWARE, INCLUDING WITHOUT LIMITATION ANY INDIRECT, SPECIAL, INCIDENTAL, ECONOMIC, LOST PROFIT, OR CONSEQUENTIAL LOSS OR DAMAGE OF ANY KIND WHATSOEVER EVEN IF BFS HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES. IN NO EVENT SHALL BFS'S LIABILITY UNDER THIS EULA EXCEED THE AMOUNT PAID FOR THE SOFTWARE LICENSE, IF ANY.

8. TERM AND TERMINATION
This EULA is effective until terminated. Your rights under this EULA will terminate automatically without notice from BFS if You fail to comply with any provision of this EULA. Upon termination of this EULA, You must destroy all copies, full or partial, of the Software. You agree that upon termination of this EULA for any reason, BFS may take actions so that Software no longer operates.

9. GENERAL TERMS AND CONDITIONS
A. You acknowledge that You have read this EULA understand it and agree to be bound by its terms and conditions. This EULA supersedes all prior agreements, oral or written communications, proposals, representations and warranties and prevails over any conflicting or additional terms of any quote, order, acknowledgment, or other communication between the parties relating to its subject matter during the term of this EULA. No modification of this EULA will be binding, unless made in writing and signed by an authorized representative of each party.

B. In the event that any portion of this EULA is held unenforceable, the unenforceable portion shall be construed in accordance with applicable law as nearly as possible to reflect the original intentions of the parties, and the remainder of this EULA shall remain in full force and effect.

C. This EULA will be governed by and construed and enforced according to the laws of the Commonwealth of Massachusetts, USA excluding its conflict of law provisions.
Suggested Reading

The *Forecast Pro Statistical Reference Manual* is a pdf document that is copied to the program directory when you install Forecast Pro. It is also accessible via the Forecast Pro help menu and is the primary suggested reference for all of the forecasting techniques, statistics and algorithms found in Forecast Pro.

The *Forecast Pro Statistical Reference Manual* includes an extensive bibliography. A few recommended textbooks include: